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Quick Overview 

TaiRox CRM and Collections is a customer relationship and collections management solution that 
integrates fully with Sage 300. It lets you easily monitor customer activity and get paid faster.  

CRM and Collections lets you manage all customer contact, opportunities, orders and collections. You 
can also purchase the TaiRox Collections module without CRM features to manage your receivables. 

CRM and Collections provides these entities for managing customers and sales opportunities: 

• Companies that you can automatically promote to Sage 300 Customers 

• Full support for Sage Optional Fields and National Accounts 

• Contacts that are fully integrated with Sage 300 M/T Contacts 

• Bulk emailing that leverages the features of common bulk email providers such as MailChimp 

• Opportunities that are linked to Sage 300 orders and quotes 

• Tasks that appear on the dashboard for overdue invoices and other collections or CRM activities 

• Communications that feed emailing services such as MailChimp or Swiftpage 

• Cases for collections, support, on-site appointments, and other activities 

It includes the following features for managing customer accounts and collections efficiently: 

• Calendar and Dashboard views that show opportunities, cases, tasks, disputed invoices, 
tracked/overdue invoices, and promised payments by revisit date for the day, week, or month 

• Event emails (*.ics files) that update users’ email calendars with new opportunities, cases, and 
tasks to which they are assigned 

• Overdue invoice features for scheduling and sending aging period-specific overdue payment 
reminder emails and generating phone tasks for calling customer and national account contacts 

• Payment due alerts to send reminder emails for invoices before they are overdue 

• Programs to email A/R and O/E invoices, statements, and letters to multiple recipients per 
company / national account and store emails with attachments for easy retrieval 

• Functionality to resend existing O/E and A/R documents and statements to any contacts 

• Invoice tracking for attaching documents and notes to invoices and other A/R documents 

• Promised payments for tracking customer agreements for settling accounts 

• Customer Aging screen to give you a lightning-fast view and report of overdue customer accounts 

• Collections cases, disputed invoices and promised payments that are created directly from the 
customer aging screen 

• Reports to assess your collections performance and review the status of disputed invoices, 
overdue invoices, and promised payments 
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CRM and Collections entities and functions appear on the Sage 300 desktop.  

   

               

CRM and Collections includes setup options for customizing opportunities and cases, creating demo data 
for any Sage 300 database, generating opportunities for multiple companies, and scheduling and sending 
invoices, statements, payment due alerts, and overdue payment reminders to multiple contacts per 
company. 
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Setting Up CRM and Collections 

This guide provides instructions for setting up TaiRox CRM and Collections and TaiRox Collections – a 
product that provides the complete Collections module without TaiRox CRM’s sales features.  

This guide uses the product name “CRM and Collections” throughout, and indicates where a feature is 
available in TaiRox CRM and Collections but not available in the stand-alone TaiRox Collections module. 

See the CRM and Collections Implementation Guide and data input Setup Forms. 

System Requirements 

• Sage 300 2018 or later 

TaiRox CRM and Collections has been extensively tested on Sage 300 2018 and later platforms. 
CRM and Collections for earlier versions of Sage 300 may be provided upon request. 

o Activate Sage 300 M/T Contacts if it’s available with your version of Sage 300. 

If you previously used TaiRox Productivity Tools to add contacts in Extended Customers, 
make sure that you update TaiRox Productivity Tools contacts to Sage 300 M/T Contacts 
before you continue. 

• SQL Server 2012 or later 

LanPaks and Multiuser Licensing 

CRM and Collections does not have its own multiuser licensing system. The number of users is controlled 
by Sage 300 LanPaks. If you need to increase the number of users concurrently accessing CRM and 
Collections, you must increase the number of LanPaks.  

Installing TaiRox CRM and Collections on the Server 

Uninstall prior version of CRM and Collections before installing a new version 

• In Windows 10 or Windows 11, go to Settings > Apps and Features, click TaiRox CRM, and 
choose the Uninstall button. 

In Windows 7, go to Control Panel > All Control Panel Items > Programs and Features, right-
click TaiRox CRM and Collections, and select Uninstall. 

Install the new version of CRM and Collections 

• Run Setup-2018-2026.msi to install TaiRox CRM and Collections. 

• Click Next, Accept the license agreement, click Next, and click Next again to install.  

• After installing, run RegAcc.exe on each workstation that runs Sage 300 from a server. 

Activating CRM and Collections and Entering License Information 

Activate CRM and Collections to add and update database tables 

• Select Administrative Services > Data Activation. 

• Choose the new version of CRM and Collections 
from Applications for Activation, and click Next. 

• Click Activate. 

• Add CRM and Collections license information 

• Select TaiRox CRM and Collections > Setup > 
License Information. 

• Enter the license number in the License field and 
click Save. 
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Set Up Options, Opportunity Stages, Case Stages, 
Communication Types, and Optional Fields 

After installing and activating CRM and Collections, follow these steps to choose options and add the 
opportunity stages, case stages, communication types, territories, optional fields, and emailed accounting 
documents that you want to use for your company. 

          Activate Sage 300 M/T Contacts if available with your version of Sage 300   
 
TaiRox contacts are fully integrated with Sage 300 M/T Contacts. TaiRox’s Contacts program lists all 
contacts added in CRM and Collections or with the Sage 300 Multiple Contacts module. And A/R 
integration ensures that you have the same contacts in TaiRox that you have in Sage 300 A/R.  

Step 1:  Set up CRM and Collections options  

The Options screen provides default settings that are used throughout CRM and Collections. For 
more details on all options, see Options, in the Setup and Maintenance Screens chapter in this guide. 

• Go to TaiRox CRM and Collections > Setup > Options 

The Options screen has five tabs – Options, E-Mail, Calendar, Document Folders, and Customer 
PDFs. 

 

• The Suspend A/R Integration checkbox lets you disable automatic updates between Accounts 
Receivable customer and national account records and TaiRox CRM and Collections company 
and national account records.  

Leave this box unchecked to automatically synchronize customer and national account records in 
Accounts Receivable with company and national account records in CRM and Collections. See 
Options for more information on A/R / CRM synchronization.  

Note:  Sync Companies and Sync National Accounts are disabled if you select the 
Suspend A/R Integration checkbox in Setup Options. Do not suspend A/R Integration while 
setting up CRM and Collections. 

• The Suspend M/T Integration checkbox appears only if you are using the Sage Multiple 
Contacts module. It lets you disable automatic updates between Sage 300 M/T Contacts records 
and the Contacts program in TaiRox CRM and Collections.  

Note:  Sync Contacts is disabled if you select the Suspend M/T Integration checkbox in 
Setup Options. Do not suspend M/T Integration while setting up CRM and Collections. 
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In addition, Sync Companies and Sync National Accounts will not compare contacts added to 
CRM and Collections Companies/National Accounts and A/R Customers and National Accounts if 
you suspend M/T Integration. 

Email Tab 

• Email Server Settings are used to send calendar events to users when you assign users and 
revisit dates to tasks, send emails from the Resend Documents program in the Companies 
window, send invoices, statements and letters from the programs in the Send Documents folder, 
and send overdue payment reminders and payment due alerts to customers. 

These settings are also used for sending bulk emails if you do not subscribe to a bulk email 
service. (Note that Send Bulk Email will not appear if you only have the Collections module.) 

And you can override the default “From Email” address for most documents and when you resend 
documents using the Resend Documents button in the Company window. 

If this field is left blank, programs will default to the user’s email address in Sage 300. 

See the following sections for more information on overriding the From Email address for specific 
email programs: 

o For A/R Statements and Letters and for A/R and O/E invoices use the Accounting Documents 
Setup program to override the default From Email. 

o For Overdue Payment Reminders and Payment Due Alerts, see the Overdue Payment 
Reminders Setup program and Payment Due Alerts Setup program. 

For more details on emailing documents, see Step 13:  Add settings for emailing overdue 
payment reminders, payment due alerts, invoices, and statements to customers and Step 14:  
Add settings for emailing invoices, statements, letters to customers. 

• Email Archive Settings:  These settings determine where CRM and Collections stores emails 
sent to customers by the Send Invoices program, Overdue Payment Reminders program, and 
Payment Due Alerts program. 

Note that the actual locations for the Email Archive folders are not set on this screen 

Generic Documents Folder:  You specify the location for this folder on the Options > Document 
Folders tab.  

If you select this option, all emails sent to customers by the Send Invoices program, Overdue 
Payment Reminders program, and Payment Due Alerts program will be stored in the same folder. 

Company / National Accounts Documents Folder:  You also specify the location for this folder 
on the Options > Document Folders tab. 

This choice lets you store emails for each company and national account in a sub-folder identified 
by the Company ID or National Account number (from A/R) – along with company folders for 
cases, tracked invoices and other communications.  

You can drill down to this folder directly from CRM’s Company and National Account screens. 

Custom:  You specify the specific storage locations for invoice emails, overdue payment 
reminder emails, and payment due alert emails on the Settings tab for the Send Invoices Setup 
program, Overdue Payment Reminders Setup program, and Payment Due Alerts Setup program. 

This choice lets you store each type of email in a different location, and it lets you save the 
archived emails in subfolders organized by Year (ArchiveFolder\YYYY), Year and Month 
(ArchiveFolder\YYYYMM) or Year, Month, and Day (ArchiveFolder\YYYYMMDD).  

Note:  

o If you choose Generic folder, Company / National Account folder, or Custom, but do not 
specify folders for the locations you select, the emails will go to the  
       <shared data>\COMPANY\<companyID>\TaiRox CRM\Documents folder. 
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o The Email Archive sections on the Send Invoices Setup screen, Overdue Payment 
Reminders Setup screen, and Payment Due Alerts Setup screen will be greyed out if you do 
not choose “Custom.”  

o If you change these settings in future, the program will store new emails in the new locations 
that you specify, but it will not move older emails to the new locations. You will have to 
manually move them if you want them stored in the new location. 

Calendar Tab 

• Select the entities that you want to update users’ calendars when you change revisit dates and 
user assignments. You can update users’ calendars for cases, opportunities, and tasks. 

Note that “Opportunities” will not appear if you are running the Collections module without CRM.  

CRM and Collections generates .ics files when employees add or change revisit dates and user 
assignments for cases, opportunities, and tasks, and sends them to the “Email 1” address 
entered in Sage 300 for the assigned – and unassigned -- user. 

.ics files (iCalendar files) are plain text files containing the details for a calendar event or a 
to-do item. Typically, they are sent as attachments to emails that you can save to a calendar, 
such as the calendar in Outlook or the Google calendar.  

Note: CRM and Collections does not send calendar files when tasks are generated by the 
Overdue Payment Reminders program. However, it will send calendar reminders when you 
change the revisit date or user for tasks generated by Overdue Payment Reminders. 

To set up TaiRox CRM and Sage 300 to send calendar event files you must also: 

o Add “Email 1” email addresses for users in Sage 300 > Administrative Services > Users. 

TaiRox CRM and Collections sends calendar events to the Email 1 email address. 

o Add your email server settings on the Email tab in CRM and Collections > Setup > 
Options. Use the Send Test Email button to test the email server settings. 

For more details on ics files and setting up users for receiving emails, see Appendix E: Updating 
Calendars with .ics Event Files. 

Document Folders Tab 

The Document Folders tab lets you organize sales and accounting documents and emails 
according to your company’s unique needs – and in any location accessible from the CRM and 
Collections server. 

Note:  

o You select the location for email storage for Overdue Payment Reminders, Payment Due 
Alerts, and Send Invoices on the Options > Email tab. You then specify the actual folders for 
the location on this tab – or using the Overdue Payment Reminders Setup program, Payment 
Due Alerts Setup program, and Send Invoices Setup program for each of these documents. 

o You can use UNC file paths to specify the archive folder (such as 
\\ComputerName\C$\SentEmails).  

Generic Documents Folder:  This is the folder where emails from the Send Bulk Email program 
are stored, along with any documents that you drag and drop on the Documents grid and specify 
the Generic Documents folder. (EML files store the complete email, including attachments.) 

You can also store emails created by Overdue Payment Reminders, Payment Due Alerts, and 
Send Invoices programs in this location by selecting the “Generic Documents Folder” choice for 
Email Archive on the Options > Email tab. 

And this is the default location where other Send Documents programs store their EML files. The 
files are referenced in CRM as Communications. If you do not specify a Shared Documents 
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folder, EML files will be stored in the Sage 300 Shared Data folder under COMPANY\<company 
ID>\TaiRox CRM\Documents.  

Entity Documents Folders:  These are the folders where documents that are dragged and 
dropped onto companies, cases, tracked invoices, company communications, opportunities 
national accounts, and national account communications are stored.  

o The Opportunity entry will not appear if you installed the TaiRox Collections module (without 
CRM).  

o The National Accounts entries will not appear unless your company has licensed the Sage 
300 National Accounts features. 

You can also store emails created by Overdue Payment Reminders, Payment Due Alerts, and 
Send Invoices programs in the Company folder by selecting the “Company Documents Folder” 
choice for Email Archive on the Options > Email tab. 

The root folders for opportunity, case, communication, and tracked invoice documents can be 
located anywhere on the network, so, for example, cases, communications, and tracked invoices 
could be located on an Accounting server, and opportunities on a Sales server. 

 

In the example above, company documents are stored in the Documents\CompanyID folder, and 
documents for Cases, Communications, Tracked Invoices, and Opportunities are stored below 
that in the Cases, Communications, Opportunities, and TrackedInvoices subfolders.  

You should set up the document folder locations before you start using CRM and Collections. 
See Options - Document Folders tab for more information. 

Customer PDFs Tab 

Click the A/R and O/E Invoice and Credit Note Options buttons to choose the report and report 
options to use for generating A/R and O/E invoices and credit/debit notes attached to emails sent 
by the Overdue Payment Reminders program, Payment Due Alerts program, and Send Invoices 
program. 

o The A/R Invoice Options apply also to A/R Credit and Debit notes. 

o The “V/M” invoice and credit note buttons appear if you use Technisoft's Service Manager 
application for Sage 300. 

Note:  The reports and options specified here are shared by the Overdue Payment Reminders 
program, Payment Due Alerts program, and the Send Invoices program, so the invoices 
generated by all three programs will match.  

Step 2:  Add opportunity stages – if you have CRM and Collections 

Opportunity stages are the key milestones of your sales process.  For example, your process might 
include the following steps: “Prospect,” “Qualified”, “Meeting”, and “Proposal.”  

Opportunity Stages appear in a dropdown list on the CRM and Collections Opportunity screen. 

If you are using the stand-alone Collections module, you will not see Opportunity Stages. 
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• Add opportunity stages to TaiRox CRM using TaiRox CRM and Collections > Setup > 
Opportunity Stages. 

 

Notes: 

• The Sort Order determines the order that opportunity stages will appear in the Finder for the 
“Stage” field on the Opportunity screen. In this example, UNQUAL has sort order “1”, and so it 
appears at the top of the list.  

 

• The following stages (shown in sort order) are created by default when you activate CRM: 

o UNQUAL      (sort order 1) 
o QUALIFIED (sort order 2) 
o MEETING (sort order 3) 
o PROPOSAL (sort order 4) 

You can edit the default stages, add new ones, and change the sort order to match your 
company’s sales process. 

Step 3:  Add case stages for one or more types of cases 

• Add case stages to TaiRox CRM using TaiRox CRM > Setup > Case Stages. 

• You do not have to use case stages, but they let users quickly see the progress of each case. 

CRM and Collections provides four different types of cases: collection, support, appointment, and 
other. The case stages should include the main steps that your company might complete for each of 
the collection, support, and customer service processes.  

Each case stage that you define is identified by a code and a description. Stages also include notes 
where you can document the procedures for each stage. 

If you use only one type of case, such as collection cases, you might have codes like this: 
“REMINDER,” “DEFAULTNOTE”, “DEMAND”, and “LEGAL.”  
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However, if you use more than one type of case – for example, cases for collection issues and for 
support issues – you would probably define a full set of case stages for each type of case, using 
codes like C1, C2, C3 for stages in the collections process and codes like S1, S2, S3 for support 
stages – as in the following screen.  

  

Notes: 

• The Sort Order determines the order that the case stages will appear in the Finder for the 
“Stage” field on the Case screen. For example, “A1” has sort order “1” and will appear at the top 
of the finder list. 

   

Step 4:  Add communication types 

Communication types appear on communications and show how you communicated with companies 
and contacts – such as by phone, email, mail, fax, text, or meeting. Each time you document a 
communication, you must also specify the communication type. 

• Add communication types to CRM using TaiRox CRM > Setup > Communication Types.  

• The following default communication types are created automatically when you activate CRM: 

o EMAIL 
o FAX 
o MAIL 
o PHONE 
o TEXT 
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Step 5:  Add optional fields 

You can add Sage 300 optional fields to companies, national accounts, contacts, opportunities, users, 
documents, communications, and cases. Optional fields in CRM are displayed in data grids – such as 
in the lists of companies, national accounts, contacts, and users – as well as on Optional Field tabs. 

To use optional fields with CRM records: 

• First, add optional fields to Sage 300 using Common Services > Optional Fields. 

You can also add a set of values for a Finder list when you add the fields. 

• Second, add optional fields to TaiRox CRM using TaiRox CRM > Setup > Optional Fields. 

You can set the default value of an optional field by choosing Yes in the Value Set field and 
selecting the value in the Default Value field from values that were added in Common Services. 
Or you can enter a default value if no list of values were added. 

 

Notes: 

• If the list is empty, just click the “Optional Field” column heading and select the first optional field 
from the list that appears. 

If the list already contains optional fields, click the Insert key, and then click the Finder to select 
the new optional field from the list. 

• Double-click the Value Set field to set a default value for the field. 

• Use the Finder in the Default Value field to select from values or enter a default value if no list of 
values exists. 

• If you add an optional field to CRM that is already used for A/R customers or national accounts, 
CRM will display the following message. Click Yes to update Companies/National Accounts with 
the optional field values from A/R. 

  

CRM will continue to synchronize optional fields for companies and national accounts unless you 
select the Suspend A/R Integration checkbox in CRM and Collections Options. 

• Similarly, if you add an optional field to CRM that is already used for M/T Contacts, CRM and 
Collections will update CRM contacts with the optional field values from Sage 300, and will 
continue to synchronize optional fields for contacts unless you select the Suspend M/T Integration 
checkbox in Setup Options. 
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Set up Contacts, Companies and National Accounts 

If you have the Sage 300 Multiple Contacts module, make sure that M/T Contacts is activated, then 
follow “Step 6” and “Step 7” to set up CRM contact and company records. 

• If you previously used TaiRox Productivity Tools to add contacts in Extended Customers, make 
sure that you update TaiRox Productivity Tools contacts to Sage 300 M/T Contacts before you 
continue. 

After updating TaiRox Productivity Tools contacts, run Sync Contacts to check that all contacts 
have been copied to TaiRox CRM and Collections. 

If you do NOT have the Sage 300 Multiple Contacts module, go directly to “Step 7” to set up CRM 
company records. 

Step 6:  Sync TaiRox Contacts with Sage M/T Contacts (if you use the Sage 
Multiple Contacts module) 

If you have the Sage 300 Multiple Contacts module, activate the Sage 300 M/T Contacts module if 
you have not already done it. 

Use Periodic Processing > Sync Contacts to add the list of contacts maintained in Sage’s M/T 
Contacts module to the list of contacts maintained by TaiRox CRM. After setting up CRM and 
Collections, you can use Sync Contacts to ensure that both lists of contacts match. 

The Sync Contacts icon will not appear in the Periodic Processing folder unless M/T Contacts 
is activated. 

Note:  Make sure that “Suspend M/T Integration” is NOT selected in Setup Options. 

The Sync Contacts program is disabled if you select the Suspend M/T Integration checkbox. Do 
not suspend M/T Integration while setting up CRM and Collections. 

 

Notes:   

• Proceed through the wizard to copy all Sage contacts to TaiRox CRM and all CRM contacts to 
Sage M/T Contacts. 

• See Sync CRM Contacts with M/T Contacts for details on using the program. 
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Step 7:  Sync National Accounts and Companies with A/R Customers and 
Customer Contacts 

Use Periodic Processing > Sync National Accounts and Sync Companies to add all active A/R 
national accounts and customers to TaiRox CRM and Collections.  

National Accounts is an optional feature in Sage 300 and must be licensed to appear in CRM. 

If using National Accounts then you must run Sync National Accounts before running Sync 
Companies. 

Sync National Accounts ensures that the list of national accounts in TaiRox matches the list of 
national accounts in Accounts Receivable. 

Sync Companies ensures that the list of companies maintained by TaiRox matches the list of 
customers in Accounts Receivable. 

Note regarding inactive customers and national accounts:  Sync Companies and Sync 
National Accounts only consider active customers and national accounts when checking that 
records in TaiRox CRM and Collections match those in Accounts Receivable. 

If you need to add inactive customers or national accounts to CRM and Collections: 

• Open the inactive customer/national account in Accounts Receivable.  

• Make the inactive customer/national account active, and save the change. CRM and Collections 
will automatically sync the record. 

• Make the customer/national account record inactive in A/R again, and save the change. 

Generally, you will want to add all of your current Sage 300 A/R customers and national accounts to 
CRM and Collections. 

Note:  Make sure that “Suspend A/R Integration” is NOT selected in Setup Options. 

The Sync Companies and Sync National Accounts programs are disabled if you select the 
Suspend A/R Integration checkbox. Do not suspend A/R Integration while setting up CRM and 
Collections. 

     

Notes:   

• Choose Sync National Accounts and then choose Sync Companies and proceed through the 
wizards to copy all Sage A/R national accounts and customers to TaiRox CRM and Collections. 

• See Sync CRM Companies with Sage 300 A/R Customers and Sync TaiRox National Accounts 
with Sage 300 National Accounts for details on using the programs. 

After Syncing Companies and National Accounts: 

• For each company, you can enable or disable settings for sending overdue payment reminders, 
payment due alerts, and invoices to company contacts. For each national account, you can send 
or disable overdue payment reminders. 
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You can also change the minimum number of days that payment is overdue before sending 
overdue payment reminders to a customer or national account, and the minimum number of days 
between payment reminders. By default, the program uses the settings in Overdue Payment 
Reminders Setup, Payment Due Alerts Setup, and Send Invoices Setup. 

Step 8:  Run “Import Prod. Tools Contacts” if you use TaiRox Productivity Tools 
to add contacts to A/R Customers 

The “Import Prod. Tools Contacts” icon will not appear in the CRM Setup folder if you use the 
Multiple Contacts module with Sage 300.  

The Import Prod. Tools Contacts program in the Setup folder lets you import contacts for A/R 
customers that are maintained by the Extended Customers program in TaiRox Productivity Tools – 
prior to the introduction of the Sage 300 Multiple Contacts module. 

The TaiRox Productivity Tools User Guide provides instructions for updating contacts when you 
activate the M/T Contacts module. 

The following “Import Prod. Tools Contacts” screen shows settings for importing all active contacts 
from TaiRox Extended Customers for all companies that are active. (These settings match the 
behavior of Sync Contacts and Companies.) 

 

Notes:   

• See Appendix F: Exporting and Importing Companies, Contacts, and Notes for information on 
importing data from other accounting systems or contact management programs. 

Set up Territories, Users, and Security 

Company, user, and territory considerations for setting up 

Each company in CRM and Collections must be assigned to a territory.  

• Companies that are imported from A/R are assigned the territory code from A/R. If the territory 
code was blank in A/R, they are added to the Default (blank) group in CRM. 

• Companies that are added in CRM are also assigned a territory code. You can choose a blank 
(default) code, or choose an existing territory from a dropdown list. 

• Opportunities and cases are linked to companies and, therefore, are linked indirectly to a territory. 
Contacts that are linked to companies are also indirectly linked to the companies’ territories. 

CRM users see companies, opportunities, cases, tasks, and notes based on their assigned territories.  
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• A CRM user can be granted the right to see all territories. CRM includes a switch that effectively 
turns off all territory restrictions for a user. 

• Alternatively, a CRM user can be granted rights to see any number of specific territories. There is 
no hierarchy of territories.  

For more information on CRM security, see Appendix G: CRM Security. 

Step 9:  Add descriptions to territory codes and add new territory codes if you 
need them 

 

Notes:  

• Double-click a row to display territory information and add a territory name.  

You can also add notes – for example, to say who is assigned the territory, or to provide phone 
numbers and addresses.  

• Click the Add button to add new territories to CRM. 

Step 10:  Add Sage 300 users to CRM and Collections 

• First, add users to Sage 300 using Administrative Services > Users. 

Note: You must add an email address to the Email 1 field in Sage 300 to send calendar events to 
assigned users for cases, opportunities, and tasks. 

• Second, add Sage 300 users to TaiRox CRM using TaiRox CRM > Setup > Users. 



Setting Up CRM and Collections  Set up Territories, Users, and Security 

TaiRox CRM and Collections for Sage 300 13 User Guide 

 

Notes: 

• Click the Add button on the Users screen. 

• Enter the User ID or use the Finder to select the new CRM user.   

Note: You must add the user to Sage 300 first. 

• Select the “All Territories” checkbox if you want the user to see opportunities, cases, and notes 
for all territories – not just territories to which they are assigned. 

• Click the Add button on the User screen. 

To assign users to territories: 

You do not have to assign users to individual territories if they have access to All Territories. 

• Click the Territories tab on the Users screen: 

 

Note that Collections users need access to all territories to run Overdue Payment Reminders and 
view all disputed invoices, overdue invoices, tracked invoices, and promised payments. 

• Click the Link button at the bottom of the screen. 

• Enter or select a territory code and click the Add button. 

• Click the New button ( ) on the Territory popup to add another territory. 

Step 11:  Add new CRM and Collections security groups to Sage 300 

Create security groups for different sets of users to allow different access rights for groups of users. 
See Appendix G: CRM and Collections Security. 

• Select Administrative Services > Security Groups 

• Choose “TaiRox CRM and Collections” as the application 
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Collections users require access to the Collections security authorization and should have user 
access to all territories in order to send invoices, payment due alerts and overdue payment reminders 
and view all disputed invoices, overdue invoices, tracked invoices, and promised payments. 

Step 12:  Add CRM and Collections users to security groups in Sage 300 

After creating CRM and Collections security groups, add users in Sage 300 Administrative Services. 
See Appendix G: CRM and Collections Security. 

• Select Administrative Services > User Authorizations 

Specify Email Settings for Customer Documents 

CRM and Collections lets you email invoices, statements, letters, payment due alerts, and overdue 
payment reminders to multiple recipients and create a communication record of each email for easy 
lookup.  

• You specify all email message details for the Send A/R statements/Letters, Send A/R Invoices, 
and Send O/E Invoices programs using the Accounting Documents screen. These programs are 
replacements for Sage 300 programs that save copies of statements, letters and invoices as 
communications. 

• You choose the email templates for overdue invoice reminders, payment due alerts and the Send 
Invoices program using the Overdue Payment Reminders Setup, Payment Due Alerts Setup, and 
Send Invoices Setup programs. 

Step 13:  Add settings for emailing overdue payment reminders, payment due 
alerts, invoices and statements 

Note that CRM and Collections uses the “Preferred Language” setting in the Company window and 
National Accounts window to send emails and attached invoices to customers in English, French, or 
Spanish. See Appendix C: Editing Email Templates for Send Invoices, Send Statements, Payment Due 
Alerts, and Overdue Payment Reminders. 

Overdue Payment Reminders Setup 

• Go to TaiRox CRM and Collections > Setup > Overdue Payment Reminders 

The Overdue Payment Reminders screen has two tabs – Settings and Scheduling. 

Settings tab 

• Overdue Payment Reminder settings are used by the Overdue Payment Reminders program 
to send reminder emails to contacts for customers and national accounts and to create phone 
tasks for users making collection calls. See Overdue Payment Reminders and Overdue Payment 
Reminders Setup for details. 

See Appendix C: Editing Email Templates for Send Invoices, Send Statements, Payment Due 
Alerts, and Overdue Payment Reminders for information on creating email templates. 
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Days Overdue:  The default settings provide standard 30-60-90 aging buckets, but you can 
change the number of days for each range.  

CRM uses these aging buckets to assign overdue invoices to invoice stages when you click the 
Update button on the Overdue Payment Reminders form.  

Labels and Color:  You can change the labels and colors used for each overdue invoice stage. 
Labels appear on the Overdue Payment Reminders form. 

Action:  The program supports two actions: 

o Send Email – to send payment reminders using the selected email template to company or 
national accounts contacts when a company’s oldest invoice reaches this overdue stage. 

o Create Task – to create a collections task for calling up a company or national account 
contact when the company’s oldest invoice reaches this overdue stage. 

Email Template:  Choose the default email message that you want to send to customers for 
each overdue invoice stage. You can edit the default template files or add your own. 

Note the following points regarding template locations: 

o During installation, the program copies the email templates to the following program directory: 

\<Sage300>\XQ61A\Templates\Overdue Payment Reminders  

o When you first activate CRM and Collections for a new company, the program copies the 
email templates to the following company directory 

C:\Sage300SharedData\Company\<companyID>\TaiRox CRM\Templates\Overdue Payment Reminders 

o The Setup program looks in the company directory for Overdue Payment Reminder 
templates: 

C:\Sage300SharedData\Company\<companyID>\TaiRox CRM\Templates\Overdue Payment Reminders 

Preview:  Click the Preview button to view the body of the selected payment reminder email 
template. If you use National Accounts, the program lets you see how an email appears when 
sent to a customer or national account contact. 

Note:  The Preview button will use the default program for the file type that’s set up in 
Windows File Explorer. For example, the default program may be your internet browser. 

Attachments:  Click the Attachments button to add additional attachments to all of the overdue 
payment reminder emails – such as your policy on overdue accounts. 
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You can use “drag and drop” to add attachments, or click the Add button on the Attachments 
screen to search for attachments using Windows File Explorer. 

Install Current Templates button:  When you update CRM and Collections, you can get the 
most recent templates installed by program updates by clicking the “Install Current Templates” 
button. It will copy new templates from \XQ61A\Templates\Overdue Payment Reminders to the 
company folder. 

Minimum days overdue before creating an Overdue Payment Reminder lets you specify the 
default minimum number of days that an invoice must be overdue before it will create an overdue 
payment reminder record.  

You can change this setting for individual companies in the Company window and for national 
accounts in the National Accounts window. (For example, you may have customers whose 
payment is always late or who may have different payment terms.) 

Minimum number of days between Overdue Payment Reminders ensures that you do not 
spam customers with too many payment reminders. If you do not specify a minimum (e.g. 7 or 14 
days), the program will create a new reminder for all overdue invoices each time you update the 
overdue payment reminders list and process payment reminders. See Overdue Payment 
Reminders for details. 

You can also change this setting for individual companies and national accounts. 

Exclude customers with a credit balance:  Select this option if you do not want to send 
overdue payment reminders to customers that have credit balances. This setting applies to 
customer overdue payment reminders, not to payment reminders sent to national accounts. 

Format:  Select Overdue Invoices to only list overdue invoices, debit notes and interest charges 
on overdue payment reminders, or select Account Summary to list all unpaid documents and 
unapplied credits. 

Email Subject:  Specify the subject line that you want to appear on all overdue payment 
reminder emails. 

From Email:  Specify the “From Email” address that you want to appear on reminder emails. 

Reply-To Email:  You can also specify a different email address that will be used when recipients 
reply to your overdue payment reminder emails. 

Cc / Bcc:  Add email addresses in the Cc and Bcc fields to send copies (or blind copies) to other 
recipients in your company. To Cc or Bcc multiple recipients, separate the email addresses with 
commas or semicolons. 

Create a Communication When You Send an Email:  Select the “Create a Communication” 
checkbox to create a communication for overdue payment reminders that are emailed to 
customer and national account contacts. 

Scheduling tab 

The Scheduling tab provides the user information that will be in effect when running the Overdue 
Payment Reminders program as a scheduled background task.  

• Send Email settings:  Apply to any selected customers that have a Send Email action. 

Attach Copies of the Invoices:  Select to include PDF copies of overdue invoices with emails. 

Substitution Variables:  Enter values for variables that appear in the email templates when 
reminders are sent from a Windows scheduled task. (Note that the actual task user may be the 
Sage 300 Admin user, but you may want emails to be from the Accounts Receivable manager.) 

• Create Task settings:  These settings apply to customers that have a Create Task action. 

You can specify a user name in the Task options to assign tasks for this set of companies to a 
single user.  

Specify the number of days following run time that the call task should appear on the assigned 
user’s dashboard. 
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• Exclude Customer settings:  Use the checkboxes to choose which invoices to exclude from 
emails or tasks. 

Payment Due Alerts Setup 

• Go to TaiRox CRM and Collections > Setup > Payment Due Alerts 

The Payment Due Alerts screen has two tabs – Settings and Scheduling. 

Settings tab 

• Payment Due Alerts settings are used by the Payment Due Alerts program to send reminder 
emails to customer contacts about upcoming invoice payments. See Payment Due Alerts and 
Payment Due Alerts Setup for details. 

 

Number of days before due date to send a Payment Due Alert lets you specify the number of 
days before payments are due to send reminders. This number applies to the invoice that is 
closest to being due.  

You can change this setting for individual companies in the Company window. (For example, you 
may customers whose payment is always late or that may have different payment terms.) 

Minimum number of days between Payment Due Alerts ensures that you do not send 
customers too many payment alerts. If you do not specify a minimum (e.g. 10 days), the program 
will let you create a new alert each time you run Update and process payment due alerts. This 
can result in spamming customers. 

Note:  The Minimum number of days between Payment Due Alerts must be less than the 
Minimum number of days before the due date to send Payment Due Alerts. This ensures that 
an alert will be sent for each invoice before it becomes due. 

Email Template:  Choose the default email message that you want to send to customers to 
remind them of invoice payments. You can edit the default template files or add your own – and 
you can override the default email message templates when you process payment due alerts.  

Note the following points regarding template locations: 

o During installation, the program copies the email templates to the following program directory: 

\<Sage300>\XQ61A\Templates\Payment Due Alerts  

o When you first activate CRM and Collections for a new company, the program copies the 
email templates to the following company directory 

C:\Sage300SharedData\Company\<companyID>\TaiRox CRM\Templates\Payment Due Alerts 
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o The Payment Due Alerts Setup program looks in the company directory for Payment Due 
Alerts templates. Template files must be stored in the following folder to be selected by the 
program. 

C:\Sage300SharedData\Company\<companyID>\TaiRox CRM\Templates\Payment Due Alerts 

Preview:  Click the Preview button to view the body of the selected payment due alert email 
template. 

Note:  The Preview button will use the default program for the file type that’s set up in 
Windows File Explorer. For example, the default program may be your internet browser. 

Attachments:  You can add additional attachments to all of the payment due alert emails – such 
as your policy on overdue accounts. 

You can use “drag and drop” to add attachments, or click the Add button on the Attachments 
screen to search for attachments using Windows File Explorer. 

Email Subject:  Specify the subject line that you want to appear on all payment due alert emails. 

From Email:  Specify the “From Email” address that you want to appear on all payment due alert 
emails. 

Reply-To Email:  You can also specify a different email address that will be used when recipients 
reply to your payment due alerts. 

Cc / Bcc:  Add email addresses in the Cc and Bcc fields to send copies (or blind copies) to other 
recipients in your company. To Cc or Bcc multiple recipients, separate the email addresses with 
commas or semicolons. 

Create a Communication When You Send an Email:  Select the “Create a Communication” 
checkbox to create a communication when payment due alerts are emailed to customers. 

Scheduling tab 

The Scheduling tab provides the user information that will be in effect when running the Payment 
Due Alerts program as a scheduled background task. 

• Send Email settings 

Attach Copies of the Invoices:  Select to include PDF copies of due invoices with emails. 

Substitution Variables:  Enter values for variables that appear in the email templates when 
reminders are sent from a Windows scheduled task. (Note that the actual task user may be the 
Sage 300 Admin user, but you may want emails to be from the Accounts Receivable manager.) 

See Appendix C: Editing Email Templates for Payment Due Alerts, Overdue Payment Reminders, 
Send Invoices, and Send Statements for information on creating email templates. 

Send Invoices Setup 

• Go to TaiRox CRM and Collections > Setup > Send Invoices 

The Send Invoices Setup screen has two tabs – Settings and Scheduling. 

Settings tab 

• Send Invoices settings are used by the Send Invoices program to send emails to customers 
with posted and unsent attached invoices. See Send Invoices and Send Invoices Setup for 
details. 
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Email Template:  Choose the default email message that you want to send to customers with 
invoices. You can edit the default template files or add your own – and you can choose a different 
email message template when you send invoices.  

Note the following regarding template locations: 

o During installation, the program copies the email templates to the following program directory: 

\<Sage300>\XQ61A\Templates\Send Invoices 

o When you first activate CRM and Collections for a new company, the program copies the 
email templates to the following company directory 

C:\Sage300SharedData\Company\<companyID>\TaiRox CRM\Templates\Send Invoices  

o The Send Invoices Setup program looks in the company directory for Invoice templates. 
Template files must be stored in the following folder to be selected by the program. 

C:\Sage300SharedData\Company\<companyID>\TaiRox CRM\Templates\Send Invoices  

You can get the most recent templates installed by program updates by copying the new 
templates from \XQ61A\Templates\Send Invoices to the company folder. Make sure that your 
current templates have a different name from the templates installed by CRM and Collections. 

Preview:  Click the Preview button to view the body of the selected Send Invoices email 
template. 

Note:  The Preview button will use the default program for the file type that’s set up in 
Windows File Explorer. For example, the default program may be your internet browser. 

Attachments:  Click the Attachments button to add additional attachments to all of the invoice 
emails – such as your policy on overdue accounts. 

You can use “drag and drop” to add attachments, or click the Add button on the Attachments 
screen to search for attachments using Windows File Explorer. 

Email Subject:  Specify the subject line that you want to appear on all invoice emails. 

From Email:  Specify the “From Email” address that you want to appear on all invoice emails. 

Reply-To Email:  You can also specify a different email address that will be used when recipients 
reply to your invoice emails. 

Cc / Bcc:  Add email addresses in the Cc and Bcc fields to send copies (or blind copies) to other 
recipients in your company. To Cc or Bcc multiple recipients, separate the email addresses with 
commas or semicolons. 

Create a Communication When You Send an Email:  Select the “Create a Communication” 
checkbox to create a communication when invoices are emailed to customers. 



Setting Up CRM and Collections  Specify Email Settings for Customer Documents 

TaiRox CRM and Collections for Sage 300 20 User Guide 

Scheduling tab 

The Scheduling tab provides the user information that will be in effect when running Send 
Invoices as a scheduled background task.  

See the CRM and Collections Scheduler User Guide for information on setting up Windows 
scheduled tasks for sending invoices. 

• Send Email settings 

Substitution Variables:  Enter values for variables that appear in the email templates when 
invoices are sent from a Windows scheduled task. (Note that the actual task user may be the 
Sage 300 Admin user, but you may want emails to be from the Accounts Receivable manager.) 

See Appendix C: Editing Email Templates for Send Invoices, Send Statements, Payment Due Alerts, 
and Overdue Payment Reminders for information on creating email templates. 

Send Statements Setup 

• Go to TaiRox CRM and Collections > Setup > Send Statements 

The Send Statements screen has two tabs – Settings and Scheduling. 

Settings tab 

• Send Statements settings are used by the Send Statements program. 

 

 

Email Template:  Choose the default email message that you want to send to customers with 
statements. You can edit the default template files or add your own. 

Note the following regarding template locations: 

o During installation, the program copies the email templates to the following program directory: 

\<Sage300>\XQ61A\Templates\Send Statements 

o When you first activate CRM and Collections for a new company, the program copies the 
email templates to the following company directory 

C:\Sage300SharedData\Company\<companyID>\TaiRox CRM\Templates\Send Statements  

o The Send Statements Setup program looks in the company directory for Statements 
templates. Template files must be stored in the following folder to be selected by the 
program. 

C:\Sage300SharedData\Company\<companyID>\TaiRox CRM\Templates\Send Statements  

You can get the most recent templates installed by program updates by copying the new 
templates from \XQ61A\Templates\Send Statements to the company folder. Make sure that your 
current templates have a different name from the templates installed by CRM and Collections. 

https://www.tairox.com/downloads/crm/Scheduler%20User%20Guide.pdf


Setting Up CRM and Collections  Specify Email Settings for Customer Documents 

TaiRox CRM and Collections for Sage 300 21 User Guide 

Preview:  Click the Preview button to view the body of the selected Send Statements email 
template. 

Note:  The Preview button will use the default program for the file type that’s set up in 
Windows File Explorer. For example, the default program may be your internet browser. 

Attachments:  Click the Attachments button to add additional attachments to all of the statement 
emails – such as your policy on overdue accounts. 

You can use “drag and drop” to add attachments, or click the Add button on the Attachments 
screen to search for attachments using Windows File Explorer. 

Email Subject:  Specify the subject line that you want to appear on all statement emails. 

From Email:  Specify the “From Email” address that you want to appear on all statement emails. 

Reply-To Email:  You can also specify a different email address that will be used when recipients 
reply to your statement emails. 

Cc / Bcc:  Add email addresses in the Cc and Bcc fields to send copies (or blind copies) to other 
recipients in your company. To Cc or Bcc multiple recipients, separate the email addresses with 
commas or semicolons. 

Create a Communication When You Send an Email:  Select the “Create a Communication” 
checkbox to create a communication when statements are emailed to customers / national 
accounts. 

Scheduling tab 

The Scheduling tab provides the user information that will be in effect when running Send 
Statements as a scheduled background task.  

See the CRM and Collections Scheduler User Guide for information on setting up Windows 
scheduled tasks for sending statements. 

• Send Email settings 

Substitution Variables:  Enter values for variables that appear in the email templates when 
statements are sent from a Windows scheduled task. (Note that the actual task user may be the 
Sage 300 Admin user, but you may want emails to be from the Accounts Receivable manager.) 

See Appendix C: Editing Email Templates for Send Invoices, Send Statements, Payment Due Alerts, 
and Overdue Payment Reminders for information on creating email templates. 

Step 14:  Add settings for emailing invoices, statements and letters to customers 

• Open TaiRox CRM and Collections > Setup > Accounting Documents to specify properties 
for emails sent using Send Statements/Letters, Send A/R Invoices, and Send O/E Invoices. 

• Send Invoices, Send Statements, Overdue Payment Reminders, and Payment Due Alerts 
do not use this form for email settings. 

o You select email templates for Overdue Payment Reminders and Payment Due Alerts in the 
Overdue Payment Reminders Setup, Payment Due Alerts Setup, Send Invoices Setup and 
Send Statements Setup screens. 

Notes: 

• Select the document type from the Name dropdown at the top of the screen. 

  

https://www.tairox.com/downloads/crm/Scheduler%20User%20Guide.pdf
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• The message details at the top of the screen let you specify a different reply-to email address, 
Cc, Bcc, email subject and email message body for each type of accounting document. The 
“From Email” will override the default From Email address specified on the Email tab in the 
Options program. 

Separate multiple Cc and Bcc recipients’ email addresses with commas or semicolons. 

 

• The Attachment Limit is the maximum number for attachments for a single email. For example, if 
you specify 1, the program will generate a separate email for each invoice that’s sent to the same 
company email address or contact.  

Enter “0” for no limit on the number of attachments. 

• Select “Create a Communication When You Send an Email” to store a copy of each email that 
CRM creates as a communication. You can look up past emails by communication or recipient. 

• The Email Archive Folder field lets you specify a different archive folder for each type of 
accounting document. If you do not specify a folder, CRM will use the Email Archive Folder 
specified on the Document Folders tab in the Options form.  

• Choose from the “Organize By” dropdown to save all communications in subfolders of the Email 
Archive Folder you specified, organized by Year (ArchiveFolder\YYYY), Year and Month 
(ArchiveFolder\YYYYMM) or Year, Month, and Day (ArchiveFolder\YYYYMMDD). 

• Accounting documents use the server set up on the Email tab in CRM and Collections Options.  

 

Step 15:  Specify the email recipients of accounting documents on the Contacts 
tab for each company and national account 

The Contacts tab in TaiRox Collections’ Company window and National Accounts window lets you: 

• Add contacts to existing companies and national accounts. 

• Identify which contacts will be emailed statements, letters, invoices, overdue invoice payment 
reminders, and payment due alerts. 
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(Note that you can also specify which documents contacts receive on the Companies tab in the 
Contacts window, but it’s quicker to add contacts to a company or national account and select 
email recipients and documents in the Companies and National Accounts windows.) 

 

You add company 
contacts using the 
Company or Companies 
window (shown here) 
and national accounts 
contacts using the 
National Account or 
National Accounts 
window. 

If you already email statements, letters and invoices to customers from Sage 300, CRM and 
Collections’ Send Documents features will continue to email statements, letters and invoices to 
customers if their Delivery Method in A/R is set to Email or Contact’s Email.  

In addition, all Collections programs that email documents create a communication for each emailed 
invoice, statement, letter, or notice and attach it to the company record, so you can look up emailed 
documents to confirm them later. 

However, to use all email features (such as sending different documents to different – and multiple 
– recipients), you must: 

• For each company, specify the email recipients for each document type on the Contacts tab in 
the Company (or Companies) window.  

You can specify any number of recipients from the list of CRM contacts for the company. 

Hint:  Right-click the column headings in the grid and choose “Hide Most Columns” to easily view 
the contact names and the email forms (as shown above). You can reset the columns after 
selecting email recipients, or choose the precise group of fields that you want to display – such as 
the email address field or the Address 1 field. 

 

Note:  If you do not set up recipients on the Contacts tab for each company / national account, 
you cannot send documents to multiple recipients – or different recipients – for each type of 
accounting document. 

See Specify Email Addresses for Statements, Letters, Invoices, Overdue Payment Reminders, and 
Payment Due Alerts for details. 

Step 16:  Set up bulk email accounts 

The Bulk Email Accounts Setup program stores the connection information for your bulk email 
provider’s website.  

This information is required if you want to use the Send Bulk Email program with a bulk email service 
provider such as MailChimp or SendGrid to send general announcements or sales and marketing 
emails to customers.  

Note:  Send Bulk Email is a CRM and Collections feature. It is not included in the Collections 
module without CRM. 
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Note: 

• You can send bulk emails using the email server specified in Setup > Options if you do not 
subscribe to a bulk emailing service. 

• You do not need a bulk email provider to send invoices and other accounting documents from 
CRM and Collections to customers. 

Open TaiRox CRM and Collections > Marketing > Bulk Email Accounts to specify the connection 
properties for your bulk email account. Note that the Marketing folder will not appear on the Desktop 
unless you have CRM and Collections. 

  

Notes:   

• Choose the provider from the Provider dropdown list. CRM and Collections currently supports 
bulk emailing through MailChimp and SendGrid. More providers will be added in future.  

• The API key is from your email provider. The Send BuIk Email program uses it to log in to the 
provider’s website when you are performing a bulk email run. 

• You can enter any notes with the account record. 

See Set Up Bulk Email Accounts and Appendix D: Sending Bulk Emails and Using Bulk Email Templates 
for details. 

Add New Companies, National Accounts, Contacts & Opportunities 

You are now ready to add new prospects and contacts to CRM, and to add and track new opportunities.   

For help on performing these tasks, see the following sections in this guide. 

• To add companies:  Company – Add/Edit 

• To add national accounts:  National Account – Add/Edit 

(National Accounts is an optional feature in Sage 300 and must be licensed to appear in CRM.) 

• To add contacts:  Contact – Add/Edit 

• To add opportunities:  Opportunity – Add/Edit 

See Copying Opportunities, and also see Create Opportunities for information on generating 
opportunities for multiple companies in a single process. 

Note that Opportunities are not available with the stand-alone Collections module (without CRM). 

• To add documents:  Document – Add/Edit, 
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You can also drag and drop documents to company records, opportunities, cases, disputed 
invoices, and tracked invoices. 

Demonstrating TaiRox CRM and Collections 

CRM and Collections has functions for creating and removing demonstration data. The data will be 
created for the 12 months preceding the current Sage 300 session date.  

• Activate CRM and Collections for the database where you want to create demo data. 

• Use TaiRox CRM and Collections > Setup > Create Demo Data to create CRM Opportunities, 
Contacts, Contact Groups, Cases, Notes, Documents, and Communications.  

Different opportunities will have Won, Lost, Closed and Deferred statuses. The opportunity dates 
will be set relative to the session date (forward and backward).  

Cases will have revisit dates as might be expected, and the resulting data will produce 
reasonable Charts. 

• Use TaiRox CRM and Collections > Setup > Remove CRM Data to delete this data. 

Notes: 

• Import Customers, Import Contacts, Sync Contacts, Sync Companies, and Sync National 
Accounts are part of the go-live and maintenance processes but are not used to create 
demonstration data. 

• The following programs will generate emails and communications in demo mode, but will NOT 
actually send emails: Resend Documents, Payment Due Alerts, and Overdue Payment 
Reminders. 

Cases, opportunities and tasks will generate calendar events, but they will not send them either.   

This means that you can demonstrate this functionality without setting up an email server. 

A/R and M/T Integration are suspended in CRM and Collections Demo Data: 

Note that A/R and M/T Integration are suspended when you create CRM and Collections Demo Data. 
If you look in Setup Options, you will see that both “suspend integration” options are checked. 

 

Suspend M/T Integration appears only if you are using Sage 300’s Multiple Contacts module. 

Warning when you select Sync Contacts, Companies or National Accounts 

If you select Sync Contacts, Companies, or National Accounts, the following messages will appear. 

       

    Note that A/R and M/T Integration are suspended for your protection! 

Integration is suspended to ensure that CRM and Collections does NOT update the Sage 300 
Multiple Contacts and Accounts Receivable data for your company’s database. 
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If you created Demo Data using SAMLTD or SAMINC – or with a copy of your company database – 
and want to see the results of A/R and M/T Integration, you can turn on integration in Setup Options.  

If you uncheck the “Suspend xx Integration” checkboxes, the program will display a message like this: 
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Companies, Contacts, Cases, Tasks, 
Opportunities, and Communications 

 
* National Accounts appears only if the National Accounts module is licensed for Sage 300 

* Opportunities, Send Bulk Email, and Sales Reports appear only in TaiRox CRM and Collections—not in TaiRox Collections 

Dashboard 

“What do I need to do today, this week, or this month?” 

The Dashboard displays sales opportunities, cases, tasks, disputed invoices, tracked invoices, and 
promised payments with a revisit date for the currently selected day, week, or month that are assigned to 
you, to all users or to other users (depending on your user permissions), or that are unassigned. 

Tasks also appear on the dashboard according to the Revisit Date until they are closed. The Due Date 
does not affect when they appear on the dashboard. 

• You will not see opportunities on the dashboard with the stand-alone Collections module. 

• See Appendix G: CRM and Collections Security for details on user security access. 

Double-click to display the details for a case, task, opportunity, disputed invoice, tracked invoice, 
or promised payment. 

 

Notes: 

• The dashboard does not show cases, tasks, disputed invoices, tracked invoices or promised 
payments that are closed or deleted, or opportunities that are won/lost or deleted. 

• Today:  The session date is used by default on the Dashboard screen. If you change the date, 
click the Today button to quickly return to the session date, retaining the day-week-month state. 
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• Navigation Arrows:  Use arrows to the right of the Today button to navigate to the previous or 
next day, week or month. 

• Day, Week, Month or Year:  Choose to display items with a revisit date for the selected day, 
week, month or year. The grid includes a Revisit On Date and a Revisit On Time for scheduling 
appointments. 

• Me, All Users, Unassigned, or Other User:  “Me” displays items assigned to the logged in user. 
“All Users” shows all items the logged-in user is allowed to see, “Unassigned” shows 
opportunities, cases, tasks, tracked invoices, and promised payments that are not assigned to 
any users. You can also see items assigned to specific other users if you have permission to 
view them. 

• Refresh Button:  This button lets you reload dashboard data from the database so you can see 
new items – and changes – without closing and reopening the dashboard. 

• Automatic Refresh:  Choose File > Settings to have the screen refreshed at regular intervals: 

 

• The dashboard selects and sorts cases, opportunities, tasks, disputed invoices, tracked invoices, 
and promised payments by Revisit Date. Items without a Revisit Time display 12:00 AM.  

• Users that are not assigned to “All Territories” will only see opportunities and cases that match 
the company territories to which they have access.  

Drill Down: 

• Double-click a row to open the case, opportunity, task, tracked invoice, or promised payment. 

 

• Click the Company Name column heading (as below) to open the Company details for the 
selected row. The following screen shot shows the company information for the highlighted item – 
J & L Builders Ltd. 
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Calendar 

Like the Dashboard, the Calendar screen displays sales opportunities, tasks, cases, disputed invoices, 
tracked invoices, and promised payments according to their revisit dates.  

• Double-click a calendar entry to display the details for a case, task, opportunity, disputed invoice, 
tracked invoice, or promised payment. 

You will not see opportunities on the dashboard if you are using the stand-alone Collections module. 

• Choose to see items for the currently selected day, week, or month. 

• Choose items that are assigned to you, to another specific user, to all users, or that are 
unassigned.  See Appendix G: CRM and Collections Security for details on user security access. 

 

Navigation: 

• Use the controls above the calendar to view calendar entries in previous and next days, 
weeks, or months. 

 

• Use the navigation controls in the left panel to quickly select a different day, week, or month.  
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• Choose the user from the dropdown list in the top-right corner of the calendar. 

 

Changing Default Calendar Settings 

 

The Settings screen provides default settings for the calendar. Choose the settings that you want, 
and click the Save button. 

• Select “Settings” from the Calendar menu at the top of the screen. 

• Work Days settings determine which days of the week are displayed when you choose the “work 
week” setting at the top of the calendar screen. The following example shows a 4-day work week. 

 

You can also set the normal working hours in the day. Appointment times outside of normal hours 
are colored grey. 

• Days settings determine the time span displayed for each day, and the length of each 
appointment time – 15, 30 or 60 minutes. 

• First Day of the Week lets you choose which day appears first in work week and full week 
displays. 

 

• Number of Weeks in Month View can be from 2 to 6. You can also use the mouse to select the 
number of weeks from the left-side calendar navigation panel. 

• Compress Weekend Days in Month View splits a calendar cell in half to display Saturday and 
Sunday in a single cell. 

• Default View lets you select the view that appears when you open the calendar – Day, Week, or 
Month. 

• Default User lets you choose whose items appear when you open the calendar – your own or all 
users’.  
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Companies 

The Companies screen provides a search field so you can quickly find company information.  

• Enter partial name, short name, customer number, address information, phone number, email 
address, or company optional field information in the Search field. 

• Press Enter, or click the Search button to find the company record. 

o Click the red X to remove search terms.    

• Click the Advanced button to search for companies using ranges for additional company fields. 

Highlight the company you want, then click the additional tabs to view company Contacts, Opportunities, 
Documents, Cases, Notes, and Communications.  

• Double-click a row to view or edit company information. 

• Click the Collections button at the bottom of the screen to view customer transactions, cases, 
notes, communications, disputed invoices, overdue invoices, tracked invoices, and promised 
payments for the highlighted company. For more details, see Collections Information. 

• Click the Resend Documents button to resend documents to customers – such as statements, 
invoices, or recent receipts. See Resend Documents under Accounts Receivable and Collections. 

 
The Opportunities tab will not appear if you are using the standalone Collections module without CRM. 

Notes: 

• Click the Add button to add a new company to CRM and Collections. The company will not be 
added as a customer in Accounts Receivable until you click the Promote button. 

• You add new prospects by adding new companies to CRM and Collections that are not yet linked 
to A/R Customers. 

o You can add new contacts before adding companies using the Contacts program in CRM and 
Collections or using Sage M/T Contacts module (if activated). 

o You can then add new companies, and add new or existing contacts to the company records. 
o When you are ready, click the Promote button in the Companies window to add CRM 

companies to Accounts Receivable. See Promoting Prospects to Customers in A/R. 
o If a customer account is added separately in A/R for the new company, you can Link the 

CRM and Collections company to the existing A/R company. For details, see Linking 
Companies to Customers in A/R. 
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• New A/R Customer accounts are automatically added as companies in CRM and Collections 
unless you select the “Suspend A/R Integration” checkbox in Setup Options. 

• Users only see companies that match the company territories to which they have access. 

Drill Down: 

• Double-click a row to open up the Company screen and edit company information. 

 

• Highlight a row and click the Collections button at the bottom of the screen to view transactions, 
cases, notes, communications, disputed invoices, overdue invoices, tracked invoices, and 
promised payments for the highlighted company.  

 

You can also double-click a company name to open the Company information screen, and then 
click the Collections button there. 

Note: If you open the Collections screen from the Companies window, the program ages 
documents based on the default aging periods specified in Accounts Receivable. 

If you open the Collections screen from the Customer Aging window, the program ages 
documents based on the settings that you specify on the Customer Aging screen. 

For more details on the Collections screen – and for information on adding new cases, disputed 
invoices, tracked invoices and promised payments – see Collections Information. 

• Click on the Customer Number column heading or on the icon to the right of the Customer 
Number (top-right-hand corner) to open the A/R Customers or the TaiRox Productivity Tools 
Extended Customers screen. 
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• Click the icon to the right of the Customer Number (top-right-hand corner) to open the A/R 
Customer Inquiry or TaiRox Extended Customer Inquiry screen. 

 

Look up Customer Addresses and Contact the Customer 

• Click on the Street1 column title to open a browser at the Google Maps site for that address. 

 

• Click the Email column heading to send an email to the main company email address. 
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• Click the Phone Number column heading to open the application associated with phone numbers. 

 

A/R and M/T Integration:  If you add a new company to A/R, it will automatically appear in CRM and 
Collections with all the A/R contacts – unless you select “Suspend A/R Integration in Setup Options.  

Similarly, updating a company in one application – such as adding contacts – will update the 
company in the other application. 

See Also: 

Appendix A - Common Screen Operations for searching, sorting, tabs and common button information. 
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Add/Edit Companies 

The Company screen lets you add or change data for a company, add contacts, promote prospects to 
customers in A/R, and resend accounting documents to multiple company contacts.  

Access:  Double-click a row or click the Add button on the Companies screen.  

  
The Opportunities tab won’t appear if you are using the TaiRox Collections module without CRM. 

Click the Drilldown button to 
view all customer data  
in Sage 300 A/R. 

Click to call the number. 

Click “Collections” to view 
account issues and 
outstanding amounts. 

Click to send an email. 

Send and choose options for 
overdue payment reminders, 
payment due alerts and 
invoices (and set the preferred 
language for emails). 

Click for access to drag and 
dropped documents. 

Resend A/R and O/E 
documents to customers. 

Click to edit the customer 
address and view location on 
Google Maps. 

Notes:  

• Click the green Plus button beside the ID field ( ) to add a new company. 

The field lengths and formatting on the Company window exactly match Sage A/R Customer 
fields, so data transferred between TaiRox and Sage 300 A/R is not truncated or reformatted. 

• Click the Address button to edit the customer address or verify it on Google Maps. 

• If you have a multilingual Sage 300 installation, you can use the “Preferred Language” setting in 
the Company window to send overdue payment reminders emails and invoices to customers in 
English, French, or Spanish. See Appendix C for details. 

• Select the Overdue Payment Reminders checkbox to send overdue payment reminders to 
customers. You can change the minimum days that payment is overdue before sending an 
overdue payment reminder to customers and the minimum number of days between overdue 
payment reminders.  

You can enable or disable payment due alerts and invoices (sent by the Send Invoices program).  

By default, the program uses the settings in Overdue Payment Reminders Setup, Payment Due 
Alerts Setup, and Send Invoices Setup. 

• Use the Link button to link companies to A/R Customers. See Linking Companies to Customers. 

• Click the Resend Documents button to resend accounting documents – or send other documents 
– to multiple contacts. See Resend Documents under Accounts Receivable and Collections. 

• Click the Documents Folder button to view drag and dropped documents in the Windows folder. 

• Add as many contacts as you need on the Contacts tab. Contacts are fully integrated with the 
Sage 300 Multiple Contacts module if you use it.  

Drill Down: 

• Click the Collections button to view transactions, cases, notes, communications, disputed 
invoices, overdue invoices, tracked invoices, and promised payments for the company.  

• Click the icon beside Street 1 in the Address popup screen to open a browser and view the 
address location on Google Maps. 
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• Click the icons beside the company Email field or Contact's Email field to send an email.  

• Click the icons beside the Phone Number field or Contact's Phone field make a phone call.  

• Click the icon beside the Web Site field to open a browser using the customer’s website URL. 

See Also: 

Appendix B – Using Data Entry Programs for tabs and common button explanations. 

Adding Company Contacts on the Company Contacts Tab  

The Contacts tab in the Company window lets you:  

• Add contacts to existing companies. 

• Identify which contacts in each company will be emailed statements, letters, invoices, and 
overdue payment reminders. 

You can add as many contacts to the company as you need on the Contacts tab. 

Note:  Contacts can be independent of companies in CRM and Collections, or each one can be 
added to one or more companies. 

To add a contact to any company in CRM and Collections, you can: 

 • Select the company in the Companies window. 

 • Select the Contacts tab. 

 • Click the “Add” button at the bottom of the form to add a new contact, or click the “Link” button 
to add an existing contact to this company. 

Or: 

 • Open the Contacts window. 

 • Add a new contact or select an existing contact. 

 • Select the Companies tab. 

 • Click the “Link” button to add the contact to an existing company. 

Specifying the Recipients for Accounting Documents on the Contacts Tab  

If you already use Sage 300 to email accounting documents to customers, CRM and Collections’ Send 
Documents features will continue to email statements, letters and invoices to customers if the Delivery 
Method for the customer in Accounts Receivable is set to Email or Contact’s Email.  

A/R provides 3 email delivery methods on the A/R Customer Processing tab: 

Email (customer) – to send emails to the email address specified for the customer on the 
Address tab. 

Email (contact) – to send emails to the contact email address specified for the customer 
account on the Contact tab. 

Email (multiple contacts) to send emails to all the contact email addresses specified for 
the customer account in the Multiple Contacts section on the Contact tab (if you use the 
Multiple Contacts feature). 

However, to use all Send Documents features – and to send overdue payment reminders, payment 
due alerts, and invoices to customer contacts (using the Send Invoices program), you must: 

• For each company, specify the email recipients for each document on the Contacts tab in the 
Company (or Companies) window.  
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You can specify any number of recipients from the list of contacts for the company. Just double-
click the row and column for the document that you want to add. 

 

Note that you can also specify document recipients in the Contacts window on the Companies 
tab. 

Hint:  Right-click the column headings in the grid and choose “Hide Most Columns” to easily view 
the contact names and the email forms (as shown above). You can reset the columns after 
selecting email recipients, or choose the precise group of fields that you want to display – such as 
the email field or Address 1. 

 

Note:   

• If you do not set up email recipients on the Contacts tab for each company – or on the 
Companies tab in the Contacts window, you cannot send documents to multiple recipients – or 
different recipients – for each type of form. 

• CRM and Collections also uses the “Preferred Language” setting in the Company window to send 
overdue payment reminders, payment due alerts, and A/R and O/E invoices (using Send 
Invoices) emails and attached invoices to customers in English, French, or Spanish.  

 See Appendix C: Editing Email Templates for Send Invoices, Send Statements, Payment Due 
Alerts, and Overdue Payment Reminders for details. 

• Send Documents features create communications for emailed statements, letters, and invoices 
and attach them to company records, so you can look them up later. 

Promoting Prospects to Customers in Accounts Receivable 

The Companies and the Company screens let you add companies in CRM and Collections to the 
Accounts Receivable module as customers. 

Typically, the salesperson managing a prospect will email the receivables accounting group and ask them 
to promote a company to an Accounts Receivable customer – which will involve assigning a customer 
number, a customer group, payment terms, a salesperson and a tax group, and then conducting a credit 
check on the new customer.  

The sales department should have additional customer onboarding procedures, such as welcoming the 
new customer, acquainting them with your services, introducing them to your support staff, documenting 
their company contacts, etc. 

Access:  Highlight the company that you want to promote and click the Promote button on the 
Companies screen to add prospects to Accounts Receivable – or open the Company screen and click the 
Promote button. 

Note:  The Promote button is active for all companies that are not linked to customer records in Sage 300 
Accounts Receivable.  
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Once a company is linked to an A/R customer record, any changes in information in one module will 
automatically update information in the other module, unless you select the option to “Suspend A/R 
Integration” in Setup Options. 

You can see in the following screen that the TaiRox company does not yet have a customer number, and 
the Promote button is active.  

Click the Promote button to display a screen for creating a linked A/R customer record. 

  

 

• You must specify the A/R Customer that you want to use, along with the National Account 
number (if applicable), the Customer Group Code, Terms, Salesperson Code,, and Tax Group. 

Before Promoting: 

• Confirm the company currency before promoting the company to Accounts Receivable.  

Note:  You cannot change the currency once the customer has been added to A/R. 

• Provide the accounting department with a customer contact that can provide the business 
registration number and email addresses for billing and payment queries. 

The onboarding procedures should include documentation of credit policies, payment terms, 
preferential pricing, shipping methods, etc. 
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Notes: 

• The field lengths and formatting on the Company window exactly match A/R Customer fields, so 
data transferred between CRM and A/R is not truncated or reformatted. 

Linking Companies to Existing Customers in Accounts Receivable 

If a customer account is added separately – or already exists – in Accounts Receivable, you can Link a 
CRM company record to the existing Accounts Receivable record. 

Note that CRM automatically creates a CRM Company Record when you add a customer in Accounts 
Receivable – unless you select the option to “Suspend A/R Integration” in Setup Options. 

If you added a CRM company and manually added an A/R Customer to match the CRM company, 
you may have two CRM companies for the same customer – although only one will be linked to A/R. 

You may need to: 
 

• Find the CRM company that was automatically created. 

• Unlink and delete the CRM company that was automatically created from the A/R customer. 

• Link the CRM prospect company to the A/R customer record that was manually created. 

Access:  Open the company that you want to link, and click the Link button on the Company screen to 
link the CRM record to the existing customer record in Accounts Receivable. 

Note:  The Link button is active for all companies in CRM that are not linked to customer records in A/R. 
You can also see in the screen below that the CRM company does not yet have a customer number. 

 

To Link the CRM prospect to an existing Accounts Receivable account: 

• Open the Company that you want to link and click the Link button at the bottom of the screen. 

• Select the A/R customer number using the Finder on the form that appears. 

• Confirm that the correct Customer Name appears, and then click the link button on the popup. 

• Use the Unlink button to remove the connection between CRM and Accounts Receivable. 
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Dragging and Dropping Documents into the Company Documents Folder 
and Linking Documents to a Company 

CRM lets you attach any documents to a company record. You can use drag and drop to attach 
documents and copy them to the Company Documents folder defined in Setup Options, or you can link 
any existing documents on your computer to a company record. 

Note the following methods for adding documents to companies: 

• Use Drag and Drop on the Documents tab to copy documents to the company document folder 
in CRM and Collections (see Document Folders tab in Setup Options). 

Documents that you drag and drop are added to the Documents tab for the company, they are 
copied to the company document folder, and they are added to the list of documents maintained 
by the Documents program in CRM and Collections. 

• Use the Add button on the Documents tab to link to a document and add it to the list on the 
Documents tab.  

When you use the Add button, the document will be added to the list maintained by the 
Documents program in CRM and Collections, but the document will NOT be moved to the 
company folder. 

• Use the Link button on the Documents tab to link to a document and add it to the list on the 
Document tab.  

When you use the Link button, the program displays the list of documents maintained by the 
Documents program in CRM and Collections, letting you choose a document to add to the 
company’s list. The document will NOT be moved to the company folder. 

To drag and drop documents and move them to the Company folder: 

1. Click the Documents tab. 

2. Drag and drop a document onto the Documents tab. (The grid border turns green, and the pointer 
shows that you are dragging a document.) 

 

3. When you release the document, the grid displays the new document, showing the path to the 
documents folder – in this case F:\Sage\Sage300SharedData\company\SAMLTD\TaiRox 
CRM\Documents\COMP00004\ACME Proposal Specs.xlsx 

  



Companies, Contacts, Cases, Tasks, Opportunities, and Communications National Accounts 

TaiRox CRM and Collections for Sage 300 41 User Guide 

National Accounts 

National Accounts Management is a Sage 300 feature for handling customers that are subsidiaries or 
branch offices of a single company. It lets you apply payments received from the national account to 
outstanding branch office invoices, and it keep sales statistics for branch offices and for the national 
account. 

Note:  National Accounts Management is a separately licensed package for Sage 300. The National 
Accounts icon will not appear on the desktop if you did not license the Sage 300 National Accounts 
Management package. 

Normally, users add national accounts in the Accounts Receivable module, and the accounts are 
automatically added in CRM and Collections (unless you selected the option to Suspend A/R Integration). 
However, you can also add national accounts in CRM and Collections, and the national account will also 
be automatically added in Accounts Receivable. 

When you add a national account record in CRM or Accounts Receivable, you must also add a customer 
record for the national account and assign the national account number as the customer number (if you 
want to record invoice payments for all branches through the national account). 

 

The National Accounts screen provides a search field so you can quickly look up national accounts.  

• Enter partial name, short name, national account number, address information, phone number, 
email address, or optional field information in the Search field. 

• Press Enter, or click the Search button to find the national account record. 

o Click the red X to remove search terms.    

• Click the Advanced button to search for national accounts using additional field ranges. 

Highlight the national account, then click the additional tabs to view national account contacts, 
documents, notes, communications and national account members (companies).  

• Click the National Account column heading to view and edit the selected national account in the 
A/R National Accounts program. 
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Add/Edit National Accounts 

The National Account screen lets you add or change data for a national account, add contacts, 
documents, notes, and communications – and view all members of the national account. An Optional 
Fields tab also appears if your company uses the optional fields module. 

Access:  Click the National Account column heading, double-click a row, or click the Add button on the 
National Accounts screen to view or edit a National Account.  

  

CRM’s National Accounts are synchronized with National Accounts in Sage 300 A/R. 

Notes:  

• Click the green Plus button beside the ID field ( ) to add a new national account. 

The field lengths and formatting on the National Account window exactly match Sage A/R 
National Account fields, so data transferred between TaiRox and Sage 300 A/R is not truncated 
or reformatted. 

Note that each national account has a paired company record which provides the information for 
sending emailed invoices, payment due alerts an overdue payment reminders. 

Normally, all national accounts added in Accounts Receivable will automatically be added to CRM 
and Collections – unless you select the option to Suspend A/R Integration. 

• Click the Address button to edit the national account address or verify it on Google Maps. 

• If you have a multilingual Sage 300 installation, you can use the “Preferred Language” setting in 
the National Account window to send overdue payment reminders emails and invoices to national 
account contacts in English, French, or Spanish. See Appendix C for details. 

• You can disable overdue payment reminders by unchecking the Send Overdue Payment 
Reminders checkbox or change the minimum days that payment is overdue before sending 
overdue payment reminders to the national account and the minimum number of days between 
overdue payment reminders. By default, the program uses the settings in Overdue Payment 
Reminders Setup. 

• Add as many contacts as you need on the Contacts tab. Contacts are fully integrated with the 
Sage 300 Multiple Contacts module if you use it.  
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Putting national accounts on hold or making them inactive 

• If you put a national account on hold, you see a warning message when you add transactions for 
customers assigned to the national account. 

You can put individual member accounts on hold without affecting the national account. 

• If you make a national account inactive, you cannot add transactions for the customers in the 
national account, and you cannot change individual customer accounts attached to the national 
account except to change their national account number. 

You can make individual member accounts inactive without affecting the national account. 

Adding National Account Contacts on the Contacts Tab  

The Contacts tab in the National Account window lets you:  

• Add contacts to existing national accounts. 

• Identify which contacts for each national account will be emailed statements, letters, invoices, and 
overdue payment reminders. 

You can add as many contacts for the national account as you need on the Contacts tab. 

Note:  Contacts can be independent of companies and national accounts in CRM and Collections, or 
each one can be added to one or more companies and national accounts. 

To add a contact to any national account in CRM and Collections, you can: 

 • Select the national account in the National Accounts window. 

 • Select the Contacts tab. 

 • Click the “Add” button at the bottom of the form to add a new contact, or click the “Link” button 
to add an existing contact to this national account. 

Specifying the Recipients for Accounting Documents on the Contacts Tab  

If you already use Sage 300 to email accounting documents to national accounts, CRM and Collections’ 
Send Documents features will continue to email documents (like statements) to national accounts if the 
Delivery Method for the national account in Accounts Receivable is set to Email.  

A/R provides 3 email delivery methods on the A/R National Account Processing tab: 

Email (national account) – to send emails to the email address specified for the national 
account on the Address tab. 

Email (contact) – to send emails to the contact email address specified for the national 
account on the Contact tab. 

Email (multiple contacts) to send emails to all the contact email addresses specified for 
the national account in the Multiple Contacts section on the Contact tab (if you use the 
Multiple Contacts feature). 

However, to use all Send Documents features – and to send overdue payment reminders – you 
must: 

• For each national account, specify the email recipients for each document on the Contacts tab in 
the National Account (or National Accounts) window.  

You can specify any number of recipients from the list of contacts for the national account. Just 
double-click the row and column for the document that you want to add. 
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Hint:  Right-click the column headings in the grid and choose “Hide Most Columns” to easily view 
the contact names and the email forms (as shown above). You can reset the columns after 
selecting email recipients, or choose the precise group of fields that you want to display – such as 
the email field or Address 1. 

 

Note:   

• If you do not set up email recipients on the Contacts tab for each national account, you cannot 
send documents to multiple national account recipients for each type of form. 

• CRM and Collections also uses the “Preferred Language” setting in the National Account window 
to send emails and attached invoices to customers in English, French, or Spanish.  

 See Appendix C for details. 

• Send Documents features create communications for emailed statements and overdue payment 
reminders and attach them to national account records, so you can look them up later. 

Dragging and Dropping Documents into the National Accounts Documents Folder 
and Linking Documents to a National Account 

CRM lets you attach any documents to a national accounts record. You can use drag and drop to attach 
documents and copy them to the National Accounts Documents folder defined in Setup Options, or you 
can link any existing documents on your computer to a national accounts record. 

Note the following methods for adding documents to national accounts: 

• Use Drag and Drop on the Documents tab to copy documents to the national accounts 
document folder in CRM and Collections (see Document Folders tab in Setup Options). 

Documents that you drag and drop are added to the Documents tab for the national account, they 
are copied to the national account document folder, and they are added to the list of documents 
maintained by the Documents program in CRM and Collections. 

• Use the Add button on the Documents tab to link to a document and add it to the list on the 
Documents tab.  

When you use the Add button, the document will be added to the list maintained by the 
Documents program in CRM and Collections, but the document will NOT be moved to the 
national account document folder. 

• Use the Link button on the Documents tab to link to a document and add it to the list on the 
Document tab.  

When you use the Link button, the program displays the list of documents maintained by the 
Documents program in CRM and Collections, letting you choose a document to add to the 
national account’s list. The document will NOT be moved to the national account folder. 
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To drag and drop documents and move them to the National Account document folder: 

1. Click the Documents tab. 

2. Drag and drop a document onto the Documents tab. (The grid border turns green, and the pointer 
shows that you are dragging a document.) 

  

3. When you release the document, the grid displays the new document, showing the path to the 
documents folder – in this case F:\Sage\Sage300SharedData\company\SAMLTD\TaiRox 
CRM\Documents\BARMART\ACME Proposal Specs.xlsx 
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Opportunities 

The Opportunities program presents a search field so you can search for opportunities. It also includes a 
Company search field to find opportunities by company. Double-click a row to open an opportunity record. 

The Opportunities program will not appear if you are using the Collections module without CRM. 

 

Notes: 

• You can look up opportunities by opportunity field ranges, as well as by Opportunity Stages, 
Opportunity Status, and Territories. Use the Advanced button for selection options. 

o Click the red X to remove Search terms.    

• Each opportunity belongs to one and only one company. 

o To look up all opportunities for a single company, click the Company Finder (shown above) 
and select the company you want.  

o Click the red X to remove the company filter. 

 

• Opportunities must be assigned to a single user. 

• CRM updates users’ calendars when you change revisit dates and user assignments. See 
Appendix E:  Updating Calendars with .ics Event Files. 

• Any number of Sage 300 quotes and orders can be linked to an opportunity. 

• Users will only see opportunities that match the company territories to which they have access. 

• See Copying Opportunities later in this section and see Create Opportunities for instructions on 
generating opportunities for multiple companies. 

Drill Down: 

• Double-click a row to open the opportunity. 

• You can also click the Company Name column heading to drill down to the Companies form, or 
click the Inquiry button to view customer information. 

See Also: 

Appendix A - Common Screen Operations for searching, sorting, and using tabs. 
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Add/Edit Opportunities 

The Opportunity screen lets you add, change or copy an opportunity. If you are using the stand-alone 
Collections module, you will not see an icon for Opportunities. 

Access:  Click the Add button or double-click a row on the Opportunities screen or on the Opportunities 
tab on the Companies screen. 

 

Notes: 

• To add a new opportunity, click the green Plus button beside the ID field ( ), then click the Finder 
button ( ) beside the Company Name field to select the company. 

• To copy an opportunity, click the Copy button at the bottom of the screen. See Copying 
Opportunities. The Copy button becomes active after you click the Add button – or the Save 
button if you changed the opportunity first. 

• The Revisit On date is used to construct data for the Dashboard program. You can also enter a 
Revisit Time after the Revisit date. Enter time in 24-hour format (e.g. 13:00).  

Opportunities show up for the revisit dates on the assigned employees’ dashboards, and 
assigned users are sent calendar event files when you click the Save button, so revisit dates 
appear in their email calendars.  

• The list of opportunity stages is maintained by the Opportunity Stages setup program. 

• The status can be Open, Won, Lost, or Deferred. 

• Besides the Name and Comment fields, all other fields are used in one or more Charts. Charts 
provide weighted or un-weighted estimates of the pipeline value categorized in various ways. A 
Time to Close Chart provides an assessment of past performance.  

• The Notes field can be up to 250 characters long. 

• The Comment field can be up to 2,500 characters long. 

• Select the Orders tab to create new Quotes and Orders in Sage 300 Order Entry. 

• Click the Documents Folder button to view drag and dropped documents in the Windows folder. 

• Click the Change Log button to view past changes to the opportunity.  

See Also: 

Appendix B – Using Data Entry Programs for tabs and common button explanations. 
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Dragging and Dropping Documents into the Opportunity Documents Folder 
and Linking Documents to an Opportunity 

CRM and Collections lets you add any documents to an opportunity. You can use drag and drop to attach 
documents and copy them to the Opportunity Documents folder defined in Setup Options, or you can link 
any existing documents on your computer to an opportunity record. 

Note the following methods for adding documents to opportunities: 

• Use Drag and Drop on the Documents tab to copy documents to the opportunity document 
folder in CRM and Collections (see Document Folders tab in Setup Options). 

Documents that you drag and drop are added to the Documents tab for the opportunity, they are 
copied to the opportunity document folder, and they are added to the list of documents 
maintained by the Documents program in CRM and Collections. 

• Use the Add button on the Documents tab to link to a document and add it to the list on the 
Documents tab.  

When you use the Add button, the document will be added to the list maintained by the 
Documents program in CRM and Collections, but the document will NOT be moved to the 
opportunity folder. 

• Use the Link button on the Documents tab to link to a document and add it to the list on the 
Document tab.  

When you use the Link button, the program displays the list of documents maintained by the 
Documents program in CRM and Collections, letting you choose a document to add to the 
opportunity’s list. The document will NOT be moved to the opportunity folder. 

To drag and drop documents and move them to the Opportunity folder: 

1. Click the Documents tab. 

2. Drag and drop a document onto the Documents tab. (The grid border turns green, and the pointer 
shows that you are dragging a document.) 

 

3. When you release the document, the grid displays the new document, showing the path to the 
documents folder – in this case F:\Sage\Sage300SharedData\company\SAMLTD\TaiRox 
CRM\Documents\COMP00001\Opportunities\OPPO00002\OEORD000000000063.PDF 
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Copying Opportunities 

CRM lets you copy an open opportunity to the current company or to a different company. 

This means you can: 

• Create standard opportunities for sales or services and apply them to particular companies. 

• Duplicate past opportunities to quickly add new opportunities with similar requirements. 

To copy an opportunity: 

1. Open the opportunity that you want to copy. 

2. Click the Copy button at the bottom of the screen, and click Yes when prompted. 

 

o The program will display a message stating that the copy was successful. Click OK. 
o By default, the new opportunity will be assigned to the current company. 

3. To change the company for the opportunity, click the Finder button beside the Company Name 
field, and use the Search field to find the new company.  

In this case, we are using “bar” to find and select “Bargain Mart – San Diego.” 

 

4. Select the new company and edit the new opportunity as required, then click the Add button at 
the bottom of the screen. 

Adding New Quotes and Orders on the Orders Tab for Opportunities 

CRM and Collections provides direct access to Sage 300’s Order Entry program from the Orders tab in 
Opportunities. It lets you: 

• Add new quotes and orders and link them to opportunities. 

The program lists all quotes and orders added in CRM on the Orders tab for the opportunity. 

• Link existing quotes and orders to the Orders tab to include quoted and orders that were entered 
from the Order Entry module.  

This makes it easy to look up opportunity details and each customer’s order history.  
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To add a new quote or order to the Orders tab: 

 

1. Open the customer opportunity. 

2. Choose the Orders tab. 

3. Click the New Quote or New Order button to add a quote or order and display it on the Orders 
tab. 

Click the Link button to add an existing order to the Order tab. 

4. Select a quote or order from the grid to look up or edit order details. 
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Contacts 

The Contacts program provides a search field so you can immediately find contacts. It also includes a 
Company search field to list contacts by company (shown below).  

• Click the red X that appears to remove Search terms.    

• Click the Finder button beside the Company field to select a company name. 

• Double-click a row to open a contact record.  

• Use the “Advanced…” button to search by specific field values and ranges. 

Note:  The Contacts program lists all contacts added in TaiRox CRM and Collections or with the 
Sage 300 Multiple Contacts module (if you use it).  

 
The National Accounts tab appears if your company licenses Sage 300 National Accounts and has national accounts. 

Notes: 

• Contacts can belong to more than one company or national account – or they can be unaffiliated 
contacts that are not linked to any companies.  

For example, you can add a new contact and link it to Bargain Mart Oakland, Bargain Mart San 
Diego, and to the Bargain Mart Stores national account. 

o To find contacts for a single company, click the Company Finder (shown above) and select 
the company you want. If you are looking for a particular contact, use the top Search field on 
the form to refine your search. 

o Click the red X to remove the company filter. 

 

• You can also view all contacts that you add in TaiRox CRM and Collections using the Finder in 
the Sage 300 M/T Contacts module – if you use it Sage Multiple Contacts. 
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Note:  Contacts are permanently deleted if you use the Delete button! 

If you do not want to permanently delete a contact, edit the contact record and select the 
Inactive checkbox. 

• Contacts added to an Accounts Receivable customer record will appear automatically on the 
Contacts tab for the corresponding (linked) CRM company, and contacts added to an A/R 
national account record will appear automatically on the Contact tab in the CRM national account 
record. 

Note, however, that you still need to edit the contact information on the Contacts tab for the 
company or national account record to specify any emailed accounting documents that the 
contact should receive. See Specifying the Recipients for Accounting Documents on the Contacts 
Tab. 

• Contacts can belong to any number of Contact Groups.  

The Add To Group and Add To New Group buttons will add all filtered contacts in the search 
results to the group you specify (i.e. all contacts displayed on all current pages of contacts – 7 
pages in the example below). 

 

• Contacts can also belong to any number of companies. Click the Companies tab to see all 
companies linked to the contact. 

 

• Choose File > Export to create a file containing all pages of contacts in the search results.  

 

You can select four export file formats – MailChimp, Swiftpage, generic Sage 300 Contacts 
format, and generic Sage 300 Contacts format with optional fields (if you assigned optional fields 
to contact records).  

 

o To export to MailChimp or Swiftpage, the contact must have an email address, a first and last 
name, and must have “Yes” in the “Contact consents to receive emails” column. In addition, 
they must not be inactive or belong to an inactive or deleted company.  

o If exporting to the generic Sage 300 Contacts format with optional fields, the optional fields 
appear in a separate workbook. 
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• Use File > Import to import an “Unsubscribe” list – a file that contains a list of email addresses 
(i.e. a single column of email addresses). 

 

All contacts with those email addresses will have their “Contact consents to receive emails” 
setting unchecked (turned off). 

• You can add any contacts you like to CRM – either unattached or attached to a company. 

For example, you can add your own company to CRM, add your own employees as contacts, and 
include them in contact groups. This lets you create contact groups for departments, marketing 
projects, etc. 

For more information on contact groups, see Contact Groups. 

Drill Down: 

• Double-click on a row to open up the contact record and edit all the information for the contact. 

 

• Click the Email column heading to send an email to the selected contact. 

 

• Click a Phone number column heading to call the selected contact. 

See Also: 

Appendix A - Common Screen Operations for searching, sorting, tabs and common button explanations. 
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Add/Edit Contacts 

The Contact screen lets you add contacts, change contact information, and link or unlink contacts from 
companies and national accounts. 

To select which company and national account contacts are emailed invoices and other accounting 
documents, see Specifying the Recipients for Accounting Documents. 

Access:  Click the Add button or double-click a row on the Contacts screen or on the Contacts tab on the 
Companies screen or National Accounts screen. 

 

Notes: 

• For a new record, click the green Plus button beside the ID field ( ). 

• Social Media links are provided for information that a contact maintains themselves and is likely 
to be current. Choose the Social Media tab to add links to social media sites, such as Facebook, 
LinkedIn, Instagram, Twitter, YouTube – or to add a Skype address or telephone number. 

• The “Contact consents to receive emails” checkbox must be checked in order to export the 
contact email address to MailChimp or Swiftpage. 

• Click the Address button to add contact address information. 

• Click the Companies tab to link or unlink contacts from existing companies – and to drill-down on 
company information. 

• Click the National Accounts tab to link or unlink contacts from existing national accounts – and to 
drill-down on national account information. 

Drill Down: 

• Click a social media icon to open a browser at the contact's social media page. Click a Phone 
icon to initiate a call. 

• Click the Go button ( ) beside a phone number to call the contact or click the Go button beside 
the Email field to send a new email to the contact. 

See Also: 

Appendix B – Using Data Entry Programs for tabs and common button explanations. 
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Linking Contacts to Existing Companies and National Accounts 

Once you add a contact, you can link it to one or more companies and national accounts. For example, a 
contact might be a buyer for one or more outlets – such as Bargain Mart San Diego and Bargain Mart 
Oakland, and may also be a contact for the Bargain Mart Stores national account. 

To Link a contact to a company:  Select the Companies tab and click the Link button (see below). 

To Link a contact to a national account:  Select the National Accounts tab and click the Link button. 
Note that the National Accounts tab appears only if your company licenses Sage 300 National Accounts 
and has national accounts. 

For example, search for the company you want (in this case, we are adding another Bargain Mart outlet 
to the list of Companies), and double-click the company to add it to the list. 

 

To Unlink a contact from a company or national account:  Select the appropriate tab, select the 
company or national account from the grid, and click the Unlink button at the bottom of the screen. 
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Specifying the Recipients of Accounting Documents on the Companies Tab and 
National Accounts Tab  

CRM lets you specify the recipients of accounting documents for companies and national accounts (such 
as invoices, statements, and overdue payment reminders) in several places: 

• On the Companies tab or National Accounts tab in the CRM Contacts window. 

• On the Contacts tab in the CRM Company window or A/R Customer window. 

• On the Contacts tab in the CRM or A/R National Account window (if you use the National 
Accounts feature). 

For company contacts, you can select A/R invoices, A/R receipts, A/R statements, O/E Order 
confirmations, O/E invoices, O/E credit and debit notes, O/E quotes, CRM payment reminder emails, and 
CRM payment due alerts. 

For national account contacts, you can select A/R statements and CRM payment reminder emails. 

If you are selecting documents from CRM’s Contacts window, you can specify documents for any 
companies to which a contact is linked.  

Just double-click the row and column for the document that you want to select. 

 

Hint:  Right-click the column headings in the grid and choose “Hide Most Columns” to easily view the 
company names and the email forms (as shown above). You can reset the columns after selecting 
companies and documents, or choose the precise group of fields that you want to display – such as the 
company name, street address and phone number. 

 

Note:   

• If you do not set up email recipients in the Contacts window or the Company / National Account 
window, you cannot send documents to multiple recipients – or different recipients – for each 
type of form. 

• CRM and Collections also uses the “Preferred Language” setting in the Company window and 
National Account window to send emails and attached invoices to customers in English, French, 
or Spanish.  

 See Appendix C: Editing Email Templates for Payment Due Alerts, Overdue Payment 
Reminders, and Send Invoices for details. 

• Send Documents features create communications for emailed statements, letters, and invoices 
and attach them to company and national account records, so you can look them up later. 



Companies, Contacts, Cases, Tasks, Opportunities, and Communications Contacts 

TaiRox CRM and Collections for Sage 300 57 User Guide 

Adding One Contact to an Existing Contact Group 

Once you add a contact, you can add it to one or more contact groups – such as “Alaska Customers” or 
“Newsletter Recipients” – and send them group emails. 

To add a new contact to an existing contact group: 

• Select the Contact from the grid on the Contacts screen. 

• Click the Contact Groups tab. 

  

• Click the Link button on the Contact Groups screen. 

• Select the group where you want to add the contact. 

Adding Multiple Contacts to a New or Existing Contact Group 

You can just as easily add multiple contacts to an existing contact group or to a new one. 

To add multiple contacts to a contact group: 

• Open the Contacts screen and use Search or Advanced Search to select a set of contacts. 

  

• Click the Save button to perform the search / selection  

• Select the Contact from the grid on the Contacts screen. 

 

• Click the Add to Group or Add to New Group button. 

• Select the existing group or specify a name for the new group to add the contacts.  

Adding Social Media Links on the Social Media Tab 

You can add social media links to your contacts to keep your contact information up to date. Social media 
links can include links to social media sites, such as Facebook, LinkedIn, Instagram, Twitter, YouTube – 
as well as Skype addresses and contact telephone numbers, or FTP servers and Web servers. 
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To add a new social media link: 

• Click the Social Media tab. 

• Click the Add button on the bottom of the screen to add a link. 

• Click the Name dropdown to select the type of link. 

  

Note: The Name dropdown selection determines the social media icon that appears on the 
Contact tab for this link. 

• Enter the link information in the Link field – such as skype:555-777-8888 

o The Link field must include the application protocol so Windows will know which program to 
use for launching the link. Windows will use the default application that has been associated 
with the protocol. You can change associations in Windows Settings > Apps > Default Apps. 

o Do not include a space between the protocol name and the link.  

For example, type  
skype:5559897777 

Not 
skype: 5559897777 

o If the link includes a space, you must enclose the link text in quotes.  

For example, type:  
skype:”fred winkler” 

Common protocols are: 

− https: hypertext transfer protocol with secure communication  
− http: hypertext transfer protocol  
− tel:  uses whatever program has been associated with the tel protocol (such as the  

 MS telephone app) with a telephone number – e.g. tel:5559897777 
− skype: to launch skype with a telephone number or contact name  

 – e.g. skype:5559897777 or skype:”fred winkler” 
− ftp: to launch an FTP program to transfer files from a server 
− mailto: to send an email to an email address – e.g. mailto:rblack@rblack.com 
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Contact Groups 

The Contact Groups program presents a search field so you can immediately find contact groups.  

Access:  Open from the CRM and Collections Desktop. 
or Open the Marketing folder, then open Contact Groups.  

  

Notes: 

• Contact Groups lets you create a list of contacts and give it a name – such as “Alaska 
Customers” or “Newsletter Recipients”. 

• Contacts can belong to any number of contact groups.  

• You can add your own company to CRM, add contacts, then create contact groups for company 
departments, sales teams, or projects. 

• See Adding Multiple Contacts to a New or an Existing Contact Group for instructions on adding 
multiple contacts to groups. 

• Click the Actions button ( ) at the top of the screen by the Name field and choose Export to 
MailChimp or Export to Swiftpage to create a CSV file containing the Contacts for the selected 
contact group that you can import into MailChimp or Swiftpage email programs.  

  

To export to MailChimp or Swiftpage, contacts must have email addresses, a first and last name, 
must consent to receiving emails (this is a checkbox on the contacts screen), and must not be 
inactive or belong to inactive or deleted companies. 

• To copy an existing group to a new group with a new name, highlight the group in the grid that 
you want to copy, select Copy Group from the Actions menu ( ), and fill in the New Contact 
Group form – as below: 
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• To add the contacts in one group to an existing group, highlight the group in the grid that you 
want to copy, select Add Contacts To Another Group from the Actions menu ( ), then select the 
target group in the form that appears. 

 

Drill Down: 

• Double-click on a row to open up the Contact Group program. 

See Also: 

Appendix A - Common Screen Operations for searching, sorting, tabs and common button explanations. 
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Add/Edit Contact Groups 

The Contact Group screen lets you add new contact groups and edit existing ones. 

 

 

Notes: 

• To create a new group record, click the green Plus button beside the ID field ( ). 

• Contact Groups lets you create a list of contacts and give it a name – such as “Alaska 
Customers” or “Newsletter Recipients”. 

• The Notes field can be up to 250 characters long. 

• Choose the Contacts tab to view existing contacts and to link new contacts to this group. 

• Click the Actions button ( ) at the top of the screen by the Name field and choose Export to 
MailChimp or Export to Swiftpage to create a CSV file containing the Contacts for this contact 
group that you can import into MailChimp or Swiftpage email programs.  
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To export to MailChimp or Swiftpage, contacts must have email addresses, a first and last name, 
must consent to receiving emails (this is a checkbox on the contacts screen), and must not be 
inactive or belong to inactive or deleted companies. 

• To copy the existing group to a new group with a new name, select Copy Group from the Actions 
menu ( ), and fill in the New Contact Group form – as below: 

 

• To add the contacts in this group to another existing group, select Add Contacts To Another 
Group from the Actions menu ( ), then select the target group in the form that appears. 

 

• See Contact Groups - Contacts Tab for information on adding contacts to a contact group using 
the Link button. 

See Also: 

Appendix B – Using Data Entry Programs for tabs and common button explanations. 
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Contact Groups - Contacts Tab 

The Contacts tab on the Contact Groups screen shows contacts that belong to the group selected on the 
Contact Groups tab – and displayed in the Name field at the top of the form. It also lets you add new 
contacts or remove contacts from the group, as well as export contacts and copy them to other contact 
groups. 

• Use the Search field on this tab to find particular contacts in the list. 

o Click the red X that appears to remove Search terms.    

 

Notes: 

• Contact groups are useful for creating email lists. 

• Click the Actions button ( ) highlighted in red to perform the following tasks: 

 

o Choose Export to MailChimp or Export to Swiftpage to create a CSV file containing the 
Contacts for the current contact group. 

o Add all of the group contacts to a new group. 
o Add all of the group contacts to an existing group. 
o Add all selected group contacts to a new group. 
o Add all selected group contacts to an existing group. 

• Click the Link button to search for and add additional contacts to the displayed contact group. 
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o Use the checkboxes to select all contacts from the list that you want to add, then click the 
Select button at the bottom of the form. 

o Use Advanced Search to list all contacts in a particular city, state, or country. 

You can also filter contacts based on job title or on contact notes fields. 

Note that this form can have multiple pages and that you can select contacts on each page 
before clicking the Select button. 

• Click the Unlink button to unlink all selected contacts from the currently selected contact group. 

Note regarding multi-page contact selection: 

o Click the “Select” column heading to select or deselect all contacts on the current page. 

 

o Use the navigation buttons at the bottom of the screen to move from page to page to make 
your selections. 

 

o Click the Unlick button at the bottom of the screen when you have selected all contacts that 
you want to remove from the contact group. The program displays the following warning. 
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Send Bulk Email 

The Send Bulk Email program lets you send bulk emails from CRM and Collections using bulk email 
providers such as MailChimp and SendGrid or using the email server specified in CRM Options. 

Send Bulk Email is a CRM and Collections feature. The program will not appear on the Sage 300 
Desktop if you are using the Collections module without CRM. 

To send bulk emails, you must set up your email server in Options or subscribe to a bulk email provider 
and set up your bulk email account using the Bulk Email Accounts program. 

The program lets you take advantage of dedicated bulk email provider features, such as: 

• Email template editors and pre-built templates for sales and marketing campaigns. 

• Subscriber preferences and unsubscribe lists for different audiences and types of emails. 

• Email forms and custom landing pages. 

• Stats for email opening and click tracking. 

• Email response handling. 

• Customer surveys. 

Note that email features vary by provider. These features may not be available from your provider. 

   
       The Marketing folder does not appear on the         TaiRox Collections Desktop 

 

Notes  

• You can use templates on a bulk email provider website or stored on your Sage 300 server, or 
you can compose emails on-the-fly using Send Bulk Email. 

This lets you quickly send out a new price list to contacts or let customers know that their sales 
rep has changed. 
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• You can select email recipients from CRM contact groups, A/R customer accounts, or CRM 
companies and use unsubscribe lists and email templates stored on a bulk email provider’s 
website. 

• You can add optional fields to the communication generated by each bulk email batch. The 
communication will be linked to all contacts that the email is sent to as well as all companies if the 
contacts were derived from selected companies or customers. 

• You can add attachments to emails. 

• Bulk emails are typically non-transactional and might include newsletters, sales brochures, 
general business announcements, or notices of sales manager changes. They provide the same 
communication to all recipients, and often have to follow local opt-in or opt-out regulations.  

Transactional emails contain information about business transactions – such as a quote, order 
confirmation, shipment confirmation, or invoice. 

If you have CRM and Collections, you can export contact information and upload it to a bulk email 
provider for bulk emails (see Contact Groups), and you can use the Send Statements/Letters to send 
informational letters to your customers.   

Access:  Open the Marketing folder, then open Send Bulk Email.  
(The Marketing folder does not appear on the TaiRox Collections Desktop.)  

Using the Send Bulk Email Program 

1. Choose between sending emails using a bulk email provider such as MailChimp or SendGrid or 
sending them using the email server set up in CRM Options. 

 

If you send emails using a provider, the process will be faster and may include more features – 
allowing you to personalize emails and use multiple unsubscribe lists for different types of emails. 

2. Select the bulk email account if you are using a bulk email provider. The account must already be 
set up using the Bulk Email Accounts program in the CRM Marketing folder. 

 

If you selected “Email Server (set up in Options)” instead of a provider, the Bulk Email Provider 
fields will not be available. Skip to the “Template” field. 

Click the Finder to change your choice of bulk email provider. 

3. If you selected a bulk email provider, select the Unsubscribe Group/Subaccount for your email 
batch. The group must already be created on the bulk email provider’s website. The type of 
unsubscribe list should match the type of email that you are sending. 
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For example, if you created a NEWSLETTER unsubscribe list, you would choose that group each 
time you sent out the newsletter.  

Any newsletter recipients that unsubscribe (by clicking the Unsubscribe button or link at the 
bottom of the newsletter) will be added to NEWSLETTER unsubscribe list. 

Each time you send a newsletter using the NEWSLETTER unsubscribe list, the program will 
remove unsubscribed contacts from the recipient list. Other unsubscribe lists will be unaffected. 

4. Select the email template that you want to use.  

If you are using a bulk email provider, the template must be on the bulk email providers website.  

If you are using your own email server, the templates are normally stored in the Sage 300 
Company folder: Sage300\SharedData\Company\SAMLTD\TaiRox CRM\Templates. You can use 
the Preview button to view the selected template on the Sage 300 server. 

 

See Appendix D: Sending Bulk Emails and Using Bulk Email Templates for details. 

Alternatively, you can leave the Template field blank and enter the Subject and Body of the email 
that you are sending at the bottom of the form. 

5. Enter the “From” name and email address that will appear on the email. 

 

6. Select the method for choosing email recipients. 

 

Contacts for selected companies lets you specify ranges of CRM company record fields to 
select the list of CRM companies. The program sends emails to all contacts that are associated 
with the selected CRM companies. This choice let you select prospects as well as existing 
customers. 

Contacts for selected customers lets you specify ranges of A/R customer record fields to select 
the list of A/R customers. The program sends emails to all contacts that are associated with the 
selected A/R customers. This choice lets you select records by salesperson. 

Members of a contact group lets you choose a group of contacts as email recipients. Use the 
Contact Groups program in CRM to create new contact groups. 

Note that you can choose only one contact group and that you cannot filter members of the 
group. If you need to select members from a group, use Search or Advance Search to select 
recipients, then add the selected contacts to a new group. 

7. Click the Select button to choose recipients using the method chosen in the dropdown. 

To select a contact group, double-click the group you want: 
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To select contacts for selected customers or customer groups: 

 

In the above example, we chose “Contacts for Selected Customers”, and then chose all A/R 
customers that have salesperson “BB”. 

The number of contacts in your selection (therefore, the number of email recipients) appears 
beside the Select button.  

In the following example, this is 8 customers with 43 contacts – all of whom will get an email 
unless they are on the unsubscribe list. 

 

8. Click the Attachments button in the upper-right corner to attach other documents to this email – 
such as a price list that you want to attach to the email. 

9. Click the Optional Fields button to add optional fields for the communication that is created by this 
bulk email. 

The communication will be linked to all contacts to which the email is sent, as well as all 
companies if the contacts were derived from selected companies or customers. 

If you are not using a template, and are composing the email on this screen 

10. Type the Subject and Body of your email in the last two fields. 

 

Use the Attachments button to add a standard item for all recipients – like a new price list. 

11. Click the Send button when ready, then choose Yes to confirm that you want to continue. 

 

Viewing Communications Created by Bulk Emails in the Communications 
Window 

All email communications generated by the Send Bulk Email program appear in the Communications 
window – letting you maintain a complete trail of all customer communications.  

For more information, see Communications. 
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Documents 

The Documents program provides a search field so you can immediately find documents. It also includes 
a Company search field to restrict documents by company. Double-click a row for document details. 

• Click the red X that appears to remove Search terms.    

 

Notes: 

• Documents can be linked to Companies, National Accounts, Contacts, Communications, Cases, 
Opportunities, and Tracked Invoices. (You can also add documents for Tracked Invoices using 
the Overdue Invoices program and the Disputed Invoices program.) 

o To see all documents added to a single company record, click the Company Finder (shown 
above) and select the company you want. You can use the top Search field on the form to 
refine your search. 

o Click the red X to remove the company filter. 

 

• To add a new document to a Company, National Account, Opportunity, Communication, Case or 
Tracked Invoice: 

o Drag the new document to the Documents grid. 

o On the Popup that appears, select the location for the document -- Generic Documents 
Folder, Company / National Accounts Documents Folder, or Entity Documents Folder – then 
select the entity to which you want to link the document (a Company, National Account, 
Communication, Case, Opportunity, or Tracked Invoice). 

• To link an existing document to a Company, Contact, Opportunity or Communication, Case or 
Tracked Invoice: 

o Double-click the document that you want to link on the Documents tab. 
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o In the Document window, click the appropriate tab for the entity to which you want to link the 
document (Companies, Contacts, Communications, Cases, Opportunities, or Tracked 
Invoices tab). 

o Click the Link button on the appropriate tab. 

o Select the Company, Contact, Opportunity or Communication, Case or Tracked Invoice from 
the Finder. 

• You can also attach documents to entities by opening the entity and dragging a document to the 
Documents tab for the entity: 

o Open the Company, National Account, Case, Communication, Opportunity, or Tracked 
Invoice. 

o Select the Documents tab. 

 

o Drag and drop a new document, or click the Link button to link to an existing Document in 
CRM.  

• Document files are not stored in the database. Instead, documents reference various document 
storage repositories. Drilling down will open the referenced file. 

o Document references can be to Web site URLS. 
o Document references can be to local network drives and folders. 
o Document references can be to local drives (can only be opened by one user). 

For more information, see the Document Folders tab in Setup Options. 

Drill Down: 

• Double-click a row in the grid to view the document details. 

• Click on the Document column heading – or click the “Go” button in the upper-right corner of the 
screen ( ) – to open the highlighted document in the grid. 

See Also: 

Appendix A - Common Screen Operations for searching, sorting, tabs and button explanations. 

 

 

 

 

 



Companies, Contacts, Cases, Tasks, Opportunities, and Communications Documents 

TaiRox CRM and Collections for Sage 300 71 User Guide 

Add/Edit Documents 

Double-click a row in the Documents window to open the Document program and view document details.  

The Document screen lets you add links to new documents and edit existing document information. 

 

Notes: 

• Click the green Plus button beside the ID field ( ) to add a new document. 

• Click the Finder button ( ) beside the Document field to select or view the document location if 
on a local or network drive. 

• Copy and paste a browser URL to store a web site address. 

• The Notes field can be up to 250 characters long. 

• The Comment field can be up to 2,500 characters long. 

• Click the Delete button to delete the document record. Delete does not delete the document – just 
the record with the document link. 

• The Optional Fields tab appears if you use the Optional Fields module and assigned optional 
fields to documents. 

Drill Down: 

• Click the drilldown icon (“Go” button ) to open the document or web page. 

See Also: 

Appendix B – Using Data Entry Programs for tabs and common button explanations. 
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Dragging and Dropping Documents into the Generic Documents Folder  

and Linking Documents to Different Entities 

CRM and Collections lets you drag and drop documents to the generic documents folder or to link them to 
different entities and drop them to specific entity folders.  

• If the document is for a single company or other entity – like a communication or case – you can 
use drag and drop to attach documents and copy them to a specific entity’s documents folder 
defined in Setup Options.  

You can link the document to a specific company or other entity when you drop the document. 

• If the document should be linked to more than one company, you can drag the document to the 
generic document folder, then use the Link buttons on the Document tabs to link the new 
document to one or more companies, contacts, opportunities, communications, cases, or tracked 
invoices. 

Note the following methods for adding documents to communications: 

• Use Drag and Drop on the Documents grid to copy documents to the generic documents folder 
or specific entity folder in CRM and Collections (see Document Folders tab in Setup Options). 

Documents that you drag and drop can be linked directly to a single company, case, 
communication, opportunity, or tracked invoice during the drag and drop procedure.  

Documents that are dragged onto the document grid are copied to the folder you select, and they 
are added to the list of documents maintained by the Documents program in CRM and 
Collections.  

Choose the Generic Documents Folder as the destination if you plan to link the document to 
many different companies (or other entities). 

Whether or not you link the document to a specific entity, you can link it later to as many entities 
as you want by using the Link buttons on the various tabs in the document window. 

• For Generic Documents, use the Link button on the Document’s Companies tab, Contacts 
tab, Opportunities tab, communications tab, Cases tab, or Tracked Invoices tab to link the 
generic document to one or more companies, contacts, opportunities, communications, cases, or 
tracked invoices. 

When you use the Link button on a tab, the program displays the list of entities that match the tab 
name (such as companies or cases), and sets you search for and select the entity to link. 

When you use the Link button, documents are NOT moved to the linked entity’s folder. 

To drag and drop documents: 

1. Open the Documents window. 

2. Drag and drop a document onto the grid on the Documents tab. (The grid border turns green, and 
the pointer shows that you are dragging a document.) 

  

3. When you release the document, the grid displays a new dialog box, asking you where you want 
to drop the document and which entity you want the document linked to.  
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o Generic Documents Folder: The first choice is to drop the document into the “Generic 
Documents Folder” that was defined on the Document Folders tab in Setup Options. 

You might drop a general document – like a Sale Brochure or new price list – in the generic 
documents folder, so the document was available to attach to any client emails. 

If you choose the Generic Documents Folder, you can still link this document to any number 
of enties later – or to a specific entity using the dropdown and Select button. 

o Company\National Account Documents Folder: Choice two is to drop it in a Company or 
National Account Documents Folder – like for Bargain Mart, Ltd. The program lets you select 
the company or national account folder using the Select button on the form. You can view 
documents for a company or national account by choosing the Documents Folder button in 
the Company or National Account window. 

o Entity Documents Folder: Choice three is to drop the document in a specific entity folder – 
such the communication folder for Bargain Mart. You can also link the document to the 
communication in the bottom part of the form. 

Note:  

• If you want to link a document to any number of entities, you should copy it to the 
generic documents folders and use the Link buttons on the document tabs to link the 
document to any number of other entities.  

• If you want to link a document to only one company, we suggest that you select the 
Company Documents Folder. You can then see all company documents by clicking the 
Documents Folder button on the Company window.  

4. Choose the type of entity to which you want to link the document from the dropdown – company, 
national account, opportunity, case, tracked invoice, communication, or none.  

 

Choose “None” if this is a generic document that you later want to link to several different entities.  

5. Click the Select button to choose the specific entity to which you want to link. 

6. When you click OK, the grid displays a newly dropped document, with the path to the documents 
folder where it was dropped– in this case, the document folder for company ID COMP00001 
(Bargain Mart – SanDiego). The program uses the ID assigned to the company by CRM. 
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Communications 

Communications record all interactions between your company and your customers. You can manually 
add any type of communication, including phone calls, text messages, letters, or emails. 

Additionally, CRM and Collections records all emails sent to customers by Send Statements/Letters, Send 
Invoices, Payment Due Alerts, Overdue Payment Reminders, and Send Bulk Email programs as 
communications – including statements, invoices, letters, payment due alerts emails, overdue payment 
reminders, and newsletters. 

The Communications program provides a search field so you can immediately find communications. It 
also includes a Company search field to restrict communications by company.  

• Click the red X that appears to remove Search terms.    

Double-click a row in the grid to open a communication record. 

   

Notes: 

• Communications are associated with Contacts, Documents, Companies and National Accounts: 

o A newsletter communication may be sent to all contacts in a contact group. 
o A statement may be emailed to two contacts at a particular company. 
o An overdue payment reminder may be sent to all contacts for a company or national account. 
o A FAX may be sent to a particular company or national account. 

• To see communications for a single company: 

o Click the Company Finder (shown above) and select the company you want. You can use the 
top Search field on the form to refine your search. 

o Click the red X to remove the company filter. 

 

• CRM and Collections creates email communications when you resend accounting documents 
from the Companies window, send statements, letters and invoices, and when you send overdue 
payment reminders, payment due alerts, and bulk emails. Just click the View Email button on the 
communication record to view emails and attachments. 
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• The Export Contacts button on a communication creates a file containing the contacts previously 
used for the selected communication, either in MailChimp or Swiftpage format. This allows you to 
follow up a previous mailout to the same group of contacts. 

 

Note: In order to export to MailChimp or Swiftpage, contacts must have email addresses, first 
and last names, must consent to receiving emails (this is a checkbox on the Contact screen), and 
must not be inactive or belong to inactive or deleted companies or national accounts. 

Drill Down: 

• Double-click on a row in the grid in the Communications Window to open up the Communication 
program and view communication details. 

• Click the Contacts tab to see recipients of emails sent by CRM. 

• Click the Documents tab to view documents that were linked to the communication. 

How Companies and National Accounts are Linked to Communications: 

Communications are generally linked to contacts and to companies or national accounts. 

• Communications that are created automatically by the Send Invoices, Payment Due Alerts 
and Overdue Payment Reminders program are automatically assigned to one recipient company 
or national account (for overdue payment reminders). 

For automatically created communications, you cannot change the company or national account 
assignment or add more companies or national accounts to the communication.  The Companies 
tab and National Accounts tab in the Communication window will be grayed out – as below. 

  

• Communications that you create manually can be assigned to a single company or 
national account using the Company Name field or National Account field, or you can leave the 
Company Name field and National Account field blank and link it to one or more companies 
or national accounts on the Companies tab or National Accounts tab. 

  

Note that if you do not select a single company or national account on the Communication tab, 
using drag and drop on the Documents tab will copy documents into the generic documents 
folder – such as “F:\Sage\Sage300\SharedData\company\SAMLTD\TaiRox CRM\Documents”. 

See Also: 

Appendix A - Common Screen Operations for searching, sorting, tabs and common button explanations. 



Companies, Contacts, Cases, Tasks, Opportunities, and Communications Communications 

TaiRox CRM and Collections for Sage 300 76 User Guide 

Add/Edit Communications 

The Communication screen lets you add new communications or view and edit existing ones. It also lets 
you view emails sent to customers by the Resend Documents, Payment Due Alerts, Overdue Payment 
Reminders, and Send Bulk Email programs. 

 

Notes: 

• Click the green Plus button ( ) beside the ID field to add a new record, and enter a description. 

• If adding a new communication for a single company, click the Finder button ( ) beside the 
Company Name field, and choose the company. The Companies tab will be greyed out 
proventing you from linking more companies to the communication. 

• Click the Finder button ( ) beside the Type field to choose the communication type. 

The list of communication types is maintained by the Communication Types setup program. You 
must choose from the list. 

• If the communication was for an email created by CRM and Collections, click the View Email 
button to view emails. Emails are created when you resend accounting documents from the 
Companies window, send statements, letters and invoices, and when you send overdue payment 
reminders from the Overdue Payment Reminders program, or emails from the Payment Due 
Alerts program and Send Bulk Email program. 

Note that all of the above programs assign communications to a single company or national 
account – except Send Bulk Email, which can link the same communication to many recipient 
contacts, companies and national accounts. 

• The Notes field can be up to 250 characters long. 

• The Comment field can be up to 2,500 characters long.  

• Click the Export Contacts button to create a file containing the contacts previously used for the 
selected communication, either in MailChimp or Swiftpage format.  

This allows you to follow up a previous mailout to the same group of contacts. 

• The Optional Fields tab appears if you use the Optional Fields module and assigned optional 
fields to communications. 

See Also:  

Appendix B – Using Data Entry Programs for tabs and common button explanations. 
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Dragging and Dropping Documents into the Communications Documents Folder 
and Linking Documents to a Communication 

CRM and Collections lets you add any documents to a communication.  

• If the communication is for a single company or national account, you can use drag and drop to 
attach documents and copy them to the Communication Documents folder defined in Options. 

• If the communication is linked to more than one company or national account, you can use the 
Link button on the Documents tab to link existing documents to the communication. 

Note the following methods for adding documents to communications: 

• Use Drag and Drop on the Documents tab to copy documents to the communication document 
folder in CRM and Collections (see Document Folders tab in Setup Options). 

Documents that you drag and drop are added to the Documents tab for the communication, they 
are copied to the communication document folder, and they are added to the list of documents 
maintained by the Documents program in CRM and Collections. 

• Use the Add button on the Documents tab to link to a document and add it to the list on the 
Documents tab.  

When you use the Add button, the document will be added to the list maintained by the 
Documents program in CRM and Collections, but the document will NOT be moved to a 
company’s or national account’s communication folder. 

• Use the Link button on the Documents tab to link to a document and add it to the list on the 
Document tab.  

When you use the Link button, the program displays the list of documents maintained by the 
Documents program in CRM and Collections, letting you choose a document to add to the 
communication’s list. The document will NOT be moved to the communication folder. 

To drag and drop documents and move them to the Communications folder: 

1. Click the Documents tab. 

2. Drag and drop a document onto the Documents tab. (The grid border turns green, and the pointer 
shows that you are dragging a document.) 

 

Note that the Companies and National Accounts tabs are greyed out, because this 
communication is for 1 company. 

3. When you release the document, the grid displays the new document, showing the path to the 
documents folder – in this case F:\Sage\Sage300\SharedData\company\SAMLTD\TaiRox 
CRM\Documents\COMP00004\Communications\COMM00111\INV001014.PDF 
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Viewing Emails in the Communications Window 

All email communications generated by the Resend Documents, Overdue Payment Reminders, Payment 
Due Alerts, and Send Bulk Email programs appear in the Communications window – letting you maintain 
a complete trail of all customer communications.  

CRM also keeps copies of all emails that are generated by CRM and Collections, such as overdue 
payment reminders, payment due alerts, and emails created by the Resend Documents program. 

Note:  Emails sent using Send Bulk Email are not captured and cannot be viewed in communications. (In 
other words, you can view the communication record listing all recipients on the Contacts tab, but you 
cannot view the actual email sent to recipients.) 

To view emails: 

1. Open the Communications window and search for the communication that you want. 

In this case, we searched for an “Overdue Payment” for customer 1100. 

2. Double-click the communication, then click the View Email button in the Communication window.  

  

You can then double-click the attachments to see the original documents.  

Note:  older emails (prior to January 2020) were stored differently in CRM. 

Older emails resent from the Company window or generated by CRM for statements, letters, 
invoices appear on the documents tab. 

And, emails that are manually attached to a communication also appear on the Documents tab. 

To access older emails and emails manually added to communications:  

o Select the company in the Companies window and click the Communication tab (or open the 
Communications window from the Sage desktop – as shown below). 
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o To view the email with attachments, select the Documents tab, and click the Document 
column heading. 

  

Viewing Company information from the Communication Window 

• Click the Companies tab, then double-click the row with the company name. 
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Cases 

Cases let you track collections issues, support issues, customer appointments, or other situations. You 
can also categorize cases by priority and by stage. (See Case Stages for more details.) 

The Cases program provides a search field so you can immediately find cases. It also includes a 
Company search field to restrict cases by company (shown below).  Double-click a row to open the case. 

• Click the red X that appears to remove Search terms.    

 

Notes: 

• Cases include a “Type” field, which can be Collections, Support, Appointment, or Other. 

• Use the Advanced… button to filter cases by field ranges (including Severity, Priority and Stage), 
as well as by Case Type, Case Status, and Territories. 

o To search cases for a single company, click the Company Finder (shown above) and select 
the company you want. You can use the top Search field on the form to refine your search. 

o Click the red X to remove the company filter. 

 

• Cases can be assigned to a user or be left for assignment at a later time. Users will only see 
cases that match the company territories to which they have access. 

• CRM and Collections updates users’ calendars when you change revisit dates and user 
assignments. See Appendix E:  Updating Calendars with .ics Event Files. 

• Automatic Refresh:  Choose File > Settings to have the case list refreshed at regular intervals, 
so you can see new cases as they are added: 

 

Drill Down: 

• Double-click a row to display the case information. 

• Click on the icons to the right of the Customer Number (top-right-hand corner) to open the A/R 
Customer program or the A/R Customer Inquiry program. 

See Also: 

Appendix A - Common Screen Operations for searching, sorting, tabs and common button explanations.  
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Add/Edit Cases 

The Case program lets you add, edit, and copy a case. 

Access:  Click the Add button or double-click an existing row on the Cases screen or on the Cases tab 
on the Companies screen. 

• On the blank Case screen, click the Finder button ( ) on the right side of the Company name 

field to choose the Company Name for the case. When you save a case, the Drill Down button  
becomes active so you can drill down to company data. 

 

Notes: 

• Click the green Plus button ( ) beside the ID field to add a new case record, then click the Finder 
button ( ) beside the Company Name field to select the company. 

If you click the Add button on the Case List screen, the program defaults the company name to 
the name on the currently highlighted case. Use the Finder button ( ) to change the name. 

• Click the Copy button at the bottom of the screen to copy a case. See Copying Cases. The Copy 
button beomes active after you click the Add button – or the Save button if you changed the case. 

• Revisit On date is used to construct data for the Dashboard program. You can also enter a 
Revisit Time after the Revisit date. Enter time in 24-hour format (e.g. 13:00). 

Cases show up for the revisit dates on the assigned employees’ dashboards and calendars, and 
assigned users are sent calendar event files so revisit dates appear in their email calendars. The 
program sends the calendar updates to assigned users when you click the Save button. 

• Cases may be of type Collection, Support, Appointment, or Other. 

• Stages are user-defined. See Case Stages. 

• Use the Appointment case type and the Revisit Time to schedule on-site calls. 

• The Notes field can be up to 250 characters long. 

• The Comment field can be up to 2,500 characters long. 

• Click  to drill down to Company data. 

• Click the Documents Folder button to view case documents in the Windows folder. 

• Click the Change Log button to view past changes to the case. 

• The Optional Fields tab appears if you use the Optional Fields module and assigned optional 
fields to cases. 

See Also: 

Appendix B – Using Data Entry Programs for tabs and common button explanations. 
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Dragging and Dropping Documents into the Case Documents Folder 
and Linking Documents to a Case 

CRM and Collections lets you add any documents to a case. You can use drag and drop to attach 
documents and copy them to the Case Documents folder defined in Setup Options, or you can link any 
existing documents on your computer to a case record. 

Note the following methods for adding documents to cases: 

• Use Drag and Drop on the Documents tab to copy documents to the case document folder in 
CRM (see Document Folders tab in Setup Options). 

Documents that you drag and drop are added to the Documents tab for the case, they are copied 
to the case document folder, and they are added to the list of documents maintained by the 
Documents program in CRM and Collections. 

• Use the Add button on the Documents tab to link to a document and add it to the list on the 
Documents tab.  

When you use the Add button, the document will be added to the list maintained by the 
Documents program in CRM and Collections, but the document will NOT be moved to the case 
folder. 

• Use the Link button on the Documents tab to link to a document and add it to the list on the 
Document tab.  

When you use the Link button, the program displays the list of documents maintained by the 
Documents program in CRM and Collections, letting you choose a document to add to the case’s 
list. The document will NOT be moved to the case folder. 

To drag and drop documents and move them to the Case folder: 

1. Click the Documents tab. 

2. Drag and drop a document onto the Documents tab. (The grid border turns green, and the pointer 
shows that you are dragging a document.) 

 

3. When you release the document, the grid displays the new document, showing the path to the 
documents folder – in this case C:\Sage300SharedData\company\SAMLTD\TaiRox 
CRM\Documents\COMP00002\Cases\CASE00002\Order Details.doc 
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Copying Cases 

CRM and Collections lets you copy an open case to the current company or to a different company. 

This means you can: 

• Create standard cases for service and support calls and apply them to particular companies. 

• Quickly duplicate a past collection case for a company. 

To copy a case: 

1. Open the case that you want to copy. 

2. Click the Copy button at the bottom of the screen, and click Yes when prompted. 

 

o The program will display a message stating that the copy was successful. Click OK. 
o By default, the new case will be assigned to the current company. 

3. To change the company for the case, click the Finder button beside the Company Name field, 
and use the Search field to find the new company.  

In this case, we entered “bar” to find and select “Bargain Mart – Oakland.” 

 

4. Select the new company and edit the new case as required, then click the Add button at the 
bottom of the screen to add the new case. 
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Tasks 

The Tasks screen lets you: 

• Track collection phone call tasks generated by the Overdue Payment Reminders program. 

Overdue Payment Reminders lets you send out overdue payment reminder emails to customers 
or create collection call tasks so users can easily follow up with customers.  

Collection call tasks appear on the dashboard according to revisit dates, provide overdue invoice 
information, and generate phone communications to track the outcome of collection calls. 

• Manually create tasks for tracking other activities.  

Manually created tasks are optionally associated with customer accounts and national accounts, 
and can track collections calls, appointments, to do items, or other CRM and Collections 
activities.  

The Tasks program provides an internet browser-like search field so you can immediately find any tasks – 
for example, type “Open” in the Search field to view all open tasks.  

• Click the red X that appears to remove Search terms.    

You can also order the task list by task name, task type, status, revisit date, company name, assigned 
user, territory, customer number, and various task dates.   

 

Notes: 

• To display tasks for a single company, click the Company Finder button and select the company 
you want.  Click the red X beside the Company field to remove the company filter. 

 

• Tasks include a “Type” field, which can be Collections, To Do, Appointment, or Other. Tasks 
created by the Overdue Payment Reminders program have a “Collection Call” type.  

• Automatic Refresh:  Choose File > Settings to have the Task list refreshed at regular intervals, 
so you can see new tasks as they are added: 

 

• Tasks can be assigned to a company or be unassigned, and they can be assigned to a user or be 
left for assignment at a later time. 
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• Tasks can include a due date and a revisit date, and can be Open, In Progress, or Closed.  

• Tasks with revisit dates appear on assigned users’ dashboards. Users will only see tasks that 
match the company territories to which they have access. 

• CRM and Collections updates users’ calendars when you change revisit dates and user 
assignments. See Appendix E:  Updating Calendars with .ics Event Files. 

The program sends the calendar update emails when you click the Save button.  

Drill Down: 

• Double-click a row to open up the Task program and display the task information. 

• Click on the icons to the right of the Customer Number (top-right-hand corner) to open the A/R 
Customer program or the A/R Customer Inquiry program. 

• Overdue Payment Reminders can automatically create payment reminder tasks for calling 
customers. See Overdue Payment Reminders and Overdue Reminders Setup. 

Collection Call Tasks Generated by the Overdue Payment Reminders Program 

The Overdue Payment Reminders program lets you send out overdue payment reminder emails or create 
phone call tasks for calling customers concerning overdue invoices.  

• You use the Overdue Reminders Setup program to select which action you want to perform for 
each overdue invoice aging stage.  

For example, you might generate tasks for calling customers with an invoice that’s overdue by 
more than 60 days. 

• System-generated call tasks with a revisit date appear on the CRM and Collections Dashboard 
and provide summary overdue invoice information and drill-down invoice details and customer 
and contact information. 

• The Overdue Payment Reminders program lets you set a revisit date and assign a user when you 
generate a group of payment reminder tasks. 

A typical procedure for using Overdue Payment call tasks looks like this: 

1. Open the Collections folder on the Sage 300 desktop, then open the Overdue Payment 
Reminders program. 

2. Click the Update button on the Overdue Payment Reminders screen. The Update button checks 
for invoices that have become overdue – or have been paid – since an update was last run. 

3. Select particular customers that you want to process – for example, choose all customers with 
overdue invoices that you want to assign to a particular staff member. 

4. Click the Process Overdue Payment Reminders button to continue.  

 

5. Specify a user ID and task revisit date for this group of customers, then click the Process button. 

• Users find Collection Calls assigned to them on the CRM and Collections Dashboard – or they 
can open the Tasks program and filter for their user names in the Search field. 

• Users document Collections Calls with a communication which they create directly from the task. 

See Also: 

Appendix A - Common Screen Operations for searching, sorting, tabs and common button explanations. 
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Add Manual Tasks and Update Tasks Created by the Overdue Payment 
Reminders Program 

The Task program lets you track and update tasks generated by the Overdue Payment Reminders 
program and create new tasks for collections, to-do items, appointments, and other CRM and Collections 
activities. 

Access:  Click the Add button at the bottom of the Tasks grid or double-click an existing task row. 

The following screen illustrates a Collection Call task generated by the Overdue Payment Reminders 
program.  Note that buttons for displaying invoice details and creating a communication appear only for 
tasks generated by Overdue Payment Reminders. They do not appear on manually-created Call Tasks. 

  

Notes: 

• Click the green Plus button ( ) beside the ID field to create a new task record. 

• Click the Finder button ( ) beside the Company Name field to link the task to a company – or 
click the Finder button beside the National Account No. field to link the task to a national account. 

o Click the appropriate Drill Down button ( ) to view Company or National Account data. The 
button for the company or national account will become active when you save the task. 

o Leave the Company Name field and National Account No. field blank to create a task that is 
not associated with a company or national account. 

• Tasks may be of type Collection, Support, Appointment, or Other. 

• The Assign To user field is optional – allowing you to create a group of tasks, and then assign 
them to individual users. 

• Collection calls created by the Overdue Payment Reminders program have an “Overdue 
Payment Reminder” label and buttons for displaying invoice details and creating a 
communication. 

o Click the Create Communication button to add a new communication. The button name will 
change to “View Communication” when you save the communication. 

o Click the View Communication button to view or edit the communication. 

• The Due Date and the Revisit Date are optional.  

The Revisit Date determines when a task appears on the assigned user’s Dashboard. Optionally 
enter a Revisit Time after the Revisit date in 24-hour format (e.g. 13:00). 

• The Comment field can be up to 2,500 characters long. 

• Click the Notes tab to add a note that can also be searched in the Notes program. 
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• Click the Change Log button to view past changes to the task. 

• The program sends calendar update emails to assigned users when you click the Save button.  

See Also: 

Appendix B – Using Data Entry Programs for tabs and common button explanations. 

View Overdue Payment Reminder Details and Drill Down to Collections Data 

Overdue Payment Reminders – Collection Call tasks created by the Overdue Payment Reminders 
program – provide a Details button that displays summary data on overdue customer accounts. 

 

Click the Details button to display the Overdue Payment Reminder Details: 

 

The popup shows all outstanding invoices – excluding invoices on hold – when the task was created.  

Click the Drill-Down button for the company or national account to view all customer and 
collections data: 

  

• Click the Collections button on the Company screen to view outstanding invoices, payments, 
cases, notes, past communications, disputed invoices, tracked invoices, and promised payments. 

• Click the Contacts tab on the Company screen or National Account screen (if you drilled down to 
a linked national account) to see the list of company or national account contacts. 
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Creating Communications from Overdue Payment Reminder Tasks 

CRM and Collections makes it easy to document all overdue payment calls – just click the Create 
Communication button to create an update for your call summary. 

 

Click the Create Communication… button to display the Communication screen: 

CRM and Collections creates a communication the first time you click the Create Communication… 
button and click the Save button on the Communication screen. The button name changes to View 
Communication when you save, so you can see that a communication exists. 

• Click the View Communication… button to update the same communication.  

Note that the new communication includes a few default pieces of information – such as the 
communication name, the type, starting notes, and a list of the overdue invoices in the comment field. 

 

You can look up all Collections Call communications in the Communications window – and you can also 
see them on the Communications tab in the Company window, along with email messages sent by the 
Overdue Payment Reminders program – as below: 
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Notes 

The Notes program provides a search field so you can immediately find notes, and it includes a Company 
search field to restrict notes by company (shown below). Double-click a row to open a note. 

• Click the red X that appears to remove Search terms.    

 

Notes: 

• Notes can be attached to Companies, Cases, Tasks, Opportunities, Promised Payments, and 
Tracked Invoices. (You can also add notes for National Accounts using the National Accounts 
window, and add notes for Tracked Invoices using the Overdue Invoices program and the 
Disputed Invoices program.) 

• To add a note using the Notes program, click the Add button and select the type of entity the note 
is for – company, case, tracked invoice, promised payment, task, opportunity or national account. 

Typically, you add notes by opening the company, national account, disputed invoice, overdue invoice, 
promised payment, opportunity, or case, and then go to the Notes tab and click the Add button. 

• Notes can be several thousand characters in length. 

• To search notes for a single company, click the Company Finder (shown above) and select the 
company you want. You can then use the top Search field on the form to refine your search. 

• Click the red X shown below to remove the company filter. 

 

• Users can only see notes that match the company territories or opportunities/cases/invoices/ 
promised payments to which they have access. 

• Use the “Advanced” search button to view notes for companies, tasks, tracked invoices, promised 
payments, or opportunities. 

Drill Down: 

• Double-click on a row to open the Note window to see the contents. 

• Click the “For” column heading in the grid to drill down to the entity to which the note is attached – 
either a company, case, tracked invoice, promised payment, or opportunity. 

See Also: 

Appendix A - Common Screen Operations for searching, sorting, and common operations. 
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Add/Edit Notes 

The Note program provides maintenance functionality. 

 

Notes: 

• Notes are always linked to a single entity – a company, case, tracked invoice, promised payment, 
or opportunity. (Invoices that have notes added using the Overdue Invoices program and the 
Disputed Invoices program appear as tracked invoices.) 

• Click the Add button ( ) beside the Name field to add another note for the same entity.  

• Notes may be several thousand characters in length.   

To add a note for a company, case, tracked invoice, promised payment, opportunity or 
national account: 

• Click the Add button at the bottom of the Notes grid, and select the type of entity to which you are 
attaching the note – for example, “Company”. 

 

• Choose the entity from the Finder. In this case, we entered “bar” as the search term in order to 
select Bargain Mart – San Diego. 

 

• Enter the information for the Note, and click the Add button. 

See Also: 

Appendix B – Using Data Entry Programs for tabs and common button explanations. 
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Sales Reports and Charts 

TaiRox CRM and Collections includes sales reports and charts to provide a quick overview of your 
company’s sales performance.   

• Charts show the Sales Pipeline, Open Opportunities, or Time to Close. 

• The Sales Activity Report shows the number of new opportunities, quotes, orders and 
communications for a range of users and range of dates.  

The Sales Activity Report uses the Crystal Reports engine for Sage 300, letting you print to 
standard Sage print destinations and export data to PDF, Word, or Excel spreadsheet formats. 

Access:  Open the Sales Reports folder, then select the charts or the report that you want to see.  

  

Note: The Sales Reports do not appear if you are using the TaiRox Collections module without CRM. 

CRM and Collections also includes a set of collections charts and reports. See Collections Reports and 
Performance Charts for details. 

Charts 

The Charts program quickly presents opportunity data in various forms.  

• Select TaiRox CRM and Collections > Sales Reports > Charts.  

• Select the chart that you want to view – Sales Pipeline, Open Opportunities, or Time to Close. 

• Choose charting options. 

• Click the Create Chart button. 

The Charts program creates a completely editable Excel spreadsheet containing the consolidated data 
and the chart. The terms “Category” and “Series” are consistent with their use in Excel. 
 

Chart Options Sample Chart 
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Chart Options Sample Chart 

 

 

 

 

 

 

Sales Activity Report 

The report shows the number of new opportunities, quotes, orders and communications for a range of 
users for a specified time period. 

To print the Sales Activity report: 

1. Select TaiRox CRM and Collections > Sales Reports > Sales Activity Report. 

2. Specify a date range for the report and the range of users that you want to include, then click the 
Print button. 

 

The Sales Activity Report appears as follows: 
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Change Log and Change Log Report 

CRM logs every change to every field for each key entity, and lets you view all record changes on-screen 
and print comprehensive change log reports.  

  

Access:  Open the Change Log folder, then select the Change Log icon to view log changes on the 
screen, or choose the Change Log Report icon to print summary change log reports. 

You can also view change logs for individual entity records by clicking the Change Log button at the 
bottom of each entity screen – such as Companies, Contacts, Tasks, or Promised Payments screens. 

Viewing Change Logs 

Access:  Open the Change Log folder, then select the Change Log icon. 

To view log entries: 

• Choose the entity you want to view, or choose All in the first field to list all entities. 

• Enter an ID for an entity in the Entity ID field to filter the list. In this example below, enter Entity ID 
“12” to list only the changes for the Company ID 12 – J & Y Builders. 

• Enter a search term to find changes fast – like “ADMIN promise” to view all promised payments 
added or changed by the ADMIN user. 

• Select a row in the top grid to display all changes for the selected record in the bottom grid. 

The following example shows company record changes made by Carla. The row for Dr Dan Penn has 
been highlighted in the top grid, and you can see the old and new field values in the lower grid.  
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• Double-click a row in the bottom grid to open a window for side-by-side comparisons. This is 
particularly useful for comparing Notes. 

 

Printing Change Log Reports 

The printed log provides a summary of all record changes, listing the CRM use and the changed record. 
To see change details, use the change log viewer. 

Access:  Open the Change Log folder, then select the Change Log Report icon. 

The Change Log Report lets you select a range of dates and users to report, choose each of the entities 
that you want to include in the report, and choose whether to order the report by date or by user. 

To print the Change Log Report: 

1. Select TaiRox CRM and Collections > Change Log > Change Log Report. 

 

2. Specify a date range for the report and the range of users that you want to include. 

3. Choose the entities for the report. 

4. Specify the report sort order. 

5. Click the Print button. 
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Accounts Receivable and Collections 

Dashboard and Calendar Views of Assignments 

The Dashboard and Calendar provide two different views of all open tasks, opportunities, cases, tracked 
invoices, disputed invoices, and promised payments for the selected day, week, or month that are 
assigned to you, all, or no users.  

Note: Opportunities will not appear on the dashboard if you are using the standalone Collections module. 

These views do not display closed cases, tasks, tracked invoices, or promised payments, or opportunities 
that are won/lost. (Tracked invoices includes all invoices – overdue and disputed – with a revisit date.) 

For details, see the Dashboard and Calendar sections earlier in this User Guide. 

Dashboard view  

 

Calendar view  

 

Double-click an item to open a case, task, opportunity, disputed invoice, tracked invoice, or 
promised payment. 

• Click on the Company Name column heading on the dashboard to open the Company program 
for the selected company and view company information. 

Notes: 

• Today:  The session date is used by default on the Dashboard and Calendar screens. If you 
change the date, click the Today button to quickly return to the session date, retaining the day-
week-month state. 

• Navigation Arrows:  Use arrows to the top of the screen to navigate to the previous or next day, 
week or month. 

• Day, Week, Month or Year:  Display items with a revisit date for the selected time period. 

• Me, All Users, Unassigned, or Other User:  “Me” displays items assigned to the logged in user. 
“All Users” shows all items the logged-in user is allowed to see, “Unassigned” shows cases, 
tasks, disputed invoices, overdue invoices, and promised payments that are not assigned to any 
users. You can also see items assigned to specific other users if you have permission to view 
them. 

• Refresh button on the Dashboard:  This button reloads the data from the database (changing 
states does not do this). 

• All displayed tasks, cases, opportunities, tracked invoices, and promised payments on the 
dashboard are selected and sorted by their Revisit Date. Items without a specific Revisit Time 
display 12:00 AM. 

See Appendix G: CRM and Collections Security for details on dashboard and calendar security settings. 
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Customer Aging 

The Customer Aging program in the Collections folder provides a lightning-fast way to see customer 
aging information, print a quick report, and drill down to overdue and disputed invoices, tracked invoices, 
communications, collection cases, promised payments, and notes for the displayed customers.  

 

 

Select “Summary” or “Detail” from the Display dropdown and click the Go button to view outstanding 
accounts. You can also print the data on the screen and export it to an Excel spreadsheet. 

Notes: 

The above screen provides a “Summary” display with one summary line for each customer that 
matches the selection criteria. 

• You can select options to match the Sage 300 aging calculations. 

o The As-Of Date lets you specify the date on which to report the receivables. 
o Enter a Cut-Off Date to only include transactions that are on or before the date you specify. 
o Use the “Include Current” checkbox to display or exclude the current amounts. Note that you 

can set the number of days overdue to include as “current”.  
o Select all or a range of customer numbers, national accounts, customer groups, billing cycles, 

short names, account sets, territory codes, currency codes, current customer currency 
balance, current functional currency balance, customer name, salesperson code, on-hold 
status, start date, or customer optional fields. 

o Age unapplied documents as current or by date. 
o Select “Exclude Disputed Invoices” to ignore disputed invoices. (See Disputed Invoices.) 
o Only show documents overdue by x Days or more. (This is a display option only. It does not 

affect aging totals, and it does not affect aging reports or exported data.) 
o Order the report by customer number, total amount, days overdue, or customer group. 

Customers within customer groups are listed by customer number.  
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• Each line shows the collection buckets for a customer on the As Of Date. This date defaults to the 
session date, but you can change it with the pop-up calendar.  

• Totals for each aging period are displayed at the top of the screen. Note that aging totals only 
include the amounts for customers that are included in the selection criteria. 

• The Flags column shows if the customer account in A/R is on hold (*) or has unapplied credit ($), 
and whether the company has open cases (!), disputed invoices (?), or promised payments (+). 

Choose “Detail” from the Display dropdown, and click the Go button ( ), to view outstanding 
documents – as below. 

• The Customer Aging Detail grid shows unpaid documents.  

 

• The Flags column for documents shows disputed invoices (@) and invoices with payment 
schedules (#), and shows if the company has promised payments (+), unapplied credit ($), open 

cases (!), or other disputed invoices (?), and whether the customer account in A/R is on hold (*). 

Drill Down: 

• Click the Customer Number column heading to open the A/R Customers window (or A/R 
Extended Customers if you have TaiRox Productivity Tools). 

• Click the Customer Name column heading to open the CRM and Collections Company window. 

• Click the Document Number column heading on the Detail grid to display the original document in 
A/R or O/E. 

• Double-click a row to open the Customer Information window – to view customer invoices, case 
information, documents, notes, communications, disputed invoices, overdue invoices, tracked 
invoices, and promised payments. 

Adding a New Collection Case, Disputed Invoice, Tracked Invoice, or Promised 
Payment for a Customer 

• Double-click the customer row to open the Collections window.  

• Go to the Tasks tab, Disputed Invoices tab, Tracked Invoices tab, or Promised Payments tab. 

 

• Click the Add button at the bottom of the tab.  

 

You can also add notes and communications by choosing the appropriate tab and clicking Add. 
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• Fill in the case, disputed invoice, tracked invoice or promised payment information, assigning the 
employee and the revisit dates for cases, disputed invoices, and promised payments.  

 

 

This example shows the screen 
for adding a new case. 

Printing an Aged Trial Balance 

To print customer the aging results on the screen: 

• Select the criteria for the customer aging report, and click the Go button. 

• Click the Print button at the bottom of the screen to print the results. 

 
 

 

Note:  The program matches rules for the Aged Trial Balance reports in Sage 300 A/R. This means: 

• It ignores options to “Exclude Disputed Invoices” and “Only show documents overdue by x days”. 

• It also ignores the “Age Unapplied Credit Notes and Debit Notes” and the “Age Receipts, 
Unapplied Cash and Unapplied Prepayments” options. 
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Exporting an Aged Trial Balance to a Spreadsheet 

To export the customer aging results displayed on the screen: 

• Select the criteria for the customer aging report, and click the Go button. 

• Click the Export button at the bottom of the screen to export the results to an Excel spreadsheet. 

• Choose the path and filename for the spreadsheet file. 

 

Summary Spreadsheet: 

 

Detail Sheet: 

 

Note:   

• If “Include Current” is not selected, the Current column will not be included in the export. 

• Document details include the ship-to location and the PO number. 

• Notes on the detail report appear following customer summary lines. 

• An Aging Summary includes the totals of each exported currency in multicurrency systems. 
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Collections Information – Drilling Down from Customer Aging 

• Double-click a row in the Customer Aging grid to view the Collections screen. 

The Collections screen displays collections-related information, including the transactions, cases, 
notes, communications, disputed invoices, overdue invoices, tracked invoices, and promised 
payments for the customer, along with the customer credit limit, balance, terms, average days to 
pay and number of paid invoices. 

• You can also access the Collections screen from the Company window, Overdue Invoices, 
Overdue Payment Reminders, and Payment Due Alerts.  

See Companies, Overdue Invoices, Overdue Payment Reminders, and Payment Due Alerts. 

Note:  

o If you open the Collections screen from the Customer Aging window, the program ages 
documents based on the settings that you specify on the Customer Aging screen. 

o If you open the Collections screen from the Companies window, the program ages 
documents based on the default aging periods specified in Accounts Receivable. 

Transactions tab: 

 

Click the buttons between the Customer Number 
and Customer Name to drill down to the A/R 
Customer record and to Customer Inquiry. 

Click the Checkbox to show only overdue 
invoices. 

Click the Document Number column heading to 
view the entry details for the selected document in 
A/R or O/E – such as the invoice or receipt. 

Cases tab: 

 

Click the buttons between the Customer Number 
and Customer Name for customer information. 

Select “Show Closed” to see closed cases. 

Double-click a case in the grid to open the Case 
window and view case details.  

Click the Add button to add a new case, or click 
the Delete button to delete the selected case. 

For more information, see Cases. 

Notes tab – for notes added to the company: 

 

Click the buttons between the Customer Number 
and Customer Name for customer information. 

Double-click a note in the grid to open the Note 
window and view the note details. 

Click the Add button to add a new note, or click 
the Delete button to delete the selected note. 

For more information on notes, see Notes. 
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Communications tab – for all company communications: 

 

Click the buttons between the Customer Number 
and Customer Name for customer information. 

Double-click a communication in the grid to open 
the Communication window and view the details.  

Click the Add button to add a new 
communication, or click the Delete button to 
delete the currently selected communication. 

For more information on notes, see 
Communications. 

Disputed Invoices, Overdue Invoices, Tracked Invoices & Promised Payments tabs: 

 

These tabs show disputed invoices, all overdue 
invoices, tracked invoices, and promised 
payments for the current company.  

Select “Show Closed” to see closed disputed 
invoices, overdue invoices, or promised 
payments. 

Choose a tab, then double-click an item in the grid 
to view the details. Click the Add button for 
disputed invoices, tracked invoices, or 
promised payments to add a new item. 

For more information, see: 

• Disputed Invoices • Overdue Invoices 

• Tracked Invoices  • Promised Payments 

Note the following points: 

• Disputed Invoices lets you track invoices that are being disputed by a customer. See Disputed 
Invoices. 

• Overdue invoice records are created and displayed on the Overdue Invoices screen and on the 
Overdue Payment Reminders screen. 

The Flags column shows disputed invoices (@) and invoices with payment schedules (#), and 
shows if the company has promised payments (+), unapplied credit ($), open cases (!), or other 

disputed invoices (?), and whether the customer account in A/R is on hold (*). 

• Promised Payments document the special arrangements for payment from customers with 
overdue or disputed invoices. 

• Tracked Invoices are all invoices with attached notes or documents, or have an assigned user or 
revisit date, or are on hold.  

If you add a note or document to a disputed invoice or overdue invoice, that invoice becomes a 
tracked invoice and will also appear on the Tracked Invoices tab, along with all notes and 
documents. 

• All notes and documents on these tabs are also accessible through the Notes and Documents 
programs. 
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Disputed Invoices 

Disputed Invoices lets you track invoices that are being disputed by a customer.  

If you add documents or notes to a disputed invoice, the disputed invoice will also appear on the Tracked 
Invoices screen, where you can also see the attached documents and notes. 

• You can assign disputed invoices to a specific user or leave them unassigned.  

• Disputed invoices appear on the Dashboard and Calendar according to the revisit date you 
specify.  

Assigned disputed invoices appear on the assigned user’s dashboard. Unassigned invoices 
appear on the dashboard when you view items for All users. 

• An option on the Customer Aging screen lets you include or ignore invoices in dispute. 

• Disputed invoices are flagged on the Overdue Invoices and Overdue Payment Reminders screen, 
so you can hold reminder emails.  

• You can add as many documents and notes as you want to disputed invoices to track activity. 

• You can close disputed invoices that have been paid using the Close Invoices program. 

Access:  Open the Collections folder, then open Disputed Invoices.  

  

  

To Search for disputed invoices: 

• Use the top Search field on the form to find disputed invoices.  

o Enter a partial invoice number, customer number, or company name in the Search field at the 
top of the screen, and press the Enter key. 

You can also enter values for company optional fields, so if you have a “sales rep” company 
optional field, you can search quickly for disputed invoices for a particular sales rep. 

o Click the red X that appears to remove Search terms.    

• Use the Company Finder (shown above) to search for a single company.  

o Click the Finder button ( ) at the end of the Company field (shown below) and enter part of 

the company name to restrict disputed invoices to a single company. 

o Click the red X beside the Company field to remove the company filter. 
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Notes: 

• Click the Status checkboxes to display both Open and Closed disputed invoices. 

• Double-click a disputed invoice in the grid to view the disputed invoice information. 

• Click the Add button at the bottom of the screen to add a new disputed invoice. 

• Disputed invoices include a “Documents” tab and a “Notes” tab where you can add the details for 
disputed invoices. 

• Use the Disputed Invoices Report to view the status of disputed invoices. 

Drill Down: 

• Double-click a row in the grid to open up the Disputed Invoice information screen. 

• Click the Invoice Number column heading to drill down on the invoice. 

  

• Click the Customer Number column heading to drill down to the A/R Customer (or Extended 
Customers form if you have TaiRox Productivity Tools). 

  

 

• Click the Company Name column heading to drill down to the CRM company information. 

 

 

See Also: 

Appendix A - Common Screen Operations for searching, sorting, tabs and common button explanations. 
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Add/Edit Disputed Invoices 

Access:  Click the Add button on the Disputed Invoices screen to add a new disputed invoice or double-
click an existing row to view the disputed invoice record. 

   

Notes: 

• Click the green Plus button beside the ID field ( ) to add a new disputed invoice record. 

• Click the Finder button ( ) beside the Company name field to choose the company with the 

disputed invoice. (The Finder becomes inactive after you add the invoice.) 

• Select the disputed invoice using the Finder beside the Invoice Number field. 

• Enter a disputed amount. You can order disputed invoices by disputed amount on the Disputed 
Invoices screen, helping you focus on larger disputes. 

• Enter a Revisit On date. This determines when disputed invoices appear on the Dashboard or 
Calendar. You can also enter a Revisit Time after the Revisit date. Enter time in 24-hour format 
(e.g. 13:00). 

• Assign the disputed invoice to an employee so it will appear on their Dashboard or Calendar. If 
you do not assign the invoice to a particular employee, it will appear when you view items for “All” 
and for “Unassigned.” 

• Days Open shows how long the dispute has been open – or was open before it was closed.  

• Change the status to Closed once the invoice dispute is resolved. 

• The Notes field can be up to 250 characters long. Click the Notes tab to add notes up to 2,500 
characters long for the disputed invoice.  

• Click the Change Log button to see the details for recent changes. 

Drill Down: 

• Click the Drill-Down button  by the Company Name to drill down to Collections company data. 

• Click the Drill-Down button  by the Customer Number field to view A/R customer data with the 
Extended Customers screen. 

• Click the Inquiry button  by the Customer Number field to drill down to Extended Customer 
Inquiry. 

• Click the Drill-Down button  by the Invoice Number field to view the original transaction entry. 

• Click the Inquiry button  by the Invoice Number field to drill down to A/R Document Inquiry. 
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Items on the Documents and Notes tabs appear with Tracked Invoices: 

• All disputed invoices with attached notes or documents appear in the Tracked Invoices program 
with the same list of documents and notes. 

You can attach and view documents and notes for invoices using Disputed Invoices, Overdue 
Invoices, and Tracked Invoices programs. The attached items are displayed on the tabs of all 
three programs. 

When you add a note or document to an invoice using the Disputed Invoices or Overdue 
Invoices program, the invoice will appear in the Tracked Invoices program. 

• All documents added to the Documents tab are also accessible through the Documents program. 

• All notes added to the Notes tab are also accessible through the Notes program. 

Dragging and Dropping Documents into the Invoice Documents Folder 
and Linking Documents to a Disputed Invoice 

CRM and Collections lets you link any documents to a disputed invoice. You can use drag and drop to 
attach documents and copy them to the Tracked Invoices Documents folder defined in Setup Options, or 
you can link any existing documents on your computer to a disputed invoice record. 

Drag and drop copies documents for Tracked Invoices, Overdue Invoices, and Disputed Invoices to 
the Tracked Invoices folder specified in CRM and Collections Setup Options. 

Note the following methods for adding documents to disputed invoices: 

• Use Drag and Drop on the Documents tab to copy documents to the tracked invoice document 
folder for CRM and Collections (see Document Folders tab in Setup Options). 

Documents that you drag and drop are added to the Documents tab for the disputed invoice, and 
you can view them on the Documents tab for Tracked Invoices. They are also copied to the 
tracked invoice document folder, and added to the list of documents maintained by the 
Documents program in CRM and Collections. 

• Use the Add button on the Documents tab to link to a document and add it to the list on the 
Documents tab.  

When you use the Add button, the document will be added to the list maintained by the 
Documents program in CRM and Collections, but the document will NOT be moved to the tracked 
invoices document folder. 

• Use the Link button on the Documents tab to link to a document and add it to the list on the 
Document tab.  

When you use the Link button, the program displays the list of documents maintained by the 
Documents program in CRM and Collections, letting you choose a document to add to the 
disputed invoice’s list. The document will NOT be moved to the tracked invoices document folder. 

To drag and drop documents and move them to the Tracked Invoices document folder: 

1. Click the Documents tab on the Disputed Invoice screen (see below). 

2. Drag and drop a document onto the Documents tab. (The grid border turns green, and the pointer 
shows that you are dragging a document.) 
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3. When you release the document, the grid displays the new document, showing the path to the 
documents folder. 

  

See Also: 

Appendix B – Using Data Entry Programs for tabs and common button explanations. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Accounts Receivable and Collections Overdue Invoices 

TaiRox CRM and Collections for Sage 300 107 User Guide 

Overdue Invoices 

The Overdue Invoices program displays a selectable and sortable list of overdue invoice records.  

• Click the Update button to recalculate the list of overdue invoices using today’s date. 

The program creates new overdue invoice records, updates existing records for overdue invoices, 
and closes records for paid invoices. 

• Double-click an invoice to open the “tracked invoice” record for the invoice. 

o You can attach documents and notes to overdue invoice records to track activity. 

If you add documents or notes to an overdue invoice record, the overdue invoice will also be 
listed on the Tracked Invoices screen. 

o You can put invoices on hold and select a reason for the hold. 

CRM will not send overdue payment reminders to customers for “on hold” invoices. 

Use the “Show On Hold” checkbox to include/exclude on hold invoices from the list. 

o You can display prior overdue invoices by selecting the Closed checkbox. 

o You can assign overdue invoices to a specific user and set a revisit date.  

Assigned overdue invoices appear on the assigned user’s Dashboard and Calendar 
according to the revisit date you specify. 

If you set a revisit date, but do not assign the invoice to a specific user, the invoice appears 
on the dashboard when you view items for All users. 

Use the Overdue Payment Reminders program to assign user tasks for overdue invoices.  

• Click the “Process Overdue Payment Reminders” button to go directly to the Overdue Payment 
Reminders program to send emails to customers and to create tasks for following up on overdue 
payments. See Overdue Payment Reminders. 

You can also view overdue invoices and overdue accounts on the Customer Aging screen. 

Access:  Open the Collections folder, then open Overdue Invoices.  
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• The Flags column shows disputed invoices (@) and invoices with payment schedules (#), and 
shows if the company has promised payments (+), unapplied credit ($), open cases (!), or other 

disputed invoices (?), and whether the customer account in A/R is on hold (*). 

• Additional grid columns show on hold status for the invoice, assigned users, and revisit dates. 

• Click the Invoice Number heading to drill down to invoice details. 

Using the Search Field and the Company Field to Look Up Overdue Invoices 

Use the Search field and the Company field to restrict the display of overdue invoices to a group of 
companies or to a single company.  

• Use the Search field at the top of the screen to filter your overdue invoice selection. 

   

In this example, we entered “bar” as the search string to look up overdue invoices for all branches 
of Bargain Mart. You can also use the Company field to look up invoices for a single company. 

o Click the red X at the end of the Search field to remove search terms.    

Search using company optional field values:  You can also enter values for company optional 
fields in the Search field. For example:  

o If you have a “sales rep” company optional field, you can search quickly for overdue invoices 
for a particular sales rep. 

o If you have a “terms” optional field, you could do a special run for a particular group of 
customers. 

• Use the Company field at the top of the screen to list overdue invoices for a single 
company. 

 

o Use the Company field to view overdue invoices for the selected company only.  
o Click the Red X to remove the company filter. 

In this example, in the above example, we are listing all invoices for Ronald Black. 

Overdue aging perdiods are specified in Setup Options. 

Double-Click an Invoice to Add Notes, Track the Invoice, and Change the Invoice 
Status 

The program opens the Tracked Invoice screen when you double-click and invoice, allowing you to attach 
additional invoice information and change the status of the invoice. You can: 

• View summary invoice information and drill down to customer and invoice details. 

• Add the invoice as a new Tracked Invoice.  
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• Assign the invoice to a user and add a revisit date so it appears on the user’s dashboard.  

• Add notes and documents to the invoice.  

• Put the invoice on hold. 

Note:  All on-hold invoices, assigned invoices, and invoices with attached notes or documents are 
Tracked Invoices.  
 

You create a tracked invoice when you click the Add button on the Tracked Invoices form.  

 

• You can attach documents and notes for any overdue invoice on the Documents and Notes tabs.  

You can attach and view documents and notes for invoices using the Overdue Invoices program, 
Disputed Invoices program, and Tracked Invoices program. The attached items are displayed on 
the tabs of all three programs. 

• You can assign invoices to users – to Keith, in the above example. 

• You can put invoices on hold and select a reason for the hold. 

• All documents added to the Documents tab are also accessible through the Documents program. 

• All notes added to the Notes tab are also accessible through the Notes program. 

Drill Down to the Original Invoice, Collections Data, CRM Company Record, and 
A/R Account Record  

 

• Select the invoice/company that you want to view data for, then click the column heading to drill 
down to the data you want. 

o Click the Invoice column heading to view the original invoice information. 
o Click the Flags column heading to view collection data. See Collections Information. 
o Click the Company Name column heading to view company information maintained by CRM 

and Collections. 
o Click the Customer Number column heading to view the A/R Customer record. 
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Dragging and Dropping Documents into the Tracked Invoices Documents Folder 
and Linking Documents to an Overdue Invoice 

• Use drag and drop to attach documents to tracked invoices and copy them to the Documents 
folder defined in Setup Options. 

OR 

• Use the Add or Link buttons to link documents on your computer to an overdue invoice record. 

Note the differences in the following methods for adding documents to tracked invoices: 

• Use Drag and Drop on the Documents tab to copy documents to the invoice document folder in 
CRM and Collections (see Document Folders tab in Setup Options). 

Documents that you drag and drop are added to the Documents tab for the invoice. They are also 
copied to the invoice document folder, and they are added to the list of documents maintained by 
the Documents program in CRM and Collections. 

• Use the Add button on the Documents tab to link to a document and add it to the list.  

When you use the Add button, the document will be added to the list maintained by the 
Documents program in CRM and Collections, but the document will NOT be moved to the tracked 
invoices document folder. 

• Use the Link button on the Documents tab to link to a document and add it to the list.  

When you use the Link button, the program displays the list of documents maintained by the 
Documents program in CRM and Collections, letting you choose a document to add to the 
invoice’s list. The document will NOT be moved to the invoices document folder. 

To drag and drop documents and move them to the Invoices document folder: 

1. Click the Documents tab on the Overdue Invoice screen (see below). 

2. Drag and drop a document onto the Documents tab. (The grid border turns green, and the pointer 
shows that you are dragging a document.) 

  

3. When you release the document, the grid displays the new document, showing the path to the 
documents folder. 
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Tracked Invoices 

The Tracked Invoices program lists all invoices that have notes or documents attached, are on hold, are 
assigned to users, or have a revisit date. 

When you add a note or document to any invoice – using the Tracked Invoices program, Disputed 
Invoices program or Overdue Invoices program – or assign the invoice to a user or put it on hold – that 
invoice becomes a tracked invoice and will also appear on the Tracked Invoices screen. 

• Assigned tracked invoices appear on the assigned user’s Dashboard and Calendar according to 
the revisit date you specify. 

Unassigned invoices appear on the dashboard when you view items for All users. 

• All tracked invoices appear in the grid on the Tracked Invoices screen. 

• The Tracked Invoices program also lets you add notes and documents for payments and credit 
notes, which will also appear in the list on the Tracked Invoices screen. 

• You can close tracked invoices that have been paid using the Close Invoices program. 

Access:  Open the Collections folder, then open Tracked Invoices.  

 

  

To Search for tracked invoices:  

• Open the Tracked Invoices program and enter a partial invoice number, customer number, or 
company name in the Search field and press the Enter key. 

You can also enter values for company fields and company optional fields, so if you have a “sales 
rep” company optional field, you can search quickly for tracked invoices for a particular sales rep. 

o Click the red X at the end of the Search field to remove search terms.    

Or Click the Finder button ( ) at the end of the Company field and enter part of the company name 

to restrict tracked invoices to a single company (as shown below). 

o Click the red X beside the Company field to remove the company filter. 

• The program also lets you track credit/debit notes and payments. 

• Click the Add button at the bottom of the screen to add a new tracked invoice. 
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Notes: 

• Use the Status checkboxes to display Open and Closed tracked invoices in the grid. 

• Double-click a tracked invoice in the grid to view the tracked invoice information. 

• Tracked Invoices include a “Documents” tab and a “Notes” tab where you can add the details for 
tracked invoices. 

• Assigned tracked invoices appear on the assigned user’s Dashboard according to the revisit date. 

Drill down from the Tracked Invoices grid: 

• Click the Document Number column heading to drill down to the original document. 

 

 

• Click the Customer Number column heading to drill down to the A/R Customers screen – or to the 
TaiRox Extended Customers screen if you use TaiRox Productivity Tools. 

 

 

• Click the Company Name column heading to drill down to the company information kept by CRM 
and Collections. 

 

   

See Also: 

Appendix A - Common Screen Operations for searching, sorting, tabs and common button explanations. 
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Add/Edit Tracked Invoices 

Access:  

• Click the Add button on the Tracked Invoices screen to add a new tracked invoice or double-click 
an existing row to view the tracked invoice record. 

• Or, double-click an existing row in the Tracked Invoices grid to display the Tracked Invoice 
information. 

  

• Click the green Plus button beside the ID field ( ) to add a new tracked invoice record. 

Click the Finder button ( ) beside the Company Name field to choose the company with the 

tracked invoice. (The Finder becomes inactive after you add the tracked invoice.) 

Select the tracked document using the Finder beside the Document Number field. (The program 
actually lets you tracked any A/R document – not just invoices.) 

• Click the “Documents” tab and “Notes” tab to view or attach documents and notes. 

• Click the Documents Folder button to view documents in Windows File Manager. 

• For new tracked invoices, assign a user and a revisit date to display the tracked invoice on the 
dashboard and calendar. 

• Select the On Hold checkbox to place an invoice on hold. Use the dropdown to select a reason. 

• Click the Documents Folder button to view documents in Windows File Manager. 

• Click the drilldown buttons  to see CRM and Collections company information, A/R customer 
and account information, and invoice details. 

• When finished tracking a document, change the Status to “Closed” to remove the tracked invoice 
from the Tracked Invoices grid. 

• Click the Delete button to delete the tracked invoices record. 

• Click the Change Log button to see the details for recent changes. 

Drill Down: 

• Click the Drill-Down button  by the Company Name field to drill down to CRM company data. 

• Click the Drill-Down button  by the Customer Number field to view A/R customer data with the 
A/R Customers screen or Extended Customers screen (if you have TaiRox Productivity Tools). 



Accounts Receivable and Collections Tracked Invoices 

TaiRox CRM and Collections for Sage 300 114 User Guide 

• Click the Inquiry button  by the Customer Number field to drill down to Extended Customer 
Inquiry. 

• Click the Drill-Down button  by the Document Number field to view the original invoice. 

• Click the Inquiry button  by the Document Number field to drill down to A/R Document Inquiry. 

Add Notes and Documents 

• Click the Documents tab to link documents to the tracked invoice. 

Documents listed on the Documents tab are also accessible through the Documents program. 

• Click the Documents Folder button to view drag and dropped documents in the Windows folder. 

• Click the Notes tab to add notes for the tracked invoice. Notes listed on the Notes tab are also 
accessible through the Notes program. 

• You can also access notes and documents for disputed or overdue invoices using the Disputed 
Invoices and Overdue Invoices programs. 

Dragging and Dropping Documents into the Tracked Invoices Documents Folder 
and Linking Documents to a Tracked Invoice 

• Use drag and drop to attach documents to tracked invoices and copy them to the Documents 
folder defined in Setup Options. 

OR 

• Use the Add or Link buttons to link documents on your computer to a tracked invoice record. 

Note the differences in the following methods for adding documents to tracked invoices: 

• Use Drag and Drop on the Documents tab to copy documents to the tracked invoice document 
folder in CRM and Collections (see Document Folders tab in Setup Options). 

Documents that you drag and drop are added to the Documents tab for the tracked invoice. They 
are also copied to the tracked invoice document folder, and they are added to the list of 
documents maintained by the Documents program in CRM and Collections. 

• Use the Add button on the Documents tab to link to a document and add it to the list.  

When you use the Add button, the document will be added to the list maintained by the 
Documents program in CRM and Collections, but the document will NOT be moved to the tracked 
invoices document folder. 

• Use the Link button on the Documents tab to link to a document and add it to the list.  

When you use the Link button, the program displays the list of documents maintained by the 
Documents program in CRM and Collections, letting you choose a document to add to the 
tracked invoice’s list. The document will NOT be moved to the tracked invoices document folder. 

To drag and drop documents and move them to the Tracked Invoices document folder: 

1. Click the Documents tab. 

2. Drag and drop a document onto the Documents tab. (The grid border turns green, and the pointer 
shows that you are dragging a document.) 
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3. When you release the document, the grid displays the new document, showing the path to the 
documents folder. 

 

See Also: 

Appendix B – Using Data Entry Programs for tabs and common button explanations. 
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Promised Payments 

Promised Payments lets you track promises made by customers for the settlement of accounts.  

Promised Payments with a revisit date appear on the Dashboard and Calendar for assigned employees – 
or for “All” and “Unassigned” Items if the promised payment has not been assigned. You can use the 
Close Promised Payments program in the Periodic Processing folder to closed paid promised payments. 

Access:  Open the Collections folder, then open Promised Payments.  

 

  

Notes: 

• Enter a customer number, partial company name, or assigned user in the Search field.  

You can also enter values for company optional fields, so if you have a “sales rep” company 
optional field, you can search quickly for promised payments for a particular sales rep. 

o Click the red X at the end of the Search field to remove search terms.    

o Use the Finder button ( ) beside the Company field to restrict promises to one company. 

• Use the Order By field to view promises by Date Promised, Amount Promised or Revisit Date. 

• Use the Status checkboxes to display Open and Closed promised payments. 

• Assign promised payments to a specific user or leave them unassigned.  

o Promised payments appear on the Dashboard and Calendar according to the revisit date you 
specify. Assigned promises appear on the assigned user’s Dashboard and Calendar. 
Unassigned promises appear when you view “All” items and “Unassigned” items. 

• You can add as many notes as you want to promised payments to track activity. 
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• Promised payments are flagged on the Customer Aging, Overdue Invoices, and Overdue 
Payment Reminders screens. 

• Use the Promised Payments Report to view the status of all promised payments. 

Drill Down: 

• Double-click a row in the grid to display the promised payment information. 

 

• Click the Company Number column heading to drill down to the A/R Customer record for the 
highlighted promised payment. 

 

• Click Company Name column heading to drill down to the TaiRox CRM and Collections company 
information for the highlighted promised payment. 

  

• You can drill down from the TaiRox Company screen to the A/R Customer record and to all 
collections data. 

o Click the icon to the right of the Customer Number (top-right-hand corner) to open the A/R 
Customer program. 

o Click Collections button to view all Collections information for the customer. 

   

See Also: 

Appendix A - Common Screen Operations for searching, sorting, tabs and common button explanations. 
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Add/Edit Promised Payments 

Access:  Click the Add button on the Promised Payments grid screen (shown in the previous section) to 
add a new promised payment. 

 

Notes: 

• Click the green Plus button beside the ID field ( ) to add a new promised payment record. 

• Click the Finder button ( ) beside the Company name field to choose the company with the 

promised payment. (The Finder button becomes inactive after you add the promised payment.) 

• Enter the date promised and the promised amount. You can sort promised payments by promised 
amount and date in the Promised Payments grid. 

• Enter a Revisit On date. This determines when promises appear on the Dashboard and Calendar. 
You can also enter a Revisit Time after the Revisit date. Enter time in 24-hour format (e.g. 13:00). 

• Assign the promised payment to an employee so it will appear on their Dashboard and Calendar. 
Unassigned promised payments appear when you view “All” or “Unassigned” items. 

• Change the status to Closed once the promised payment has been received. 

• Click in the invoice grid and use the Insert key to add invoices covered by the promised payment.  

• Double-click an invoice in the grid – or highlight an invoice in the grid and click the Invoice 
Number column heading – to drill down to invoice information in A/R Document Inquiry.  

• Use the Notes field to list invoices covered by the payment and receipt information when payment 
is received. The Notes field can be up to 250 characters long.  

Click the Notes tab to add notes up to 2,500 characters long for the promised payment. Notes 
listed on the Notes tab are also accessible through the Notes program. 

• Click the Change Log button to see the details for recent changes. 

Drill Down: 

• Click the Drill-Down button  by the Company Name field to drill down to TaiRox company data. 

• Click the Drill-Down button  by the Customer Number field to view A/R customer data. 

See Also: 

Appendix B – Using Data Entry Programs for tabs and common button explanations. 
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Overdue Payment Reminders 

The Overdue Payment Reminders program: 

• Emails overdue payment reminders to contacts linked to customers or national accounts with 
overdue invoices 

The program generates reminder emails for different overdue aging stages. It lists all overdue 
customer invoices in each email, lets you attach the overdue invoices as PDF files, and sends 
emails to multiple customer or national account contacts. Emails are kept as communications. 

• Creates dashboard tasks for users to call customers concerning overdue invoices 

Tasks appear on the CRM and Collections Dashboard and provide overdue invoice information 
required for following up on overdue invoices. 

You can run the program interactively from the Sage 300 Desktop or run the program as a Windows 
Scheduled Task. See Overdue Payment Reminders Setup and refer to the Scheduler User Guide. 

If your company uses Sage 300’s National Accounts features, you will see two sets of tabs that let you 
send overdue payment reminders to A/R customer contacts or to A/R national account contacts. 

Related programs: 

• Use Payment Due Alerts to send reminder emails about upcoming invoice payments. 

• Use the Overdue Invoices program to view overdue invoices, assign overdue invoices to users, 
put invoices on hold, and to attach documents and notes to document the collections process. 

Access:  Open the Collections folder, then open Overdue Payment Reminders.  

 

 
The National Accounts tabs will not appear unless your company uses Sage 300’s National Accounts features. 

https://www.tairox.com/downloads/crm/Scheduler%20User%20Guide.pdf
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CRM and Collections lets you specify four overdue color-coded invoice stages and specify an action for 
each aging stage – either Send Email or Create Task – which you can change at runtime.  

You specify aging periods for overdue accounts, the default action (Send Email or Create Task), and the 
email default template for each Email aging stage in the Overdue Payment Reminders Setup program in 
the CRM and Collections Setup folder.  

Note also that you can specify From Email and Reply To Email addresses for payment reminders with the 
Overdue Payment Reminders Setup program.  

• Double-click a row on the Overdue Payment Reminders screen to view summary information for 
a company’s overdue invoices. 

 

Note: CRM and Collections also uses the “Preferred Language” setting in the Company or National 
Account window to send overdue payment reminders emails and invoices to customers in English, 
French, or Spanish. See Appendix C for details. 

Procedure for Sending Overdue Payment Reminders and Creating Tasks 

You can run Overdue Payment Reminders daily, bi-weekly, or weekly – whatever works best for you. 

Note:   

If you use the Sage 300 National Accounts feature, the program provides separate tabs for sending 
payment due reminders to contacts for companies and to contacts for national accounts. 

For simplicity, the following set of instructions shows how to send emails or create tasks for 
Customers only. The steps for generating payment reminders emails or phone call tasks for national 
account contacts is exactly the same as the steps for processing customer contacts. 

To send overdue payment reminders to A/R customers: 

1. Open the Collections folder, then open the Overdue Payment Reminders program.  

Note that Overdue Payment Reminders can only be run by Collections users who: 

o Have access to all territories 

o Are assigned “Collections” security rights if Sage 300 security is in use. 

Also note that you will see one or two sets of tabs for Pendng and Processed payment reminders, 
depending on whether your company uses Sage 300’s National Accounts feature. 

Without National Accounts: 
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With National Accounts: 

 

You use the Company set of tabs to send payment reminders to company contacts and the 
National Account set of tabs to send payment reminders to national account contacts. 

The process for sending Customer or National Account payment reminders is the same.  

2. Click the Update button on the Customer or National Account Pending tab to check for 
new overdue accounts and to recalculate invoice aging.  

Update also checks how much time has elapsed since the last payment reminders were 
generated for company/national account contacts to see which overdue accounts are eligible for 
new reminders. It also checks if invoices have been put on hold. 

 

Note: 

o The program lists overdue customer or national accounts. Double-click a line in the grid to 
see the customer’s or national account’s overdue invoices. 
− Accounts appear if at least 1 invoice exceeds the “Minimum days overdue before creating 

an Overdue Payment Reminder” for the customer or national account, and is not on hold. 
o Days Overdue is the number of days for the most overdue invoice.  
o Aging Stages are defined on the Overdue Payment Reminders Setup program in the Setup 

folder. They determine the default Action. 
o Customers or national accounts will not appear if the minimum number of days between 

payment reminders has not elapsed. 
o Customers or national accounts will not appear if their overdue invoices are on hold. 

3. Click the All button to send emails or generate call tasks for all accounts with outstanding 
amounts, and use the checkboxes in the Select column to cherry-pick accounts. 

 

For example, deselect members of national accounts that do not pay their own invoices, then 
process overdue payment reminders for the national accounts when the customer run is finished. 

4. Double-click the Action to switch between sending emails and creating tasks. 

The Action column shows you whether the program will send an email or create a collection task 
for this customer or national account. The default settings come from the Overdue Payment 
Reminders Setup program. 
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How to assign phone call tasks to different users: 

o Select all the customers or national accounts with a Phone Call 
action that you want assigned to the same user. 

o Click the Create Overdue Payment Reminders button at the bottom 
of the screen. 

o Specify a user for the new tasks, select a revisit date, and click the 
Process button. 

o When all emails and tasks have been processed, select the next 
group of customers that you want assigned to a different user. 

5. Double-click the email template file name to select a different template. 

 

o Highlight the email filename and click the Template column heading to display the email. 

6. Click the “Create Overdue Payment Reminders” button at the bottom of the form when you 
are ready to continue. 

The program will warn you if the overdue invoice data wasn’t updated today.  

 

Click the Yes button to continue. 

7. Select options for emails and tasks in the form that appears. 

 

o If any selected customers or national accounts have a Send Email action, you can: 

− Select “Attach Copies of the Invoices” to include PDF copies of overdue invoices with 
emails. 

Note:  Attaching copies of the documents slows the process down considerably because 
each invoice must be retrieved and rendered as a PDF. 

− Click the Attachments button to add additional attachments to all of the payment reminder 
emails – such as your policy on overdue accounts. 

 

 

 
Use “drag and drop” to add 
attachments, or click the Add 
button to search for attachments 
using Windows File Explorer. 
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o If any selected customers or national accounts have a Create Task action, you can specify a 
user name in the Task options to assign tasks for this set of accounts to a single user.  

 

Specify a Revisit Date to ensure that the call appears on the assigned user’s dashboard. 

o If you click the Process button without specifying a revisit date for tasks, the program 
displays a warning to let you know that the task will not appear on the Dashboard. 

 

8. Click the Process button on the popup options screen to send the reminder emails or create 
tasks for the selected customers or national accounts. 

9. When a customer processing run is finished, select another set of customers – or select 
the Process National Accounts tab to send emails or to create call tasks: 

To process another group of customers – for example to assign tasks to another user: 

o Select another one or more customers from the remaining list of customers. 
o Choose who to assign the next group of tasks, and specify a revisit date. 
o Click the Process button again to send the reminder emails and/or generate tasks for the new 

set of selected customers. 

• Click the Processed tab to see past payment reminders. 

 

Typical Email Sent for “Delinquent” Accounts 

The email can include a summary of the overdue invoices, a summary of all invoices, an aging summary, 
and PDF attachments. The following example shows overdue invoices and an aged overdue summary. 
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Please note that attaching copies of the documents (as shown above) slows down the emailing process 
because each invoice must be retrieved and rendered as a PDF. If you have issues with the time it takes 
to send emails, you should not include invoices with the emails. 

Also note that the program creates one email per company or national account that it can send to multiple 
contacts per company. The program does not create separate emails for each customer contact. (Note 
that the email shown above includes the main customer contact name in the greeting – not the M/T 
Contacts name.) 

To create payment reminders using the Overdue Payment Reminders program, you must: 

 • Set up Overdue Payment Reminders using the Overdue Payment Reminders Setup program 

 • Edit email templates for overdue invoice stages in the Overdue Payment Reminders Setup  
  program. 

 • Select the recipients for overdue payment reminders on the Contacts tab in the Companies 
  window and on the Contacts tab of the National Accounts window. 

Setting a Minimum Number of Days Overdue Before Creating Payment Reminders 
and a Minimum Number of Days Between Payment Reminders 

CRM and Collections lets you set a minimum number of days that an invoice must be overdue before 
creating an overdue payment reminder –so you won’t send a reminder as soon as the due date passes. 
You can change the default number of days overdue before creating an overdue payment reminder for 
individual companies and national accounts on the Company screen and the National Account screen. 

The program also lets you set a default minimum number of days (for example, 7 or 14 days) between 
payment reminders in the Overdue Payment Reminders Setup program. You can specify a different 
minimum number of days between reminders for individual companies and national accounts on the 
Company screen and the National Account screen. 

The program will not send an email message to a customer / national account – or create a Collection 
Call task – until each of the minimum number of days specified has elapsed.  

Using the Update Button to Create, Update and Close Pending Reminder Records 

The Update button creates new pending overdue payment reminder records for overdue invoices 
according to the aging periods specified in Overdue Payment Reminders Setup – unless you specified a 
minimum number of days before creating an overdue payment reminder for individual companies. 

  

Double-click a row in the Overdue Payment Reminders grid to see the overdue invoices 
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Using the Search Field and Company Field to Filter Overdue Payment Reminders 

You can restrict the display of customers or national accounts with pending overdue payment reminders 
to make it easier to select a subset of accounts for processing.  

• Use the Search field at the top of the screen to filter your overdue account selection. 

  

In this case, we searched for “Bargain” to get all Bargain Mart stores. The Company field would 
have restricted us to one location. 

You can also search by Stage – for example, to create reminders for all “Delinquent” customers. 

o Click the red X at the end of the Search field to remove search terms.    
o Use the Advanced… button to filter cases by different customer field ranges. 

Filter using company optional field values:  You can also enter values for company optional 
fields in the Search field.  

In the following example, we filtered on the “Salesperson” optional field to create phone call tasks 
for a single salesperson. 

  

o In our example, the “KW” letter combination doesn’t appear in any company names. Consider 
adding a non-alphabetic character to any optional fields that you want to use for filtering – for 
example, use *KW as the Salesperson code instead of “KW”. 

o If you have a “terms” optional field, you could do a special run for a particular group of 
customers. 

• Use the Company field at the top of the screen to filter for a single company. 

  

o Use the Company field to send reminder emails or to create call tasks for the selected 
company only. The Company field provides a SmartFinder to quickly find the company. 

o Click the Red X to remove the company filter. 

The Company field is replaced by a Nat. Acct. field on the National Account tabs. 
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More Details on Creating Overdue Payment Reminders 

• Click the Update button on the Customer Pending tab or National Account Pending tab to update 
the list of customers or national accounts with pending overdue payment reminders based on the 
aging stages that you defined in Overdue Payment Reminders Setup.  

The program takes into account the time elapsed since payment reminders were last created for 
customers or national accounts to see which accounts are eligible for new reminders.  

o Customers / national accounts will not receive reminders unless the Send Overdue Payment 
Reminders checkbox is selected on the Company / National Account screen.  

o Customers / national accounts will not receive reminders for invoices that are on hold.  

• For each company or national account, you can set the minimum number of days that a 
payment must be overdue before creating an overdue invoice record, and you can set a 
minimum number of days between overdue payment reminders. See the Company window or 
National Account window to change these settings. You can change the default numbers of days 
in Overdue Payment Reminders Setup. 

The program will not create an overdue invoice record for an invoice until the minimum number of 
days specified for the customer or national account is reached. 

You can turn off overdue payment reminders by unchecking the “Send” option for individual 
companies on TaiRox Collections’ Company or National Account screen. 

 

• You can put invoices “On Hold” using the Overdue Invoices and Tracked Invoices 
programs. 

For example, you might put an invoice on hold because it’s being disputed or if the invoice is for a 
good customer who is always a little late with payments.  

 

• Select options for creating payment reminders on the Create Overdue Payment Reminders 
popup screen. 

The following screen appears when you click “Create Overdue Payment Reminders: 
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Select “Attach copies of the invoices” to attach a PDF of each overdue invoice to payment 
reminder emails. 

You select the report formats for A/R and O/E invoices on the Overdue Payment Reminders 
Setup screen. 

Click the Attachments button to add additional attachments to all of the overdue payment 
reminder emails – such as your policy on overdue accounts. 

You can use “drag and drop” to add attachments, or click the Add button on the Attachments 
screen to search for attachments using Windows File Explorer. 

Specify a user for tasks and specify a revisit date to add the task to the user’s dashboard. 

The progran sends 1 email per customer or creates 1 call task listing all overdue invoices. 
Invoices that are on hold will not be listed in emails or on call tasks. 

• Click the Process button to generate emails or tasks for all customers / national accounts with 
an “X” in the Select column. 

The program will display status messages as it generates each payment reminder. 

• When all payment reminder emails and tasks have been generated, TaiRox Collections will 
display a message that includes the number of payment reminders generated (sent emails and 
new tasks) and whether any errors occurred.  

 

When you close the message window, TaiRox Collections will update company / national account 
records with the date of the last overdue payment reminder. 

 

• Click the Log button on the Overdue Payment Reminders screen to see the list of all successful 
email transmissions and tasks. The log also lists all email recipients. 

You will see an error in the log file if no email recipients were defined for a company. You can add 
contacts, then run the email program again to send the reminders.  

 

The Log file lists all email recipients for companies that got emails and all tasks created for 
reminder phone call. 
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Additional Features on the Overdue Payment Reminders Customer and National 
Accounts Pending tabs 

 

Note the following features on the Overdue Payment Reminders tabs: 

• Displays the date when the list was last updated, along with the ID of the user who ran the 
update. The date will be updated again when you click the Update button.  

• Shows the number of days overdue of the oldest overdue invoice for each customer or national 
account, the total amount overdue, the account balance and currency, the default action for the 
overdue payment reminder, and the default email template if the action is an email. 

• On the Customer Pending tab, flags customer accounts that are on hold (*) and companies with 
promised payments (+), unapplied credit ($), open cases (!), or disputed invoices (?). 

On the National Account Pending tab, flags national accounts that are on hold (*) and companies 
with promised payments (+), unapplied credit ($), open cases (!), or disputed invoices (?). 

• Provides drilldown to overdue invoices, A/R customer information (click the Customer Number 
column heading), CRM and Collections customer data (click the Company Name column 
heading) and Collections information (click the Flags column heading). 

• Double-click a line in the grid to see a list of overdue invoices.  

• Click the Customer Processed and Nat. Account Processed tabs to see sent payment reminders. 

Viewing Overdue Payment Reminders Communications and Sent Emails 

• Select the Communications tab on the Company screen (shown below) or National Account 
screen to view payment reminder email communications. 

• Double-click the email communication entry, then click the View Email button to see the email 
with all attachments. 
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Payment Due Alerts 

The Payment Due Alerts program sends payment reminder emails to company contacts before their 
invoices are due. Payment due emails list all unpaid – but not overdue – customer invoices in each email. 

You can run the program interactively from the Sage 300 Desktop, or you can run the program as a 
Windows Scheduled Task. See Payment Due Alerts Setup and refer to the Scheduler User Guide. 

The program lets you attach due invoices as PDF files, and sends emails to multiple company contacts. 
Sent emails are kept as communications. 

See Overdue Payment Reminders to send emails and create tasks for following up on overdue invoices. 

CRM uses the same contact list for each company for payment due alerts and for overdue payment 
reminders. You select the recipients for both types of reminders on the Contacts tab for each company. 

Access:  Open the Collections folder, then open Payment Due Alerts.  

  

  

You specify the email template for payment due alerts, along with Email subject, From Email, Cc and Bcc 
settings on the Payment Due Alerts Setup program in the CRM Setup folder. 

Notes: 

• The program includes invoices on payment due alerts that are within the number of days before 
the due date that is set in Payment Due Alerts Setup. 

• Invoices will appear on only one payment due alert. After that, the program ignores them. 

• Invoices that are past the due date will not appear on a Payment Due Alert. 

https://www.tairox.com/downloads/crm/Scheduler%20User%20Guide.pdf
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• If you do not send payment due alerts frequently, some invoices could be skipped. 

• Double-click a row on the Payment Due Alerts screen to view summary information for a 
company’s upcoming invoices. 

  

Note: CRM also uses the “Preferred Language” setting in the Company window to send payment due 
alerts emails and invoices to customers in English, French, or Spanish. See Appendix C for details. 

Procedure for Sending Payment Due Alerts 

You can run Payment Due Alerts daily, bi-weekly, or weekly – whatever works best for you. 

1. Open the Collections folder, then open the Payment Due Alerts program.  

Note that Payment Due Alerts can only be run by collections users, who must have access to all 
territories and be assigned “Collections” security rights if Sage 300 security is in use. 

2. Click the Update button to check for eligible customer accounts.  

Update also checks how much time has elapsed since the last payment due alerts were 
generated to see which customer accounts are eligible for new reminders. It also checks if 
invoices have been put on hold. 

  

Note: 

o The program lists customer accounts with invoices that are due within the Minimum number 
of days before due date to send a Payment Due Alert. (This is a Payment Due Alerts Setup 
setting.) 

o Double-click a line in the grid to see the customer’s due invoices. 
− Accounts appear if at least 1 invoice is within the “Minimum number of days before due 

date to send a Payment Due Alert” for the customer, and is not on hold. 

o Customers will not appear if the Minimum number of days between Payment Due Alerts has 
not elapsed. 

o Customers will not appear if their invoices are on hold. 

3. Click the All button to send emails for all companies with due invoices, and use the 
checkboxes in the Select column to cherry-pick customers. 
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4. Double-click the email template file name select a different template. 

o Highlight the email filename and click the Template column heading to display the email. 

5. Click the “Create Payment Due Alerts” button at the bottom of the form when you are ready to 
continue. 

The program will warn you if the “payment due” data wasn’t updated today.  

 

Click the Yes button to continue. 

6. Select options for emails in the form that appears. 

 

o You can select “Attach Copies of the Invoices” to include PDF copies of due invoices with 
emails. 

Note:  Do not attach invoices if processing takes too long. Attaching copies of invoices slows 
the process down because each invoice must be retrieved and rendered as a PDF.  

o Click the Attachments button to add additional attachments to all of the payment reminder 
emails – such as your policy on overdue accounts. 

 

7. Click the Process button on the email options screen to send the payment due reminder 
emails for the selected companies. 

8. When processing is finished, companies that were sent emails are removed from the list. 
You can: 

o Close the Payment Due Alerts program, or select one or more companies from the remaining 
list of companies to send emails. 

o Use “drag and drop” to add attachments, or click the Add button to search for attachments 
using Windows File Explorer. 
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Sample Reminder Email for Pending Invoice Payments 

The email can include a summary of pending invoices, as well as PDF attachments. 

 

Using the Update Button to Create, Update and Close Pending Reminder Records 

The Update button creates new pending payment reminder records for invoices according to the default 
setting for Minimum number of days before due date to send a Payment Due Alert specified in Payment 
Due Alerts Setup. You can override the setting for individual companies in the Company window. 

  

Double-click a row in the Payment Due Alerts grid to see the pending invoices 

 

Using the Search Field and Company Field to Filter Payment Due Alerts 

You can restrict the display of customers with pending payment due alerts to make it easier to select a 
subset of customers for processing.  

• Use the Search field at the top of the screen to filter your account selection. 

 

In this case, we searched for “bar” to see Companies with “bar” in the name. 

o Click the red X at the end of the Search field to remove search terms.    
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Search using company optional field values:  You can also enter values for company optional 
fields in the Search field.  

In the following example, we filtered on a “Salesperson” optional field to send emails to the 
customers for a salesrep. You could also use an optional field to filter by region or customer type. 

  

o Consider adding a non-alphabetic character to any optional fields that you want to use for 
filtering – for example, use “*keith” as the code instead of “KEITH”. 

o If you have a “terms” optional field, you could do a special run for a particular group of 
customers. 

• Use the Company field at the top of the screen to filter for a single company. 

   

o Use the Advanced… button to filter cases by different customer field ranges. 
o Use the Company field to send reminder emails for the selected company only.  
o Click the Red X to remove the company filter. 

Additional Features on the Payment Due Alerts Grid 

    

Note the following features on the Payment Due Alerts screen and grid: 

• Displays the date when the list was last updated, along with the ID of the user who ran the 
update. The date will be updated again when you click the Update button.  

• Shows the number of invoices due, the total amount due, the account balance and currency, and 
the default email template. 

• Flags companies with promised payments (+), unapplied credit ($), open cases (!), or disputed 
invoices (?). 

• Provides drilldown to the A/R customer information (click the Customer Number column heading), 
CRM and Collections customer data (click the Company Name column heading) and Collections 
information (click the Flags column heading). 

• Double-click a line in the grid to see a list of due invoices.  

• Click the Processed tab to see past payment due alerts. 
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Viewing Payment Due Alerts Communications and Sent Emails 

• Select the Processed tab on the Payment Due Alerts screen. 

• Highlight the alert that you want to view, and click the Company Name column heading.to 
drill down to the Company data. 

• Select the Communications tab on the Company screen to view payment due alert email 
communications. 

• Double-click the email communication entry.  

• Click the View Email button to see the emails. 
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Send A/R and O/E Invoices to Multiple Customer Contacts 

The Send Invoices program is a powerful and flexible replacement for Sage 300 programs that email A/R 
Invoices and O/E Invoices to customers.  

You can run the program interactively from the Sage 300 Desktop, or you can run the program as a 
Windows Scheduled Task. See Send Invoices Setup and also refer to the Scheduler User Guide. 

Note: You must select the Send Invoices Checkbox on the Company form for each company that you 
want to send invoices. 

 

  

The Send Invoices program lets you: 

• Quickly select all unsent A/R and O/E invoices and email them to multiple customer contacts per 
company, then use the checkboxes to cherry-pick the invoices that you want to send. 

• Find individual customers using the SmartFinder or use Advanced Search to select customers by 
up to 4 customer record fields or optional fields – such as the customer number, national account, 
customer group, currency, salesperson, or territory. Then use the checkboxes to refine your list. 

• Select and preview email templates at run time – letting you tailor your message for different 
customer groups, sales regions, countries, etc. 

• Send emails that match each invoiced company’s preferred language. See Sending Emails and 
Invoices Using the “Preferred Language” Company Setting. 

https://www.tairox.com/downloads/crm/Scheduler%20User%20Guide.pdf
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• Add additional attachments to each email – such as your overdue payment policies. 

• Click the Preview button to view the body of the selected Send Invoices email template.  

If you have a multi-lingual Sage 300 system, the preview appears in the user’s language, if you 
are running in French or Spanish and you created French or Spanish email templates. 

• Send invoices and credit notes created by Service Manager, a Technisoft product that integrates 
with Sage 300. Note that the program does not print invoices. 

The program treats invoices from other 3rd party programs as if they originated in A/R. 

• Log all email activity and creates a separate communication for each recipient to document the 
emails, so you can view all past emails and attachments in the communications window. 

Note: Send Invoices does not resend invoices that have already been sent. Use the Resend Documents 
function in the Companies window to resend invoices or statements to customers. 

To email invoices to customers, you must set up recipient email addresses: 

 Either provide an email address for each company or principle company contact on the A/R 
Customer Address tab and and choose Email or Contact’s Email as the Delivery Method in the 
A/R Customer record (on the Processing tab). 

  AND/OR 

 For each CRM company, select the company contacts that should receive A/R and O/E invoices 
on the Contacts tab of the CRM Company screen. 
 

 
 

The program sends emails to email addresses specified by the customer's delivery method in A/R 
as well as to all contacts set up as invoice recipients recipients in CRM (as shown above).  

See Select Recipients for Emailed Invoices, Statements, Letters, Payment Reminders and Payment Due 
Alerts for details.  

Note: CRM also uses the “Preferred Language” setting in the Company window to send emails and 
invoices from the Send Invoices program in English, French, or Spanish. See Appendix C for details. 

Also note that you must set up the email settings in the Send Invoices Setup program before you can 
send documents. See Send Invoices Setup for details. 

Delivery Method Must be “Email” in the A/R Customer Record to Email the 
Company or the Main Contact Email Addresses 

If the Delivery Method set in the A/R Customer Record (on the Processing tab) is Email (Customer) or 
Email (contact), TaiRox Collections will send to that email address IN ADDITION TO the contact email 
addresses defined on the company’s Contacts tab (shown above). 

If you do NOT want to Email invoices to some customers, specify “Mail” as the Delivery Method in A/R 
on the Address tab of the A/R Customer Record AND deselect A/R and O/E invoices for all contacts on 
the company's contacts tab. 
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You can then do a print run for unsent invoices using the O/E Invoices or A/R Invoices functions in the 
Send Documents window. 

Using the Send Invoices Program 

1. Choose the Send Invoices program from the Send Documents folder. 

2. Click the Update button to update the grid with all unsent, selected documents (in this case A/R 
and O/E invoices) in the selected date range. 

If you use Service Manager V/M – Technisoft's Service and Maintenance software – you will see 
two additional checkboxes in the Documents section for selecting V/M invoices and credit notes. 

3. Click the All button to select all checkboxes for the current page of the grid.  

Note that this is page 1 of 4 in the grid. You can lengthen the window by dragging the bottom 
border, and you can use the page navigation buttons to move to each new page. 

Click the All button on each grid page to include all unsent documents. 

  

In the screen above, we are sending O/E invoices to customers 1500, 4030, and 2130 on page 1 
of the grid. 

4. You can select a different email template from the dropdown list. 

o The Template dropdown lists all “html’ and “txt” type messages stored the following folder:  

C:\<Sage300SharedData>\Company\<companyID>\TaiRox CRM\Templates\Send Invoices 

Click the Preview button to see the email template with sample customer data. 

See Appendix C: Editing Email Templates for Send Invoices, Send Statements, Payment 
Due Alerts, and Overdue Payment Reminders for information on creating email templates. 

5. Click the Send Documents button to send the emails.  

  

• Choose Yes when asked to confirm that you want to “send documents”. If you click No, you 
can continue to edit the Send Invoices fields or close the program. 

• The program will show progress bars as it generates PDF attachments and sends the emails. 
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Viewing “Send Invoices” Emails on the Communications tab 

You can view all email communications generated by Send Invoices on the Communications tab for the 
company (or contact) or by opening the Communications window from the Sage desktop.  

To view emails from the Companies window: 

1. Select the company in the Companies window and click the Communications tab.  

You can also click the Communications tab for individual contacts or open the Communications 
window from the Sage desktop to see communications. 

2. Double-click the communication you want to view, then click the View Email button in the 
communication window. You can double-click the attachments to see the invoices. 

  

See Appendix C: Editing Email Templates for Send Invoices, Send Statements, Payment Due Alerts, 
and Overdue Payment Reminders for information on creating and editing email templates. 
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Send A/R Statements to Multiple Customer Contacts 

The Send Statements program is a powerful and flexible replacement for Sage 300 program that emails 
A/R Statements to customers and national accounts. 

You can run the program interactively from the Sage 300 Desktop, or you can run the program as a 
Windows Scheduled Task. See Send Statements Setup and also refer to the Scheduler User Guide. 

Note: You must set up Statement Profiles before you can send statements. When TCRM is activated two 
default statement profiles are created; DEFAULT for use by companies and DEFAULTNA for use by 
national accounts. You should review these to make sure the desired settings are selected before running 
Send Statements the first time. 

Statement profiles specify the options needed to create statements as well as determine statements will 
be created and sent. 

In order for a company or national account to receive a statement they must have: 

• The Send Statements option selected 

• One or more active contacts that specify an email address and have the A/R Statements form 
selected  

• An active statement profile that is linked to a schedule 

Note: Send Statements will only advance a statement profile's Next Cutoff Date if statements were 
successfully created for all customers using the profile. Note that this does not mean that the statements 
were successfully sent, only that the data for the statements was created. 

Note: If there were errors when sending the statements then they would be logged. You should review 
the errors in the log, make the necessary corrections, and then manually send the statements to the 
customers (companies) using the Resend Documents form. 

 

https://www.tairox.com/downloads/crm/Scheduler%20User%20Guide.pdf
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To email statements to customers and national accounts, you must set up recipient 
email addresses: 

 For each CRM company and national account, select the contacts that should receive A/R 
statements on the Contacts tab of the CRM Company and National Accounts screens. 
 

 
 

The program sends emails to all contacts set up as statement recipients in CRM (as shown 
above).  

See Select Recipients for Emailed Invoices, Statements, Letters, Payment Reminders and Payment Due 
Alerts for details.  

Note: CRM also uses the “Preferred Language” setting in the Company and National Account 
windows when sending statements. See Appendix C for details. 

Also note that you must set up the email settings in the Send Statements Setup program before you can 
send documents. See Send Statements Setup for details. 

 

 

 

 
  



Accounts Receivable and Collections Send Statements, Letters, and Invoices to Multiple Recipients 

TaiRox CRM and Collections for Sage 300 141 User Guide 

Send Statements, Letters, and Invoices to Multiple Recipients 

CRM provides three programs for emailing and printing statements, letters, and invoices to multiple 
recipients, logging all email activity, and creating communications for each recipient to document the 
emails. 

 

The following CRM programs effectively replace three standard Sage 300 programs: 

Send Statements/Letters:  Replaces Sage 300 A/R Statements / Letters / Labels (in the A/R 
Customer Reports folder).  

Send A/R Invoices:  Replaces Sage 300 A/R Invoices (in the A/R Transaction Reports folder) 

Send O/E Invoices:  Replaces Sage 300 Invoices (in the O/E Forms folder) 

Use the Send Invoices program to email all new A/R and O/E invoices to groups of customers. 

Note:  Before you can email accounting documents with these programs, you must use the Accounting 
Documents Setup program to specify the contents of your emails.  

You must also make sure that each company record includes an email account or contact’s email 
account, or has additional company contacts set up as email recipients for each document.  

To email documents to customers, you must: 

 1. Select the “Customer” Delivery Method when you print Statements, Letters, or Invoices from 
CRM – just like in A/R. 

  If the Print function Delivery Method is set to “Print Destination”, CRM will NOT send emails. 

 AND have the recipient email addresses set up 

 2. Either provide an email address for each company or principle company contact on the A/R 
Customer Address tab and and choose Email or Contact’s Email as the Delivery Method in 
the A/R Customer record (on the Processing tab). 

  CRM uses the email templates set up in the Accounting Documents Setup function. 

  AND/OR 

  For each CRM company, select the accounting documents that each company contact 
should receive on the Contacts tab of the CRM Company screen. 
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Using Email or Contact’s Email addresses after you set up accounting documents: 

If the Delivery Method set in the A/R Customer Record (on the Processing tab) is Email or Contact’s  
Email, CRM will send to that email address IN ADDITION TO the contact email addresses defined on the 
company’s Contacts tab (shown above). 

If you do NOT want to send to the Email or Contact’s Email addresses, specify “Mail” as the Delivery 
Method in A/R on the Address tab of the A/R Customer Record. 

See Select Recipients for Invoices, Statements, Letters, Payment Reminders and Payment Due Alerts.  

Communications are not created if the Delivery Method in A/R is “Mail” and accounting 
documents are not set up: 

If the Delivery Method set in the A/R Customer Record is Mail, CRM will not create a communication.  

Mixing print and email delivery methods 

If some of your statements, letters or invoices are emailed to customers, and others are printed using the 
“Mail” delivery method, please note the following points: 

• Emailing is performed first, and then the program prints accounting documents which will be sent 
out by mail. 

• Depending on the Sage 300 Print Destinations, some user intervention may be required when 
emailing is complete.  For example, if your Sage 300 print destination is Preview, several print 
preview windows may appear that you will need to deal with. 

Sending Statements/Letters 

This program lets you email statements and letters to multiple contacts per customer and record each 
email as a communication. The screen is almost identical to the A/R Statements/Letters/Labels screen. 

CRM’s Send Statements/Letters uses the emails defined with the CRM Accounting Documents Setup 
program.  

You should set up the email recipients for your customers (on the Contacts tab in the CRM Company 
window) before using this program to send out accounting documents. 
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Notes: 

• You MUST set the Delivery Method on this screen to “Customer” in order to send emails. If you 
select “Print Destination”, all statements will be printed to the Sage 300 print destination. 

• Select National Account Statements to send statements to national account contacts instead of 
for the individual customer accounts that belong to the national account.  

• Statements and letters are added as PDF attachments to customer emails. 

• Specify email messages for statements and letters with the Accounting Documents program. 

The “From Email” setting in Accounting Documents overrides the email setting in CRM Options. 

• Specify the recipients for statements and letters on the Contacts tab for each company. See 
Specify Email Addresses for Statements, Letters, Invoices, and Payment Reminders. 

Depending on the Delivery Method set in A/R for each company or national account, the program 
will also send emails to the company email address or the primary contact’s email address listed 
on the Company tab. 

• If you have set up one or more contacts to receive accounting documents in the CRM Company 
window, and you set the Delivery Method in the A/R Customer record to Mail, CRM will send 
emails only to the recipients listed in the Company window – not to the Company or Primary 
Contact email address.  

All company contacts with accounting documents set up will get statements or letters emailed to 
them – no matter which Delivery Method is set in the A/R Customer record. 

• If some statements or letters are printed, all emails will be processed first, and then printed 
documents. 

Resend Statements 

 

• Click the Resend Statements button to reprint or resend a range of statements selected by date 
and customer number. 

• Choose a reason – either because of an incomplete statement run or to print or send an 
additional copy. 

• Use the Resend Documents function in the Companies window to resend A/R and O/E 
documents – including past A/R statements – to individual customers. 

Resend Documents also lets you preview and send interim statements to customers. Preview is 
very useful for answering customer phone inquiries, then quickly emailing the same information. 

Sending A/R Invoices 

This program lets you email A/R Invoices to multiple contacts per customer and record each email as a 
communication. The screen is almost identical to the A/R Invoices screen in the A/R Transaction Reports 
folder. 

Note that CRM and Collections also provides a Send Invoices program in this folder that provides more 
features for sending A/R and O/E invoices to customers.  
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The program sends one email to each email address and attaches up to the maximum number of 
invoices specified by the Attachment Limit setting on the Accounting Document tab for the specific 
company. If you have more invoices, it will attach them to a subsequent email. 

Specify 1 for the Attachment Limit setting to send 1 invoice per email to customers, if they request it.  

You can also choose to have a single attachment that includes ALL invoices up to the maximum, or send 
separate attachments for each invoice.  

 

You define Emails for Send A/R Invoices using the CRM Accounting Documents Setup program.  

Notes: 

• You MUST set the Delivery Method on this screen to “Customer” in order to send emails. If you 
select “Print Destination”, all invoices will be printed to the Sage 300 print destination. 

• Specify email messages for invoices using the CRM Accounting Documents Setup program. 

The “From Email” setting in Accounting Documents overrides the email setting in CRM Options. 

• Invoices are added as PDF attachments to the customer email.  

You can include all invoices in a single PDF for each customer (this is the default Sage 300 
setting), or you can create a separate PDF for each invoice. 

• Emails for companies with Accounting Documents set up are sent to all contacts specified on the 
Contacts tab in the CRM Company window for each company.  

Depending on the Delivery Method set in A/R for each company, the program will also send 
emails to the company email address or the primary contact’s email address listed on the 
Company tab. 

• If you have set up one or more contacts to receive accounting documents in the CRM Company 
window, and you set the Delivery Method in the A/R Customer record to Mail, CRM will send 
emails only to the recipients listed in the Company window – not to the Company or Primary 
Contact email address.  

All companies with accounting documents set up will get invoices emailed to them – no matter 
which Delivery Method is set in the A/R Customer record. (The invoice printing function must use 
the “Customer” Delivery Method.) 

• If some invoices are printed, all emails will be processed first, and then printed documents. (The 
program will print [not email] invoices for customers that have no email recipients set up.) 

• Like the Sage 300 Send A/R Invoices program, there is no way to skip the summary invoices that 
originate in OE. Use the Send Invoices program to email A/R invoices and detailed O/E invoices. 



Accounts Receivable and Collections Send Statements, Letters, and Invoices to Multiple Recipients 

TaiRox CRM and Collections for Sage 300 145 User Guide 

Resend Invoices 

• Select “Reprint Previously Printed Invoices” to resend them to customers. 

• Use the Resend Documents function in the Companies window to resend documents and 
statements to individual customers. 

Sending O/E Invoices 

This program lets you email Order Entry Invoices to multiple contacts per customer and record the emails 
as communications. The screen is almost identical to the O/E Invoices screen in O/E Forms. 

Note that CRM and Collections also provides a Send Invoices program in this folder that provides more 
features for sending A/R and O/E invoices to customers.  

The program sends one email to each email address and attaches up to the maximum number of 
invoices specified by the Attachment Limit setting on the Accounting Document tab for the specific 
company. If you have more invoices, it will attach them to a subsequent email. 

Specify 1 for the Attachment Limit setting to send 1 invoice per email to customers, if they request it.  

Send O/E Invoices emails are defined using the CRM Accounting Documents Setup program.  

  

Notes: 

• You MUST set the Delivery Method on this screen to “Customer” in order to send emails. If you 
select “Print Destination”, all invoices will be printed to the Sage 300 print destination. 

• “Use Custom Form” matches the Order Entry choice, where the program uses the selection 
criteria for the custom form rather than the selection criteria that appears on the screen. 

• Specify email messages for invoices using the CRM Accounting Documents Setup program. 

The “From Email” setting in Accounting Documents overrides the email setting in CRM Options. 

• Invoices are added as PDF attachments to the customer email.  

• Emails for companies with Accounting Documents set up are sent to all contacts specified on the 
Contacts tab in the CRM Company window for each company.  

Depending on the Delivery Method set in A/R for each company, the program will also send 
emails to the company email address or the primary contact’s email address listed on the 
Company tab. 
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• If you have set up one or more contacts to receive accounting documents in the CRM Company 
window, and you set the Delivery Method in the A/R Customer record to Mail, CRM will send 
emails only to the recipients listed in the Company window – not to the Company or Primary 
Contact email address.  

All companies with accounting documents set up will get invoices emailed to them – no matter 
which Delivery Method is set in the A/R Customer record. (The invoice printing function must use 
the “Customer” Delivery Method.) 

• If some invoices are printed, all emails will be processed first, and then printed documents. 

• Use the Send Invoices program to email A/R invoices and detailed O/E invoices. 

Resend Invoices 

• Select “Include Invoices Already Printed” to resend them to customers. 

• Use the Resend Documents function in the Companies window to resend documents and 
statements to individual customers. 

Viewing Emails in the Communications window 

All email communications generated by Send Documents programs and overdue payment reminders 
created by Overdue Payments are available in the Communications window – letting you maintain a 
complete trail of all customer communications.  

To view emails: 

1. Open the Communications window. 

2. Double-click the communication that you want to view. (Use Company Search to view 
communications for a single company.) 

 

3. Click the View Email button in the communication window to display the email. 

You can then open the attachments to see the original documents.  

Note that older emails generated by Send Documents programs (prior to January 2020) 
were stored differently in CRM. 

See Open older emails for more information. 
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Resend Individual Documents from the Companies Window 

The Resend Documents button lets you quickly and easily resend existing A/R or O/E documents 
(invoices, orders, receipts, statements, etc.) or other attachments to any customer or contact email 
address directly from CRM.  

Resend Documents also lets you preview and send interim statements to customers. Preview is 
especially useful for answering customer phone inquiries, then quickly emailing the same information. 

• Type the body of the email on a standard email form or use a previously-saved email template.  

• Select any of the company and contact email addresses in CRM. Cc and Bcc addresses can 
default to prior values (see user settings). 

• Select any prior A/R and O/E documents to add as attachments – including an interim statement.  

• Click the Send button to generate and attach PDF’d documents and send the email. 

• View all past emails and attachments in the communications window. 

To start, click the Resend Documents button in the CRM Companies window.  

Note: You must set up the email settings in Setup Options before you can resend documents.  
See Options for details. 

 

Creating New Email Communications with A/R and O/E Document Attachments 

Resend Documents lets you send interim statements, resend A/R and O/E documents, or send emails 
with miscellaneous attachments to customer email addresses maintained in CRM and Collections. 

To compose and send emails: 

1. Open the Companies window, select the customer that you want to contact (click the row in the 
grid), and click the “Resend Documents…” button. Or double-click a company name to open a 
company record, and then click the “Resend Documents…” button on the Company screen. 
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2. Check that you have the correct name and customer number at the top of the screen. 

   

o To quickly preview an interim statement to answer a customer query: 

− Select the “Include Interim Statement” checkbox. 
− Click the Preview button to generate and view the interim statement. 

When TaiRox Collections produces an interim customer statement, it does not record the 
statement in Sage A/R. As a result, it does not impact the regular billing cycle, balance 
forward, or the last statement date. 

o To resend documents – or email an interim statement – fill in the email subject and the 
body of the email message or choose a message template from the Finder beside the 
Email Message field. The Finder displays all “Letter” type messages stored with Accounts 
Receivable. 

See Email Message Templates and Variables Supported by “Resend Documents” Emails. 

Note:  The email body can be up to 2,500 characters long. 

o Click the Attachments button to attach miscellaneous documents from your computer or 
network to this email. See Sending Miscellaneous Emails and Email Attachments to Contacts 
for more information. 

o Add email addresses in the Cc and Bcc fields to send copies (or blind copies) to other 
recipients in your company. To Cc or Bcc multiple recipients, separate the email addresses 
with commas or semicolons. 

o Add a Reply To email address to handle customer queries.  

Note: The Reply To address overrides the “From Email” address specified on the Email tab 
in CRM Options. 

3. Click the Recipients tab and select the recipients from the list of company contacts: 

 

To add a company recipient that is not in the contact list. 

o Double-click a recipient to open the Contact window, and then click the New button (+) beside 
the Contact Code field.  

o Fill in the contact information, and click the Add button. The new contact will be automatically 
linked to the current company. 
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4. Click the Optional Fields tab if your company uses the Optional Fields module and has defined 
fields for communications. The optional fields appear on communications created by the Resend 
Documents program. 

 

5. Select the A/R and O/E documents that you want to attach to the email from the tabs at the top of 
the screen. For A/R invoices, you can include or exclude fully paid invoices from the list. 

 

Add miscellaneous attachments using the Attachments button on the Communication tab. 

If you have use Service Manager V/M – Technisoft's Service and Maintenance software – you will 
see two additional tabs for selecting Invoices and credit notes. 

 

6. Click the Options button on each accounting document tab to choose the A/R or O/E forms that 
you want to use for creating PDF attachments. Each form also provides a set of printing options: 

 

A/R Invoice 
options  
Choose the 
Crystal report for 
emailing  
A/R invoices. 

 

A/R Receipts options 
Choose the Crystal report for emailing, and  
choose a detail or summary report format. 

 

Quote options 
Choose the Crystal report for emailing quotes,  
and select report options. 
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Order Confirmation options 
Choose the Crystal report for emailing quotes,  
and select report options. 

 

O/E Invoice options 
Choose the Crystal report for emailing quotes,  
and select report options. 

 

O/E Credit/Debit Note options 
Choose the Crystal report for emailing credit/debit  
notes, and select report options. 

7. Click the Send Documents button to send the email to all recipients. 

   

o Choose Yes when asked to confirm that you want to “send documents”. If you click No, you 
can continue to edit the email content. 

o The program will show progress bars as it generates PDF attachments and sends the email. 
o The program will display a message when the email is sent, and then return to the 

Companies window when you acknowledge it. 

Sending Miscellaneous Emails and Email Attachments to Contacts 

Resend Documents also lets you attach any documents on your computer (or on the network) to the 
email and send it to multiple company contacts. 

You can also send emails that do not have any attachments. CRM will save the email as a 
communication, maintaining a complete contact email history. 

To attach documents: 

1. Click the Attachments button on the Communication tab. 
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2. Drag and drop attachments into the Attachments window.  

 

Or click the Add button on the Attachments window to browse to documents that you want to add. 

o To delete a document from the list, select the document and click the Delete button or press 
the Delete key on your keyboard.  

3. Click the Close button when you have added all your attachments.  

When you close the window, the Attachments button will show you the number of attached 
documents. Click the button to open the Attachments window and edit the list. 

 

4. Edit the email and select email recipients from the Recipients tab, and then click the Send 
Documents button to send the email. 

The following message will appear if you did not select any accounting documents to resend 
to recipients. 

 

5.  Click Yes to send the email with only the miscellaneous attachments. 

Choosing Interim Statement Print Options 

Click the Interim Statements Print Options button on the Resend Documents Communications tab: 
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The print options are the same as the Print Criteria options for Sage 300 A/R statements: 

• Use Statement:  The program displays the current statement print file. Click the Browse button to 
search for a different file. By default, the program looks in folder “\Sage300\ARnnA\ENG”. 

For example, you might create a copy of your existing A/R Crystal Report statement for interim 
statements that says "Interim Statement" at the top instead of just "Statement". 

• Send Statements to Customers with Debit Balance, Credit Balance, and/or Zero Balance:  
Most users will select all three checkboxes in order to create an interim statement for any 
customer. 

• Sort Documents by Document Number or Document Date:  Users typically order documents 
on statements by date, so customers see them in the order they were created. 

• Open Item Statement Type:  These are the same options provided by Sage 300 Print 
Statements. You can choose from the following statement options: 

o Statements formatted as they were for Sage 300 version 5.1, 5.2 and 5.3. This choice also 
lets you select two more options: 
− Include Paid Transactions For Open Item Accounts (to include transactions that have 

been paid, but have not yet been cleared) 
− Include Applied Details For Open Item Accounts (to show receipts, prepayments, 

unapplied cash, and credit notes) 

o Balance Forward style of statement 
o Transaction Current Outstanding Balances –prints all transactions that have a current 

outstanding balance. 
o Transaction Opening Balances Showing Applied Details – prints new transactions that have 

not appeared on statements, along with unpaid older transactions and the details of 
transactions that have been applied since the last A/R statement. 

o Transaction Opening Balances and New Transactions – prints new transactions that have not 
appeared on statements, along with unpaid older transactions. 

• Age By and Aging periods:  Today’s date appears on the statement, and the program uses this 
date to assign transactions or balances to aging periods.  

For example, if you choose to age documents by their due dates (for the Age By option), the 
program assigns each transaction to an aging period by calculating the number of days between 
its due date and the run date.  

• Dunning Messages:  If you do not select a code, the program uses the default messages 
entered on the A/R Options > Statement tab. 

Viewing “Resend Documents” Emails on the Communications tab 

All email communications generated by Resend Documents are available on the Communications tab for 
the company (or contact) or by opening the CRM and Collections Communications window from the Sage 
desktop – letting you maintain a complete trail of all customer communications.  

To view emails from the Companies window: 

1. Select the company in the Companies window and click the Communication tab (or open the 
Communications window from the Sage desktop). 

2. Double-click the communication you want to view, then click the View Email button in the 
communication window. You can double-click the attachments to see the original documents. 
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Note that older emails (prior to January 2020) were stored differently in CRM. 

To access older emails: 

o Open the Communications window from the Sage desktop – as shown below – or select the 
company in the Companies window and click the Communication tab. 

 

o To view the email with attachments, select the Documents tab, and click the Document 
column heading. 

 

3. To view Company information from the Communication window, click the Companies tab, then 
double-click the row with the company name. 
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Email Message Templates and Variables for “Resend Documents” Emails  

You can create and save standard email messages to use with the Resend Documents program. Use the 
Finder to select existing message templates. The Finder displays all “Letter” type messages stored with 
Sage 300 Accounts Receivable. 

  

To create and save a new message: 

1. Click the Zoom button beside the Email Message field to display the A/R Messages form. 

  

2. Click the New button (+) on the right side of the Message ID field. 

3. Enter a name for the new email template (the Message ID), and enter a Description and Email 
Subject. 

4. Compose the message using any of the variables listed below. 

5. Click the Add button. 
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Email Variables 

You can use the following variables in email messages: 
 

Email Message Variable Value to Insert 

$COMPANY_CONTACT Company Contact from CRM & Collection’s Company record 

$COMPANY_NAME Company Name from CRM & Collection’s Company record 

$CUSTOMER_ID A/R Customer Number 

$CUSTOMER_CONTACT Customer Contact from the A/R Customer record 

$CUSTOMER_NAME Customer Name from the A/R Customer record 

$COMPANY_FAX Company Fax Number from CRM & Collection’s Company record 

$COMPANY_PHONE Company Phone Number from CRM & Collection’s Company record 
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Collections Reports and Collections Performance Charts 

TaiRox collection charts and reports cut through surplus data to provide a quick overview of your 
company’s collections performance. Along with the Customer Aging program, they help you monitor and 
manage your company’s receivables. 

TaiRox Collections provides two kinds of reports: 

• Charts that show the effectiveness of your company’s credit and collection policies. 

Charts create Excel spreadsheets containing the consolidated data and the chart. The 
spreadsheet is completely editable.  

• Reports that show the current status, details, and currency totals for all or a selection of your 
company’s disputed invoices, overdue invoices, payment reminders, and promised payments.  

Reports use the standard Crystal Reports engine for Sage 300, letting you print to standard Sage 
print destinations and export data to PDF, Word, or Excel spreadsheet formats. 

Access:  Open the Collections Reports folder, then select the chart or report that you want to display. 

 

Average Days to Pay 

The program charts the average number of days clients take to pay their bills, indicating the effectiveness 
of your company’s credit and collection policies, and allowing you to see the effectiveness over time of 
policy changes.  

 

To chart Average Days to Pay: 

1. Select TaiRox CRM and Collections > Collections Reports > Avg. Days to Pay Chart. 

2. Select customers using a range of customer record and customer optional fields. 
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3. Click Create Chart. 

The program will display the chart and data in separate worksheets in an Excel workbook. 

 

Average Days Overdue  

The program charts the average number of days that invoices are overdue before being paid. This is also 
a measure of your company’s credit and collection policies, and allows you measure their effectiveness 
over time.  

 

To chart Average Days Overdue: 

1. Select TaiRox CRM and Collections > Collections Reports > Avg. Days Overdue Chart. 

2. Select customers using a range of customer record and customer optional fields. 

 

3.  Click Create Chart. 

The program will display the chart and data in separate worksheets in an Excel workbook. 
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Collections Effectiveness Index 

The Collections Effectiveness Index (CEI) show the percentage of receivables that have been collected in 
each month over the past year. It compares the amount that was collected in each month during the 
year to the receivables that were available for collection.  

Essentially, this metric shows how quickly your company collects outstanding receivables. An 
effectiveness index near 80% or above indicates a very effective collections process, while an index of 
50% and below is low and should be investigated.  

The formula for the effectiveness index includes the total credit sales for each month. Because Sage 
does not differentiate between credit sales and cash sales, this program considers invoices paid on or the 
day after the invoice date to be cash sales, and all other invoices to be credit sales. 
 

Beginning Receivables + Monthly Credit Sales – Ending Total Receivables 

Beginning Receivables + Monthly Credit Sales – Ending Current Receivables       
X  100 

The program includes invoices, debit notes, and interest in the sales total.  

 

To chart the Effectiveness Index: 

1. Select TaiRox CRM and Collections > Collections Reports > Effectiveness Index Chart. 

2.  Click Create Chart. 

 

The program will display the chart and data in separate worksheets in an Excel workbook. 

https://www.billtrust.com/products/collections/
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Disputed Invoices 

This report that let you review the current status, details, and currency totals for all or a selection of your 
company’s disputed invoices. You can print the report for all assigned disputed invoices, for unassigned 
invoices, or for invoices assigned to a specific user. 

Reports use the standard Crystal Reports engine for Sage 300, letting you print to standard Sage print 
destinations and export data to PDF, Word, or Excel spreadsheet formats. 

 

To print the Disputed Invoices report: 

1. Select TaiRox CRM and Collections > Collections Reports > Disputed Invoices. 

2. Specify the contents of the report using the options on the following screen, then click the Print 
button. 

 

Range Fields:  The program lets you select disputed invoices using a range of invoice numbers, 
customer numbers, customer groups, and creation dates. 

Include Open/Closed/Notes:  Use the checkboxes to print open and/or closed records and to 
print all Notes that are attached to the Notes tab for disputed invoices.  
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The contents of the Notes field on the Disputed Invoices tab always appear on the report. (See 
example below.) 

Assigned To:  Select this checkbox and use the Finder to print all disputed invoices assigned to 
a single user. Leave the field blank to print all unassigned disputed invoices. 

Sort By:  You can choose two levels of sorting – by invoice number, customer number, customer 
group, currency, assigned user, creation date, number of days open, and revisit date. For 
example, you can group all disputed invoices by assigned to user, then list by currency within 
each group. 

Days Open:  This is the number of days that the disputed invoice record has been Open – 
calculated as Days Open = Current Date – Created On Date. If the record has been closed, 
the calculation is Days Open = Closed On Date – Created On Date 

The program will print or display the disputed invoices report using the Sage 300 print destination 
that you selected. 

 

o This example includes a note added to the Notes tab for the first disputed invoice for ACME 
Plumbing. 

The other freeform text is from the Notes field on the Disputed Invoice tab. 

o The program prints a summary of the total amount of disputed invoices for each currency at 
the end of the report. 

Overdue Invoices 

This report that let you review the current status, details, and currency totals for all or a selection of your 
company’s overdue invoices. You can print the report for all assigned overdue invoices, for unassigned 
invoices, invoices that are on hold, or for overdue invoices assigned to a specific user. 

Reports use the standard Crystal Reports engine for Sage 300, letting you print to standard Sage print 
destinations and export data to PDF, Word, or Excel spreadsheet formats. 
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To print the Overdue Invoices report: 

1. Select TaiRox CRM and Collections > Collections Reports > Overdue Invoices. 

2. Specify the contents of the report using the options on the following screen, then click the Print 
button. 

 

Range Fields:  The program lets you select overdue invoices using a range of creation dates, 
invoice numbers, customer numbers, customer groups, and days overdue. 

Include:  Use the checkboxes to print open or closed records, to print notes that are attached to 
the Notes tab for overdue invoices, and to include overdue payment reminder emails or tasks.  

Select:  You can print a report that only shows invoices that are on hold or not on hold. The 
report flags all on hold invoices. 

Assigned To:  Select this checkbox and use the Finder to print all overdue invoices assigned to 
a single user. Leave the field blank to print all unassigned invoices. 

Sort By:  You can specify two levels of sorting using the invoice number, customer number, 
customer group, currency, assigned user, creation date, stage, days overdue, and revisit date. 
For example, you can group invoices by assigned to user, then list by currency within each group. 

The program will print or display the overdue invoices report using the Sage 300 print destination 
that you selected. 
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o Print selection criteria appear at the top of the report. This report lists invoices for customer 
1600, one of which is assigned to Keith. 

o Notes and overdue payment reminders (OPRs) are optionally printed for each invoice. 
o Company flags show whether the customer is on hold or has unapplied credit, open cases, 

disputed invoices or promised payments. Invoice flags show whether the invoice has a 
payment schedule or is disputed. 

o The program prints a summary of the total invoice amounts by source currency. 

Overdue Payment Reminders 

This report that let you review the details and currency totals for all or a selection of your company’s 
pending or processed (sent) customer payment reminders. You can print a summary or detail report, print 
the report for a range of customer groups, customer numbers and date processed, and sort the details 
using the selection criteria. 

Reports use the standard Crystal Reports engine for Sage 300, letting you print to standard Sage print 
destinations and export data to PDF, Word, or Excel spreadsheet formats. 

 

To print the Overdue Payment Reminders report: 

1. Select TaiRox CRM and Collections > Collections Reports > Overdue Payment Reminders. 

2. Specify the contents of the report using the options on the following screen, then click the Print 
button. 
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Report Type:  Choose “Customer Pending” to list the payment reminders that will be sent if you 
process them now, or choose “Customer Processed” to list payment reminders that have already 
been sent to customers. 

The “Customer Processed” report lets you choose the range of processing dates. 

Report Format:  You can print a “Summary” report that lists each customer and amount overdue, 
or print a “Detail” report that lists each outstanding document for each customer. 

Range Fields:  The program lets you select overdue payment reminders using a range of 
customer groups, customer numbers, and date processed (if you are reporting processed 
reminders). 

Sort By:  You can specify three levels of sorting using the customer groups, customer numbers, 
and date processed. For example, you can group reminders by customer number, then by date 
processed for each customer. 

The program will print or display the overdue payment reminders report using the Sage 300 print 
destination that you selected. 

 

o Print selection criteria appear at the top of the report. This report lists customer payment 
reminders that were processed on July 15, 2022. 

o Document details are optionally printed for each reminder. 
o The program prints a summary of the outstanding amounts for reminders by source currency. 
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Promised Payments 

This report that let you review the current status, details, and currency totals for all or a selection of your 
company’s promised payments. You can print the report for all assigned promised payments, for 
unassigned promises, or for promised payments assigned to a specific user. 

Reports use the standard Crystal Reports engine for Sage 300, letting you print to standard Sage print 
destinations and export data to PDF, Word, or Excel spreadsheet formats. 

 

To print the Promised Payments report: 

1. Select TaiRox CRM and Collections > Collections Reports > Promised Payments. 

2. Specify the contents of the report using the options on the following screen, then click the Print 
button. 

 

Range Fields:  The program lets you select promised payments using a range of dates 
promised, customer numbers, customer groups, and creation dates. 

Include Open/Closed/Notes:  Use the checkboxes to print open and/or closed records and to 
print all Notes that are attached to the Notes tab for promised payments.  

The contents of the Notes field on the Promised Payments tab always appear on the report. (See 
example below.) 

Assigned To:  Select this checkbox and use the Finder to print all promised payments assigned 
to a single user. Leave the field blank to print all unassigned promised payments. 

Sort By:  You can choose two levels of sorting– by date promised, customer number, customer 
group, currency, assigned user, creation date, and revisit date. For example, you can group all 
promised payments by assigned to user, then list by currency within each group. 

The program will print or display the promised payments report using the Sage 300 print 
destination that you selected. 
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o This example includes a note added to the Note tab for the first promised payment (ID 2) for 
Mr. Ronald English. 

The other freeform text is from the Notes field on the Promised Payment tab. 

o The program prints a summary of the total amount promised and total paid by source 
currency. 
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Periodic Processing 

 
* Create Opportunities appears if you are using the CRM and Collections module (not the standalone Collections module) 

* Sync Contacts appears only if you are using the Sage 300 M/T Contacts module and Sync National Accounts appears only if  

      you are using Sage 300 National Accounts. 

The Periodic Processing folder includes tasks that are part of your regular procedures. Note that you can 
also automate several CRM and Collections tasks using the task Scheduler, in the Setup folder. 

Create Opportunities 

The Create Opportunities program lets you: 

• Specify the group of customers for which you want to create opportunities using fields from the 
A/R customer record and CRM optional fields. (For example, you can specify a range of A/R 
customer IDs and specify the account rep ID in an optional field.) 

You can cherry-pick from the resulting group to exclude individual companies. 

• Specify the information that you want to appear for each opportunity – including opportunity 
optional fields. 

• Generate the opportunities in one process. 

Create Opportunities will not appear on the Sage 300 Desktop if are using the Collections 
module without CRM. 

Access:  Select TaiRox CRM and Collections > Periodic Processing > Create Opportunities. 
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Notes: 

• The program creates opportunities for Companies that are also A/R Customers. It does not create 
opportunities for prospects. 

• By default, the Company Range fields will display the last selection criteria used to create 
opportunities. 

Specify the group of companies for which you are creating opportunities 

You can specify ranges using A/R Customer fields for company selection – including the customer 
number, national account, group code, account set, terms, billing cycle, interest profile, payment 
code, tax group, currency code, customer price list, inventory location, ship-via code, and territory 
code. You can also use any of the optional fields that you use for companies in CRM and Collections. 

 

For example, the above screen shows customer selection by the Territory field and by two company 
optional fields – Sales Rep and Rental Customer. 

Load the list of companies and choose which require opportunities: 

 

• Click the Load button to display the list of companies that match the selection criteria. 

When the Load button is pressed, the program will display the companies in the range you 
specified. 

o You can adjust the company range, if necessary, then click the Load button again. 

• Click the Select All and Select None buttons at the bottom of the screen to include all or none of 
the companies loaded in the grid. 

 

• Click the Include column to “cherry-pick” companies: 
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Click the Opportunity Details button to add the opportunity information: 

 

• Click the Opportunity Details button to add opportunity details. The program will display the 
Opportunity screen, letting you fill in opportunity fields and optional fields for opportunities. 

• Click the Close button on the Opportunity details form when you are finished. The Name of the 
opportunity will now appear in the Name field on the Create Opportunities screen. 

 

Note:  You MUST complete the opportunity Name and Stage fields. All other information is optional. 
Note also that the program will not allow you to create duplicate opportunities – so you cannot create 
an opportunity for the same customer with the same name and creation date. 

Click the Process button to create the opportunities:  

 

• Click the Process button at the bottom of the screen to proceed. 

• Click Yes to confirm that you want to create the opportunities. 

The following message will appear if the opportunities were created successfully: 
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If you did not specify a name or stage for the opportunities, you will see a message like this. Close 
the message and click the Opportunity Details button to add the opportunity name or stage. 

 

Click the Log button to confirm which opportunities were processed: 

================================================================================ 

5/5/2020 11:37:12 AM Create Opportunities started. 

5/5/2020 11:37:12 AM  

5/5/2020 11:37:12 AM Performed by user: ADMIN 

5/5/2020 11:37:12 AM  

5/5/2020 11:37:12 AM Company Range 

5/5/2020 11:37:12 AM     Customer Number From [] To [ZZZZZZZZZZZZ] 

5/5/2020 11:37:12 AM  

5/5/2020 11:37:12 AM Opportunity 

5/5/2020 11:37:12 AM     Name: Summer Furnishings Sale 2020 

5/5/2020 11:37:12 AM     Amount: 1,000.000  

5/5/2020 11:37:12 AM     Certainty: 50 

5/5/2020 11:37:12 AM     Stage: QUALIFIED 

5/5/2020 11:37:12 AM     Assigned To: ADMIN 

5/5/2020 11:37:12 AM     Status: Open 

5/5/2020 11:37:12 AM     Opened On: 5/5/2020 

5/5/2020 11:37:12 AM     Expected Close: 8/15/2020 

5/5/2020 11:37:12 AM     Revisit On: 6/1/2020 

5/5/2020 11:37:12 AM     Revisit At: 12:00:00 AM 

5/5/2020 11:37:12 AM     Notes: Sale dates -- July 15 to Aug 15 

5/5/2020 11:37:12 AM     Comment: Printed brochure and email campaign to commence June 1. 

5/5/2020 11:37:12 AM  

5/5/2020 11:37:12 AM Creating Opportunity for Customer BARMART... 

5/5/2020 11:37:12 AM     Customer BARMART Opportunity ID 86 created. 

5/5/2020 11:37:12 AM Creating Opportunity for Customer 1580... 

5/5/2020 11:37:12 AM     Customer 1580 Opportunity ID 87 created. 

5/5/2020 11:37:12 AM Creating Opportunity for Customer 7200... 

5/5/2020 11:37:12 AM     Customer 7200 Opportunity ID 88 created. 

5/5/2020 11:37:12 AM  

5/5/2020 11:37:12 AM 3 record(s) created. 

5/5/2020 11:37:12 AM  

5/5/2020 11:37:12 AM 

================================================================================ 

The Log lists: 

• The user and the type of operation performed.  

• The range of customers specified. 

• The opportunity details. 

• Each customer that was processed and whether the records were updated.  
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Close Invoices 

The Close Invoices program closes all open Disputed Invoices and Tracked Invoices when the A/R 
invoice has been paid, written off, or cleared from A/R (so it has a 0 balance).  

Access:  Select TaiRox CRM and Collections > Periodic Processing > Close Invoices. 

 

To run the Close Invoices program: 

1. Select TaiRox CRM and Collections > Periodic Processing > Close Invoices. 

2. Choose whether you want to close Disputed Invoices and Tracked Invoices. 

3. Click the Process button. 

The program will display a message showing the number of closed records. 
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Close Promised Payments 

The Close Promised Payments program closes all open (and not deleted) Promised Payments with one 
or more linked invoices if all linked invoices have been paid. 

Note: The program closes promised payments with paid linked invoices, but it does not update the 
Amount Paid field because it does not know how much was paid. 

Access:  Select TaiRox CRM and Collections > Periodic Processing > Close Promised Payments. 

 

To run the Close Invoices program: 

1. Select TaiRox CRM and Collections > Periodic Processing > Close Promised Payments. 

2. Click the Process button to proceed. 

The program will display a message showing the number of closed records. 

 

If no promised payments can be closed, the program will display a message stating that none 
were closed: 
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Sync TaiRox Contacts with M/T Contacts 

Sync Contacts is a program that quickly identifies contacts in TaiRox CRM and Collection that are missing 
from the Sage 300 M/T Contacts module and M/T Contacts that are missing from CRM. 

Sync Contacts appears if you have Sage 300 version 2020.1 or higher installed and have activated the 
Sage 300 M/T Contacts module. 

Note on upgrading to Sage M/T Contacts:  If you are already running TaiRox CRM and Collections 
and have just acquired the Sage Multiple Contacts module, perform the following steps to add your 
CRM contacts to the M/T Contacts module and to individual A/R customer and national accounts 
records: 

• Run Sync Contacts to add all TaiRox CRM and Collections contacts to the M/T Contacts module.  

• Run Sync Companies to add all contacts linked to CRM companies to their corresponding  
A/R Customer records. 

• Run Sync National Accounts to add all contacts linked to CRM national accounts to their 
corresponding A/R National Account records. 

Access:  Select TaiRox > CRM and Collections > Periodic Processing > Sync Contacts to display 
the following screen. 

 

Note:  Make sure that “Suspend M/T Integration” is NOT selected in Setup Options. The 

Sync Contacts program is disabled if you select the Suspend M/T Integration option.  

The following message appears if you try to run Sync Contacts when M/T Integration has been disabled 
in CRM and Collections Setup Options: 
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CRM and Collections automatically synchronizes TaiRox contacts data with M/T Contacts data 
unless you deliberately suspend M/T integration. See Setup Options for more information on M/T 
Contacts synchronization. 

With integration on, if you add a contact in Sage M/T Contacts, the contact will be added to the 
contacts list in CRM and Collections. Similarly, if you delete a contact from CRM and Collections, the 
contact will also be deleted from the M/T Contacts module. 

Notes: 

• Click the Next button to check that contacts are synchronized. If contacts match, the following 
message appears:  

 

Screen #2 –contacts in TaiRox CRM and Collections only 

If contacts appear in CRM and Collections that are NOT in the M/T Contacts module, the following screen 
appears.  

 

To copy all TaiRox contacts to M/T Contacts: 

• Click the All button to select all contacts that are only in CRM and Collections. 

• Double-click the Copy column for each entry to select or de-select individual contacts. 

• Click the None button to de-select all contacts. 

• Click the Next button when you have finished selecting contacts and move to the next Sync 
Contacts screen. 

Screen #3 – contacts in the Sage M/T Contacts module only 

If contacts appear in the M/T Contacts module that are NOT in TaiRox CRM and Collections, the following 
screen appears.  
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To copy all M/T Contacts contacts to TaiRox CRM and Collections: 

• Click the All button to select all contacts that are only in the M/T Contacts module. 

• Double-click the Copy column for each entry to select or de-select individual contacts. 

• Click the None button to de-select all contacts. 

• Click the Next button when you have finished selecting contacts and move to the next Sync 
Contacts screen. 

Screen #4 – contacts with different field values in TaiRox and Sage M/T Contacts  

The following screen appears for contacts that appear in TaiRox CRM and Collections and in Sage’s M/T 
Contacts module but have different field values in each program. 

 

To reconcile differences between TaiRox contacts and Sage M/T Contacts: 

• Double-click individual lines in the grid to see the record differences between contacts in TaiRox 
CRM and Collections and contacts in Sage’s M/T Contacts module. 
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• Double-click the Action column, then choose from the dropdown to reconcile differences for one 
contact. 

 

Choose None to leave the differences between records, or choose to use the TaiRox CRM data 
or the M/T Contacts data for the record. 

• Use the Change All dropdown to select the same procedure for all contact differences in the list. 

Choose None to leave the differences between records, or choose to use the TaiRox CRM data 
or the M/T Contacts data for both records. 

 

Screen #5 – click the Finish button to make all selected changes  

• On the final screen: 

o Click the Finish button to make all selected changes. 
o Click the Close button to exit without making any changes. 
o Click the Previous button to revisit prior screens to check your edits. 

• All updates are listed on the screen as the program completes them: 
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Sync TaiRox Companies with Sage 300 A/R Customers 

Sync Companies is a program that quickly identifies which TaiRox CRM and Collections companies have 
data that is inconsistent with the linked customer record in Accounts Receivable.  

If you use the Sage 300 M/T Contacts module, Sync Companies will also compare the contacts added 
to TaiRox companies with the contacts added to A/R customers to see if they match. 

Note on upgrading to Sage M/T Contacts:  If you are already running TaiRox CRM and Collections 
and have just acquired the Sage Multiple Contacts module, perform the following steps to add your 
CRM contacts to the M/T Contacts module and to individual A/R customer and national accounts 
records: 

• Run Sync Contacts to add all TaiRox CRM and Collections contacts to the M/T Contacts module.  

• Run Sync National Accounts to add all contacts linked to CRM national accounts to their 
corresponding A/R National Account records. 

• Run Sync Companies to add all contacts linked to CRM companies to their corresponding  
A/R Customer records. 

Access:  Select TaiRox > CRM and Collections > Periodic Processing > Sync Companies to display 
the following screen. 

 

If you do not use M/T Contacts, the final message “You should run the Sync Contacts Wizard …” will not 
appear on the Sync Companies screen (shown above). 

Note:  Make sure that “Suspend A/R Integration” is NOT selected in Setup Options. The 
Sync Companies program is disabled if you select the Suspend A/R Integration option.  

The following message appears if you try to run Sync Companies when A/R Integration has been 
disabled in CRM and Collections Setup Options: 
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CRM and Collections automatically synchronizes company data with A/R customer account 
information unless you deliberately suspend A/R integration. See Options for more information on 
A/R synchronization. 

With integration on, if you add a customer in A/R, the customer will be added as a company in CRM 
and Collections. Similarly, if you delete a customer in A/R, the CRM and Collections company will be 
unlinked and flagged as deleted. 

Notes: 

• Regarding inactive customers:  Sync Companies only considers active customers when 
checking if a customer has a corresponding company in CRM and Collections. 

If you need to add an inactive customer to CRM and Collections: 

o Open the inactive customer in the A/R Customers program.  
o Make the inactive customer active, and save the change. The record will be automatically 

sync’d with the record with CRM and Collections. 
o Make the customer record inactive again, and save the change. 

• If all company data matches with A/R customer data, the following message appears when you 
click the Next button to check that companies are synchronized.  

 

• If you do not use the M/T Contacts module – or if “M/T integration” is suspended in Setup 
Options, the program will only compare companies to customers. It will not compare contacts. 

Screen #2 – A/R customers missing from TaiRox CRM and Collections 

If Accounts Receivable customers are missing from TaiRox CRM and Collections, the following screen 
appears.  
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To import missing A/R customers into CRM and Collections: 

• Click the All button to select all customers that are only in Accounts Receivable and import them 
into CRM and Collections. 

• Or double-click the Import column for each entry to select or de-select individual A/R customers. 

• Click the None button to de-select all A/R customers. 

• Click the Next button when you have finished selecting customers and move to the next Sync 
Companies screen. 

Screen #3 – A/R customers with different field values than in TaiRox CRM and 
Collections 

The following screen appears for A/R customers that appear in TaiRox CRM and Collections but have 
different field values in each program. 

 

To reconcile differences between A/R customers and TaiRox companies: 

• Double-click individual lines in the grid to see the record differences between A/R customer 
records and companies in TaiRox CRM and Collections. 

 

• Double-click the Action column, then choose from the dropdown to reconcile differences for one 
company. 

 

Choose None to leave the differences between records, or choose to use the TaiRox data or the 
A/R Customer data for both records. 
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• Use the Change All dropdown to select the same procedure for all companies and customers in 
the list. 

Choose None to leave the differences between records, or choose to use the TaiRox CRM data 
or the A/R customer data for both records. 

 

Screen #4 – click the Finish button to make all selected changes  

• On the final screen: 

o Click the Finish button to make all selected changes. 
o Click the Close button to exit without making any changes. 
o Click the Previous button to revisit prior screens to check your edits. 

• All updates are listed on the screen as the program completes them: 
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Sync TaiRox National Accounts with Sage 300 National Accounts 

Sync National Accounts is a program that quickly identifies if TaiRox CRM and Collections’ national 
accounts have data that is inconsistent with national account records in Accounts Receivable.  

If you use the Sage 300 M/T Contacts module, Sync National Accounts will also compare the contacts 
added to TaiRox national accounts with the contacts added to A/R national accounts to see if they match. 

Note on upgrading to Sage M/T Contacts:  If you are already running TaiRox CRM and Collections 
and have just acquired the Sage Multiple Contacts module, perform the following steps to add your 
CRM contacts to the M/T Contacts module and to individual A/R customer and national accounts 
records: 

• Run Sync Contacts to add all TaiRox CRM and Collections contacts to the M/T Contacts module.  

• Run Sync Companies to add all contacts linked to CRM companies to their corresponding  
A/R Customer records. 

• Run Sync National Accounts to add all contacts linked to CRM national accounts to their 
corresponding A/R National Account records. 

Access:  Select TaiRox > CRM and Collections > Periodic Processing > Sync National Accounts to 
display the following screen. 

 

If you do not use M/T Contacts, the final message “You should run the Sync Contacts Wizard …” will not 
appear on the Sync National Accounts screen (shown above). 

Note:  Make sure that “Suspend A/R Integration” is NOT selected in Setup Options. The 

Sync National Accounts program is disabled if you select the Suspend A/R Integration option.  

The following message appears if you try to run Sync National Accounts when A/R Integration has been 
disabled in CRM and Collections Setup Options: 
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CRM and Collections automatically synchronizes national account data with A/R account information 
unless you deliberately suspend A/R integration. See Options for more information on A/R 
synchronization. 

With integration on, if you add a national account in A/R, the national account will be added as a 
national account in CRM and Collections. Similarly, if you delete a national account in A/R, the CRM 
and Collections national account will be unlinked and flagged as deleted. 

Notes: 

• Regarding inactive national accounts:  Sync National Accounts only considers active national 
accounts when checking if a corresponding national account appears in CRM and Collections. 

If you need to add an inactive national account to CRM and Collections: 

o Open the inactive national account in the A/R National Accounts program.  
o Make the inactive national account active, and save the change. The record will be 

automatically sync’d with the record with CRM and Collections. 
o Make the national account record inactive again, and save the change. 

• If all CRM national account data matches with A/R national account data, the following message 
appears when you click the Next button to check that national accounts are synchronized.  

 

• If you do not use the M/T Contacts module – or if “M/T integration” is suspended in Setup 
Options, the program will only compare national accounts to national accounts. It will not 
compare contacts. 

Screen #2 – A/R national accounts missing from TaiRox CRM and Collections 

If Accounts Receivable national accounts are missing from TaiRox CRM and Collections, the following 
screen appears.  
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To import missing A/R national accounts into CRM and Collections: 

• Click the All button to select all national accounts that are only in Accounts Receivable and import 
them into CRM and Collections. 

• Or double-click the Import column for each entry to select or de-select individual A/R national 
accounts. 

• Click the None button to de-select all A/R national accounts. 

• Click the Next button when you have finished selecting national accounts and move to the next 
Sync National Accounts screen. 

Screen #3 – A/R national accounts with different field values than in TaiRox CRM 
and Collections 

The following screen appears for A/R national accounts that appear in TaiRox CRM and Collections but 
have different field values in each program. 

   

To reconcile differences between A/R national accounts and TaiRox national accounts: 

• Double-click individual lines in the grid to see the record differences between A/R national 
account records and national accounts in TaiRox CRM and Collections. 

 

• Double-click the Action column, then choose from the dropdown to reconcile differences for one 
national account. 

 

Choose None to leave the differences between records, or choose to use the TaiRox data or the 
A/R national account data for both records. 
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• Use the Change All dropdown to select the same procedure for all national accounts that appear 
in the list. 

Choose None to leave the differences between records, or choose to use the TaiRox CRM data 
or the A/R national account data for both records. 

 

Screen #4 – click the Finish button to make all selected changes  

• On the final screen: 

o Click the Finish button to make all selected changes. 
o Click the Close button to exit without making any changes. 
o Click the Previous button to revisit prior screens to check your edits. 

• All updates are listed on the screen as the program completes them, and the program posts a 
message when finished. 
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Setup and Maintenance Screens 

    

Notes: 

• Import Prod. Tools Contacts appears only if you use Productivity Tools and do not use the Sage 
300 M/T Contacts module. 

• XQSceduler.exe launches the CRM Job Scheduler for Overdue Payment Reminders and 
Payment Due alerts. You can also start it directly from the Windows File Manager. 

• Bulk Email Accounts – in the Marketing folder – lets you enter setup information bulk email 
accounts. It does not appear if you are using the Collections module without CRM. 

License Information 

The License Information icon lets you enter the CRM and Collections License code.  

Note: The Client ID and Company information must exactly match that shown by the Sage 300  
License Manager. 

 

The Help About menu choice shows build information and links to the TaiRox web site. 
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Options 

Options include settings that apply to all CRM and Collections users. For information on changing settings 
in data entry grids, see Appendix B: Using Data Entry Programs. 

Options Tab 

 

Suspend A/R Integration:  This checkbox lets you disable automatic updates between Accounts 
Receivable customer and national account records and CRM company and national account records.  

Note:  Sync Companies and Sync National Accounts are disabled if you select the Suspend A/R 
Integration checkbox in Setup Options. Do not suspend A/R Integration while setting up CRM. 

Leave this box unchecked to automatically synchronize customer/company and national account records 
in Accounts Receivable and CRM. 

Suspend M/T Integration:  This checkbox appears only if you are using the Sage Multiple Contacts 
module. It lets you disable automatic updates between Sage 300 M/T Contacts records and the contacts 
listed in the CRM Contacts program.  

Note:  Sync Contacts is disabled if you select the Suspend M/T Integration checkbox in Setup 
Options. Do not suspend M/T Integration while setting up CRM. 

In addition, Sync Companies and Sync National Accounts will not compare linked contacts in CRM and 
Collections to contacts in A/R if you suspend M/T Integration. 

More about CRM and Collections / Accounts Receivable Integration 

CRM and Collections / Accounts Receivable integration synchronizes corresponding customer and 
national account records.  

If you change a field that is common to CRM companies and A/R customers or to CRM national accounts 
and A/R national accounts (including optional fields and contacts), the linked customer/company record or 
linked national account record will also be updated. 

• If you insert a new company record or national account in CRM and Collections (or A/R), the 
record will also be inserted in A/R (or CRM and Collections).  

• If you add a contact to a company in CRM, the contact will be added to the A/R customer record. 

• If you add a record with a new territory in A/R, the new territory will be added to CRM. 

• If you delete a customer in A/R, the CRM company will be unlinked and marked as deleted.  
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Email Tab 

  

Email Server Settings:  These settings are used by the following programs: 

• Resend Documents functionality in the Companies window to resend documents to customers. 

• The Send Statements/Letters, Send A/R Invoices, Send O/E Invoices, and Send Invoices 
programs in the Send Documents folder. 

• Send Bulk Email program unless you use a bulk email provider like MailChimp or SendGrid. 

• By default for the Overdue Payment Reminders program, Payment Due Alerts program and Send 
Invoices program if you do not add settings with Overdue Payment Reminders Setup, Payment 
Due Alerts Setup, and Send Invoices Setup. 

Send Bulk Email lets you send batches of emails to contact groups, company contacts, or A/R customer 
contacts using the specified email server or using bulk email providers like MailChimp or SendGrid. This 
program is available only with CRM and Collections. 

Send Invoices provides flexible customer selection criteria for emailing A/R and O/E Invoices to customers. 

Resend Documents lets you resend past customer documents and interim statements to one or more 
customer contacts. See Resend Individual Documents from the Companies window for more information. 

For more information on sending statements, letters, and invoices to customers, see Send Statements, 
Letters, and Invoices to Multiple Recipients. 

Server Name:  Enter the name of the outgoing message server for CRM emails. 

Server Port:  Enter the SMTP port number. 

Use SSL:  Check this box to have the email communication SSL encrypted. 

See the “Use SSL” note under “Send Test Email,” below. 

Username:  Enter the account user name for sending emails. 

Password:  Enter the password for the user account. 

From Email:  Provide the default From Email address that you want to use for emails created by CRM 
and Collections. (You can't always separate the From Email from the Username email.) 

If this field is left blank, the default From Email address for CRM documents will be the user’s email 
address in Sage 300. 
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Note:  Depending on your SMTP server, this address may need to match the one you enter in the 
Username field – or it may not work unless you set up an email alias. Consult your SMTP server 
document for details about sending emails. 

See the following sections for more information on the From Email address for specific email programs: 

• For A/R Statements and Letters and for A/R and O/E invoices use the Accounting Documents 
Setup program to override the default From Email. 

• For Overdue Payment Reminders and Payment Due Alerts, use Overdue Payment Reminders 
Setup and Payment Due Alerts Setup to override the default From Email. 

You can also override the default From Email address when you resend documents from the Company 
window by specifying a new address in the Resend Documents window. 

For more details on emailing documents, see Step 13:  Add settings for emailing overdue payment 
reminders, and payment due alerts to customers and Step 14:  Add settings for emailing invoices, 
statements, letters to customers. 

Send Test Email:  Click this button to test email settings. The program will prompt you for an email 
address, and then send a test email.  

 

A number of different messages can appear depending on whether the test was successful. If the test 
fails, you should also check the log file – “C:\Users\<username>\AppData\Local\Temp\TaiRox CRM and 
Collections.log”. 

       

Note that you can send test emails to multiple recipients by separating the email addresses with commas 
or semicolons. 

Note regarding “Use SSL” if unsupported by the SMTP server  

If you select the “Use SSL” checkbox, CRM will first try to send a test email securely. If it does not 
succeed, it will try to send a test email insecurely. If the secure test fails, but the insecure test is 
successful, the program will display the following message. 

 

If this message appears, it means that: 

• Your SMTP server does not support current email communication styles on the port provided. 
(The "Use SSL" checkbox has different meanings for different email sending mechanisms.) 

• You should uncheck “Use SSL” to send emails without SSL protection. 
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Email Archive:  These settings determine where CRM and Collections stores emails sent to customers 
by the Send Invoices program, Overdue Payment Reminders program, and Payment Due Alerts program. 

Note that the actual locations for the Email Archive folders are not set on this screen 

Generic Documents Folder:  You specify the folder location on the Options > Document Folders tab.  

If you select this option, all emails sent to customers by the Send Invoices program, Overdue Payment 
Reminders program, and Payment Due Alerts program will be stored in the same folder. 

Company / National Accounts Documents Folder:  You also specify the location for this folder on the 
Options > Document Folders tab. 

This choice lets you store emails for each company and national account in a sub-folder identified by the 
Company ID or National Account number (from A/R) – along with company folders for cases, tracked 
invoices and other communications.  

You can drill down to this folder directly from CRM’s Company and National Account screens. 

Custom:  You specify the specific storage locations for invoice emails, overdue payment reminder 
emails, and payment due alert emails on the Settings tab for the Send Invoices Setup program, Overdue 
Payment Reminders Setup program, and Payment Due Alerts Setup program. 

This choice lets you store each type of email in a different location, and it lets you save the archived 
emails in subfolders organized by Year (ArchiveFolder\YYYY), Year and Month (ArchiveFolder\YYYYMM) 
or Year, Month, and Day (ArchiveFolder\YYYYMMDD).  

Note:  

• If you choose Generic folder, Company / National Account folder, or Custom, but do not specify 
folders for the locations you select, the emails will go to the  
       <shared data>\COMPANY\<companyID>\TaiRox CRM\Documents folder. 

• The Email Archive sections on the Send Invoices Setup screen, Overdue Payment Reminders 
Setup screen, and Payment Due Alerts Setup screen will be greyed out if you do not choose 
“Custom.”  

• If you change these settings in future, the program will store new emails in the new locations that 
you specify, but it will not move older emails to the new locations. You will have to manually move 
them if you want them stored in the new location. 

Calendar Tab 

 

Select which entities will updates user calendars:  Select the entities that you want to update users’ 
calendars when you change revisit dates and user assignments. You can update users’ calendars for 
changes to cases, opportunities, and tasks. 
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Note:  

• CRM and Collections does not send calendar files when tasks are generated by the Overdue 
Payment Reminders program. However, it will send calendar reminders when you change the 
revisit date or user for tasks generated by Overdue Payment Reminders. 

• “Opportunities” will not appear if you are running the Collections module without CRM.  

CRM and Collections generates .ics files when employees add or change revisit dates and user 
assignments for cases, opportunities, and tasks, and sends them to the “Email 1” address entered in 
Sage 300 for the assigned – and unassigned -- user. 

.ics files (iCalendar files) are plain text files containing the details for a calendar event or a to-do 
item. Typically, they are sent as attachments to emails that you can save to a calendar, such as the 
calendar in Outlook or the Google calendar.  

For more details on ics files and setting up users for receiving emails, see Appendix E: Updating 
Calendars with .ics Event Files. 

To set up TaiRox CRM and Sage 300 to send calendar event files you must also: 

• Add “Email 1” email addresses for all users in Sage 300 > Administrative Services > Users. 

TaiRox CRM and Collections sends calendar events to the Email 1 email address. 

• Add the settings for your email server on the Email tab in CRM and Collections > Setup > 
Options.  

• Use the Send Test Email button to test the email server settings. 

Document Folders Tab 

 

The Document Folders tab lets you organize sales and accounting documents and emails according to 
your company’s unique needs – and in any location accessible from the CRM and Collections server. 

Note:  

• You select the location for email storage for Overdue Payment Reminders, Payment Due Alerts, 
and Send Invoices on the Options > Email tab. You then specify the actual folders for the location 
on this tab – or using the Overdue Payment Reminders Setup program, Payment Due Alerts 
Setup program, and Send Invoices Setup program for each of these documents. 

• You can use UNC file paths to specify the archive folder (such as 
\\ComputerName\C$\SentEmails).  
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Generic Documents Folder:  This is the folder where emails from the Send Bulk Email program are 
stored, along with any documents that you drag and drop on the Documents grid and specify the Generic 
Documents folder. (EML files store the complete email, including attachments.) 

You can also store emails created by Overdue Payment Reminders, Payment Due Alerts, and Send 
Invoices programs in this location by selecting the “Generic Documents Folder” choice for Email Archive 
on the Options > Email tab. 

And this is the default location where other Send Documents programs store their EML files. The files are 
referenced in CRM as Communications.  

If you do not specify a Generic Documents folder, EML files will be should be stored in the Generic 
Documents folder will be stored in <shared data>\COMPANY\<company ID>\TaiRox CRM\Documents.  

Entity Documents Folders:  These are the folders where documents that are dragged and dropped onto 
companies, national accounts, cases, tracked invoices, communications, and opportunities are stored. 
(The Opportunity entry will not appear if you installed the Collections module without CRM.) 

You can also store emails created by Overdue Payment Reminders, Payment Due Alerts, and Send 
Invoices programs in the Company folder by selecting the “Company Documents Folder” choice for Email 
Archive on the Options > Email tab. 

The root folders for opportunity, case, communication, and tracked invoice documents can be located 
anywhere on the network, so, for example, cases, communications, and tracked invoices could be located 
on an Accounting server, and opportunities on a Sales server. 

 

In the example above, company documents are stored in the Documents\CompanyID folder, and 
documents for Cases, Communications, Tracked Invoices, and Opportunities are stored below that in the 
Cases, Communications, Opportunities, and TrackedInvoices subfolders.  

In the following example, company documents, national account documents, cases, tracked invoices, 
communications, and opportunities are top-level folders, with companies / national accounts below each 
one. 

 

If you do not specify a Company Documents folder, EML files that should be stored in the Company 
Documents folder will be stored in <shared data>\COMPANY\<company ID>\TaiRox CRM\Documents.  

If you use drag and drop to attach documents to companies, national accounts, cases, communications, 
opportunities and invoices, they are automatically copied to foders that you specify here. 
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Note:  Tracked Invoice documents include all documents attached to invoices using theTracked Invoices, 
Overdue Invoices, and Disputed Invoices program.  

In this example, all cases are stored in one folder, all communications are stored in another folder, and all 
opportunities are stored in a third folder, with subfolders for companies and folders below that for 
individual opportunities, communications, and cases.  

 

If you want, you can have  the root opportunity and case folders anywhere on the network, so, for 
example, cases could be located on an Accounting server, and opportunities on a Sales server. 

The document folder paths include the following variables for specifying folders with names for the 
Company ID, Case ID, Communication ID, Tracked Invoice ID, and Opportunity ID. 
 

Vaiable name Variable  Example – specification in Options and actual generated path 

Company ID (Collections) 

 

 

National Account No. (A/R) 

 

 

Case ID 

 

 

Communication ID 

 

 

Tracked Invoice ID 

 

 

Opportunity ID 

 

{COMPID} 

 

 

{NATACCT#} 

 

 

{CASEID} 

 

 

{COMMID} 

 

 

{ARINID} 

 

 

{OPPOID} 

 

\TaiRox CRM\Documents\{COMPID} 

\TaiRox CRM\Documents\COMP00003 

 

\TaiRox CRM\Documents\{NATACCT#} 

\TaiRox CRM\Documents\BARGAIN 

 

\TaiRox CRM\Documents\{COMPID}\Cases\{CASEID} 

\TaiRox CRM\Documents\COMP00003\Cases\CASE00009 

 

\TaiRox CRM\Documents\{COMPID}\Communications\{COMMID} 

\TaiRox CRM\Documents\COMP00003\ Communications\COMM00010 

 

\TaiRox CRM\Documents\{COMPID}\TrackedInvoices\{ARINID} 

\TaiRox CRM\Documents\COMP00003\TrackedInvoices\ARIN00015 

 

\TaiRox CRM\Documents\{COMPID}\Opportunities\{OPPOID} 

\TaiRox CRM\Documents\COMP00003\Opportunities\OPPO00082 

Note:  You can use the company ID variable for company document paths, case document paths, 
communication document paths, tracked invoice doument paths, and opportunity document paths.  

However, you cannot use the company ID variable for contact document paths because contacts do not 
have to belong to a company. 

Customer PDFs Tab 

Click the A/R and O/E Invoice and Credit Note Options buttons to choose the report and report options to 
use for generating A/R and O/E invoices and credit/debit notes attached to emails sent by the Overdue 
Payment Reminders program, Payment Due Alerts program, and Send Invoices program. 

• The A/R Invoice Options apply also to A/R Credit and Debit notes. 

• The “V/M” invoice and credit note buttons appear if you use Technisoft's Service Manager 
application for Sage 300. 
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Note:  The reports and options specified here are shared by the Overdue Payment Reminders program, 
Payment Due Alerts program, and the Send Invoices program, so the invoices generated by all three 
programs will match.  

 

Also note: 

• The Crystal Report form used for A/R and O/E invoices and CR/DR notes is set on this tab.  

By default, the program will browse to the AR\ENG or OE\ENG folder to let you choose the report 
for invoices.  

• Do not specify a path when you choose an invoice print form in CRM Options.  

 

If you are running a multi-lingual Sage 300 system, the Overdue Payment Reminders program, 
Payment Due Alerts program, and Send Invoices program will use the preferred customer 
language from the appropriate language folders. (This will not work if you include a path to a 
specific folder.) 

 

 

 

 

 

 
  



Setup and Maintenance Screens Overdue Payment Reminders Setup 

TaiRox CRM and Collections for Sage 300 193 User Guide 

Overdue Payment Reminders Setup 

These settings are used by the Overdue Payment Reminders program (in the Collections folder) to send 
overdue payment reminder emails to individual customers and national accounts with overdue invoices or 
create phone call tasks to followup on overdue accounts. 

To send overdue payment reminder emails you must also specify email addresses for overdue payment 
reminders on the Contacts tab for each company / national account record. 

 

Note: CRM uses the “Preferred Language” setting in the Company or National Account window to send 
overdue payment reminder emails and invoices to customers in English, French, or Spanish. See 
Appendix C for details. 

Settings Tab 

Overdue Payment Reminder Stages 

Days Overdue:  The default settings are standard aging buckets, but you can change the date ranges. 
CRM uses these aging buckets to assign overdue invoices to invoice stages when you click the Update 
button on the Overdue Payment Reminders form or Overdue Invoices form. See Overdue Payment 
Reminders for information on using the Overdue Payment Reminders program. 

Label:  You can change the labels used to describe each overdue invoice stage. Labels appear on the 
Overdue Payment Reminders form. 

Color:  Double-click the Color square to change the color used for each overdue stage on the Overdue 
Payment Reminders form. 

Action:  The program supports two actions: 

• Send Email – to send payment reminders using the selected email template to company or 
national account contacts when the customer’s oldest invoice reaches this overdue stage. 

• Create Task – to create a collections task for calling up a customer or national account contact 
when the customer’s oldest invoice reaches this overdue stage. 
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The Overdue Payment Reminders program performs the action specified for the oldest overdue invoice. 

Email Template:  Choose the default email message that you want to send to customers for each 
overdue invoice stage. You can edit the default template files or add your own.  

Note also that the “Format” setting on this tab determines whether only overdue documents, or all unpaid 
documents, are included in the table on overdue payment reminder emails.  

You can override the default email message templates specified here when you process overdue 
payment reminders.  

Note the following points regarding template locations: 

• During installation, the program copies the email templates to the following program directory: 

\<Sage300>\XQ61A\Templates\Overdue Payment Reminders  

• When you first activate CRM and Collections for a new Sage 300 company, the program copies 
the email templates to the following company directory 

C:\Sage300SharedData\Company\<companyID>\TaiRox CRM\Templates\Overdue Payment Reminders 

• The Setup program looks in the company directory for Overdue Payment Reminder templates: 

C:\Sage300SharedData\Company\<companyID>\TaiRox CRM\Templates\Overdue Payment Reminders 

You can get the most recent templates installed by program updates by clicking the “Install Current 
Templates” button. It will copy new templates from \XQ61A\Templates\Overdue Payment Reminders to 
the company folder.  

 

Note that the program will copy over the previous templates of the same name. You should 
rename templates that you are using to ensure they aren’t replaced. 

See Appendix C: Editing Email Templates for Send Invoices, Send Statements, Payment Due Alerts, 
and Overdue Payment Reminders for information on editing email templates and using templates that 
match the target company’s preferred language. 

Note that the Overdue Payment Reminders program uses the email template for the oldest invoice that’s 
overdue when it sends out overdue invoice payment reminders. So if you have an email that’s over 90 
days overdue, the program will send the email for the oldest overdue email stage (unless you change the 
default aging periods). 

The Template dropdown is greyed out if the action is Create Task. 

Preview:  Click the Preview button to view the body of the selected payment reminder email template. 

• If you use the Sage 300 National Accounts, the following popup will appear when you click the 
Preview button to let you view the email for company recipients or the email for national accounts. 

 

• The Preview button will use the default program for the file type that’s set up in Windows File 
Explorer. For example, the default program may be your internet browser. 

Attachments:  Click the Attachments button to add additional attachments to all of the overdue payment 
reminder emails – such as your policy on overdue accounts. 
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You can use “drag and drop” to add attachments, or click the Add button on the Attachments screen to 
search for attachments using Windows File Explorer. 

 

Minimum days overdue before creating an Overdue Payment Reminder:  Specify the default 
minimum number of days that an invoice must be overdue before marking it as an overdue invoice and 
creating a reminder email or phone call task.  

You can change this setting for individual customers in the Company window or National Accounts 
window. (For example, you may have customers that may have different payment terms.) 

Minimum number of days between Overdue Payment Reminders:  If you do not specify a minimum 
(e.g. 10 days), the program will let you create a new reminder each time you run Update and process 
payment reminders. This can result in customers getting reminders on two consecutive days, if you send 
out reminders daily, unless you specify a minimum number of days between reminders. 

You can also change this setting for individual companies or national accounts. 

Exclude customers with a credit balance:  Select this option if you do not want to send overdue 
payment reminders to customers that have credit balances. This setting applies to customer overdue 
payment reminders, not to payment reminders sent to national accounts. 

Format:  Select Overdue Invoices to only list overdue invoices, debit notes, and interest charges on 
overdue payment reminders, or select Account Summary to list all unpaid documents and unapplied 
credits. Use the Preview button to see the difference between Overdue Invoices and Account Summary 
formats. 

Email Subject:  Specify the subject line that you want to appear on all overdue payment reminder emails. 

From Email:  Specify the “From Email” address that you want to appear on overdue payment reminders. 

Reply-To Email:  You can also specify a different email address that will be used when recipients reply to 
your overdue payment reminder emails. 

Cc / Bcc:  Add email addresses in the Cc and Bcc fields to send copies (or blind copies) to other 
recipients in your company. To Cc or Bcc multiple recipients, separate the email addresses with commas 
or semicolons. 

Create a Communication When You Send an Email:  Select the “Create a Communication” checkbox 
to create a communication when overdue payment reminders are emailed to customers. Emails are 
stored as EML files, which include the email message and all attachments. 

Email Archive Folder:  You can specify a different archive folder for overdue payment reminders.  

Note:  This field will be greyed out unless you choose “Custom” for the Email Archive type on the  
Options > Email tab. You can also choose (on the Options > Email tab) to use the Generic Documents 
Folder or the Company Documents folder – which you specify on the Options > Document Folders tab.  
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If you choose “Custom” on the Options > Email tab, but do not specify a folder here, CRM will use the 
Generic Documents folder specified on the Options > Document Folders tab. If the Generic Document 
Folder path is blank, CRM will use <shared data>\COMPANY\<company ID>\TaiRox CRM\Documents. 

Organize Documents:  This dropdown lets you save archived overdue payment reminder emails in 
subfolders of the Email Archive Folder you specified above, organized by Year (ArchiveFolder\YYYY), 
Year and Month (ArchiveFolder\YYYYMM) or Year, Month, and Day (ArchiveFolder\YYYYMMDD). 

Notes On using Overdue Payment Reminders  

• You can turn off overdue payment reminders on the Company or National Accounts 
screen for customers. See the Company window and National Accounts window to change 
reminder settings for individual customers. 

• You specify the contacts that receive emails on the Contacts tab on the company screen 
and National Accounts screen. 

• For each company or national account, you can set the minimum days that a payment must be 
overdue before sending an overdue payment reminder, and you can set the minimum number of 
days between overdue payment reminders. 

• You can attach copies of overdue invoices to the emailed payment reminders. 

• You can change the email template specified here when you process reminder emails. See 
Overdue Payment Reminders. 

• Send emails that match each company’s preferred language. See Sending Emails and Invoices 
Using the “Preferred Language” Company Setting. 

Scheduling Tab 

The Scheduling tab provides the email and task assignment options that will be in effect when running 
Overdue Payment Reminders as a background Windows scheduled task. (These options also appear in a 
popup window when you click the “Create Overdue Payment Reminders” button when generating 
payment reminders interactively from the Collections folder.) See the CRM and Collections Scheduler 
User Guide for information on setting up Windows scheduled tasks. 

The substitution variables let you provide user information for emails when the program is run as a task. 
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Send Email settings:  Apply to any selected customers that have a Send Email action. 

• Select “Attach Copies of the Invoices” to include PDF copies of overdue invoices with emails. 

• Use the Variables values to provide the name, email address, and phone number that you want 
to appear in emails when the program is launched from a scheduled task. (Note that the actual 
task user may be the Sage 300 Admin user, but you may want emails to be from the Accounts 
Receivable manager.) 

Create Task settings:  These settings apply to any selected customers that have a Create Task action. 

 

• You can specify a user name in the Task options to assign tasks for this set of companies or 
national accounts to a single user.  

• Specify the number of days following run time that the call task should appear on the assigned 
user’s dashboard. 

• The “V/M” invoice and credit note buttons appear if you use Technisoft's Service Manager 
application for Sage 300. 

Exclude Customer settings:  Choose which customers to exclude from emails or tasks. 

 

Editing Overdue Payment Reminder Templates 

See Appendix C: Editing Email Templates for Send Invoices, Send Statements, Payment Due Alerts, 
and Overdue Payment Reminders for more information on editing email templates. 

Note that each recipient receives only one email per mailout. For example, the following HTML overdue 
payment reminder email – 4Delinquent.html – might be sent to customers whose oldest invoice payment 
is over 90 days overdue. 

  

Overdue Payment Reminder templates are ANSI text or HTML files that provide the contents of the 
reminder emails. Make sure that you use a plain text editor – like Notepad – to edit email templates. 

Template files must be saved in ANSI text format – not in a Unicode variant. You can check the format by 
opening the fie in Notepad and clicking File > Save As. The Encoding appears at the botton of the form. 
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The Overdue Payment Reminders Setup program looks for email template files in the following location: 

<SharedData>\COMPANY\<OrgID>\TaiRox CRM\Templates\Overdue Payment Reminders 

See Sending Emails and Invoices Using the “Preferred Language” Company Setting for more information 
on template folders. 
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Payment Due Alerts Setup 

Payment due alerts are email reminders sent to customers before a payment is due to remind them and 
encourage prompt payment. Overdue payments are not included in payment due alerts; they are handled 
by the overdue payment reminders program. 

Before you can send payment due alerts, you must also specify email addresses for overdue payment 
reminders on the Contacts tab for each company record. 

 

Note:  CRM uses the “Preferred Language” setting in the Company window to send overdue payment 
reminder emails and invoices to customers in English, French, or Spanish. See Appendix C for details. 

Settings Tab 

Number of days before due date to send a Payment Due Alert:  Specify the number of days before 
payments are due to send reminders. This number applies to the invoice that is closest to being due.  

Minimum number of days between Payment Due Alerts:  If you do not specify a minimum (e.g. 10 
days), the program will let you create a new alert each time you run Update and process payment due 
alerts. This can result in spamming customers. 

The Minimum number of days between Payment Due Alerts must be less than the Minimum number 
of days before the due date to send Payment Due Alerts. This ensures that an alert will be sent for 
each invoice before it becomes due. 

This means that it you run Payment Due Alerts daily, an alert will go out for each invoice with the 
number of days specified before the due date. 

Email Template:  Choose the default email message that you want to send to customers to remind them 
of invoice payments. You can edit the default template files or add your own – and you can override the 
default email message templates when you process payment due alerts.  

Note the following points regarding template locations: 

• During installation, the program copies the email templates to the following program directory: 

\<Sage300>\XQ61A\Templates\Payment Due Alerts  
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• When you first activate CRM and Collections for a new company, the program copies the email 
templates to the following company directory 

C:\Sage300SharedData\Company\<companyID>\TaiRox CRM\Templates\Templates\Payment Due Alerts 

• The Payment Due Alerts Setup program looks in the company directory for Payment Due Alerts 
templates. Template files must be stored in the following folder to be selected by the program. 

C:\Sage300SharedData\Company\<companyID>\TaiRox CRM\Templates\Payment Due Alerts 

You can get the most recent templates installed by program updates by copying the new templates from 
\XQ61A\Templates\Payment Due Alerts to the company folder. Make sure that your current templates 
have a different name from the templates installed by CRM and Collections. 

Preview:  Click the Preview button to view the body of the selected payment due alert email template. 

Note:  The Preview button will use the default program for the file type that’s set up in Windows File 
Explorer. For example, the default program may be your internet browser. 

Attachments:  Click the Attachments button to add additional attachments to all of the payment due 
alerts emails – such as your policy on overdue accounts. 

You can use “drag and drop” to add attachments, or click the Add button on the Attachments screen to 
search for attachments using Windows File Explorer. 

 

Email Subject:  Specify the subject line that you want to appear on all payment due alert emails. 

From Email:  Specify the “From Email” address that you want to appear on payment due alerts. 

Reply-To Email:  You can also specify a different email address that will be used when recipients reply to 
your payment due alert emails. 

Cc / Bcc:  Add email addresses in the Cc and Bcc fields to send copies (or blind copies) to other 
recipients in your company. To Cc or Bcc multiple recipients, separate the email addresses with commas 
or semicolons. 

Create a Communication When You Send an Email:  Select the “Create a Communication” checkbox 
to create a communication when payment due alerts are emailed to customers. Emails are stored as EML 
files, which include the email message and all attachments. 

Email Archive Folder:  This field lets you specify a different archive folder for payment due alerts.  
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Note:  This field will be greyed out unless you choose “Custom” for the Email Archive type on the  
Options > Email tab. You can also choose on the Options > Email tab to use the Generic Documents 
Folder or the Company Documents folder – both of which are specified on the Options > Document 
Folders tab.  

If you choose “Custom” on the Options > Email tab, but do not specify a folder here, CRM will use the 
Generic Documents folder specified on the Options > Document Folders tab. If the Generic Document 
Folder path is blank, CRM will use <shared data>\COMPANY\<company ID>\TaiRox CRM\Documents. 

Organize Documents:  This dropdown lets you save archived overdue payment reminder emails in 
subfolders of the Email Archive Folder you specified above, organized by Year (ArchiveFolder\YYYY), 
Year and Month (ArchiveFolder\YYYYMM) or Year, Month, and Day (ArchiveFolder\YYYYMMDD). 

Notes On using Payment Due Alerts 

• The program includes invoices on payment due alerts that are within the number of days before 
the due date that is set in Payment Due Alerts Setup. 

• Invoices will appear on only one payment due alert. After that, the program ignores them. 

• Invoices that are past the due date will not appear on a Payment Due Alert. 

• If you do not send payment due alerts frequently, some invoices could be skipped. 

• You can turn off alert emails on the Company screen for each customer. See the Company 
window to change settings for individual customers. 

• You specify the company contacts that receive emails on the Contacts tab on the 
company screen. 

• For each company, you can set the minimum number of days between payment due alerts.  

• You can attach copies of due invoices to the payment due reminder emails.  

• You can change the email template specified when you process reminder emails. See Payment 
Due Alerts. 

• You can send emails that match each company’s preferred language. See Sending Emails and 
Invoices Using the “Preferred Language” Company Setting. 

Scheduling Tab 

The Scheduling tab provides the email options that will be in effect when running Payment Due Alerts as 
a scheduled background task.  

See the CRM and Collections Scheduler User Guide for information on setting up Windows scheduled 
tasks for sending Payment Due Alerts. 

The substitution variables let you provide user information for email variables when the program is run as 
a scheduled task. 
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Send Email settings 

• Select “Attach Copies of the Invoices” to include PDF copies of invoices with emails. 

• Use the Variables values to provide the name, email address, and phone number that you want 
to appear in emails when the program is launched from a scheduled task. (Note that the actual 
task user may be the Sage 300 Admin user, but you may want emails to be from the Accounts 
Receivable manager.) 

Editing Payment Due Alert Templates 

See Appendix C: Editing Email Templates for Send Invoices, Send Statements, Payment Due Alerts, 
and Overdue Payment Reminders for more information on editing email templates. Note that each 
recipient receives only one email per mailout. 

Payment Due Alert templates are ANSI text or HTML files that provide the contents of the reminder 
emails. Make sure that you use a plain text editor – like NotePad – to edit email templates. 

Template files must be saved in ANSI text format – not in a Unicode variant. You can check the format by 
opening the fie in Notepad and clicking File > Save As. The Encoding appears at the botton of the form. 

 

The Payment Due Alerts Setup program looks for email template files in the following location: 

<SharedData>\COMPANY\<OrgID>\TaiRox CRM\Templates\Payment Due Alerts 

See Sending Emails and Invoices Using the “Preferred Language” Company Setting for more information 
on template folders. 
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Send Invoices Setup 

The Send Invoices program sends posted invoices to all recipients. You specify the company contacts 
that receive invoices on the Contacts tab on the company screen. 

Note: If you select A/R Invoices or O/E invoices for a company contact, the program will send that 
recipient A/R Invoices, O/E Invoices, and O/E CR/DR notes – as well as documents created by 
Technisoft’s Service Manager for Sage 300 (if you have it), and any A/R summary invoices created 
by other third-party programs for Sage 300. 

Before you can send invoices to recipients, you must also select email addresses for invoices on the 
Contacts tab for each company record. 

 

Note: CRM uses the “Preferred Language” setting in the Company window to send emails and invoices 
to customers in English, French, or Spanish with the Send Invoices program. See Appendix C for details. 

Settings Tab 

Email Template:  Choose the default email message that you want to send to customers with invoices. 
You can edit the default template files or add your own – and you can choose a different email message 
template when you run the Send Invoices program.  

Note the following points regarding template locations: 

• During installation, the program copies the email templates to the following program directory: 

\<Sage300>\XQ61A\Templates\Send Invoices  

• When you first activate CRM and Collections for a new company, the program copies the email 
templates to the following company directory 

C:\Sage300SharedData\Company\<companyID>\TaiRox CRM\Templates\Send Invoices 

• The Send Invoices Setup program looks in the company directory for Send Invoices templates. 
Template files must be stored in the following folder to be selected by the program. 

C:\Sage300SharedData\Company\<companyID>\TaiRox CRM\Templates\Send Invoices 

Preview:  Click the Preview button to view the body of the selected email template. 

Note:  The Preview button will use the default program for the file type that’s set up in Windows File 
Explorer. For example, the default program may be your internet browser. 
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You can get the most recent templates installed by program updates by copying the new templates from 
\XQ61A\Templates\Send Invoices to the company folder. Make sure that your current templates have a 
different name from the templates installed by CRM and Collections. 

Attachments:  Click the Attachments button to add additional attachments to all of the invoice emails – 
such as your policy on overdue accounts. 

You can use “drag and drop” to add attachments, or click the Add button on the Attachments screen to 
search for attachments using Windows File Explorer. 

 

Email Subject:  Specify the subject line that you want to appear on all invoice emails. 

From Email:  Specify the “From Email” address that you want to appear on invoice emails. 

Reply-To Email:  You can also specify a different email address that will be used when recipients reply to 
your emails. 

Cc / Bcc:  Add email addresses in the Cc and Bcc fields to send copies (or blind copies) to other 
recipients in your company. To Cc or Bcc multiple recipients, separate the email addresses with commas 
or semicolons. 

Create a Communication When You Send an Email:  Select the “Create a Communication” checkbox 
to create a communication when invoices are emailed to customers. Emails are stored as EML files, 
which include the email message and all attachments. 

Email Archive Folder:  This field lets you specify a different archive folder for invoice emails and 
attachments.  

Note:  This field will be greyed out unless you choose “Custom” for the Email Archive type on the  
Options > Email tab. You can also choose on the Options > Email tab to use the Generic Documents 
Folder or the Company Documents folder – both of which are specified on the Options > Document 
Folders tab.  

If you choose “Custom” on the Options > Email tab, but do not specify a folder here, CRM will use the 
Generic Documents folder specified on the Options > Document Folders tab. If the Generic Document 
Folder path is blank, CRM will use <shared data>\COMPANY\<company ID>\TaiRox CRM\Documents. 

Organize Documents:  This dropdown lets you save archived invoice emails in subfolders of the Email 
Archive Folder you specified above, organized by Year (ArchiveFolder\YYYY), Year and Month 
(ArchiveFolder\YYYYMM) or Year, Month, and Day (ArchiveFolder\YYYYMMDD). 

Notes On using Send Invoices 

• Invoices must be posted and unprinted to appear in an email run. 
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• You can turn off invoices on the Company screen for each customer. See the Company 
window to change settings for individual customers. 

• You specify the company contacts that receive emails on the Contacts tab on the 
company screen. 

• You can change the email template specified when you process emails. See Send Invoices. 

• You can send emails that match each company’s preferred language. See Sending Emails and 
Invoices Using the “Preferred Language” Company Setting. 

Scheduling Tab 

The Scheduling tab provides user settings that will be in effect when running Send Invoices as a 
scheduled background task.  

See the CRM and Collections Scheduler User Guide for information on setting up Windows scheduled 
tasks for sending invoices. 

 

Send Email Substitution Variables 

• Use the Variables values to provide the name, email address, and phone number that you want 
to appear in emails when the program is launched from a scheduled task. (Note that the actual 
task user may be the Sage 300 Admin user, but you may want emails to be from the Accounts 
Receivable manager.) 

Editing Send Invoices Templates 

See Appendix C: Editing Email Templates for Send Invoices, Send Statements, Payment Due Alerts, 
and Overdue Payment Reminders for more information on editing email templates. Note that each 
recipient receives only one email per mailout. 

Send Invoice templates are ANSI text or HTML files that provide the contents of the reminder emails. 
Make sure that you use a plain text editor – like NotePad – to edit email templates. 

Template files must be saved in ANSI text format – not in a Unicode variant. You can check the format by 
opening the fie in Notepad and clicking File > Save As. The Encoding appears at the botton of the form. 

 

https://www.tairox.com/downloads/crm/Scheduler%20User%20Guide.pdf
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The Send Invoices Setup program looks for email template files in the following location: 

<SharedData>\COMPANY\<OrgID>\TaiRox CRM\Templates\Send Invoices 

See Sending Emails and Invoices Using the “Preferred Language” Company Setting for more information. 
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Send Statements Setup 

The Send Statements program sends A/R statements to customers and national accounts. 

 

Note: The Send Statements program uses the “Preferred Language” setting in the Company and 
National Account windows to send emails and statements in English, French, or Spanish.  
See Appendix C for details. 

Settings Tab 

Email Template:  Choose the email message that you want to send to customers and national accounts 
with statements. You can edit the default template files or add your own. 

Note the following points regarding template locations: 

• During installation, the program copies the email templates to the following program directory: 

\<Sage300>\XQ61A\Templates\Send Statements  

• When you first activate CRM and Collections for a new company, the program copies the email 
templates to the following company directory 

C:\Sage300SharedData\Company\<companyID>\TaiRox CRM\Templates\Send Statements 

• The Send Statements Setup program looks in the company directory for Send Statements 
templates. Template files must be stored in the following folder to be selected by the program. 

C:\Sage300SharedData\Company\<companyID>\TaiRox CRM\Templates\Send Statements 

Preview:  Click the Preview button to view the body of the selected email template. 

Note:  The Preview button will use the default program for the file type that’s set up in Windows File 
Explorer. For example, the default program may be your internet browser. 
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You can get the most recent templates installed by program updates by copying the new templates from 
\XQ61A\Templates\Send Statements to the company folder. Make sure that your current templates have 
a different name from the templates installed by CRM and Collections. 

Attachments:  Click the Attachments button to add additional attachments to all of the statement emails 
– such as your policy on overdue accounts. 

You can use “drag and drop” to add attachments, or click the Add button on the Attachments screen to 
search for attachments using Windows File Explorer. 

 

Email Subject:  Specify the subject line that you want to appear on all statement emails. 

From Email:  Specify the “From Email” address that you want to appear on statement emails. 

Reply-To Email:  You can also specify a different email address that will be used when recipients reply to 
your emails. 

Cc / Bcc:  Add email addresses in the Cc and Bcc fields to send copies (or blind copies) to other 
recipients in your company. To Cc or Bcc multiple recipients, separate the email addresses with commas 
or semicolons. 

Create a Communication When You Send an Email:  Select the “Create a Communication” checkbox 
to create a communication when statements are emailed to customers or national accounts. Emails are 
stored as EML files, which include the email message and all attachments. 

Email Archive Folder:  This field lets you specify a different archive folder for statement emails and 
attachments.  

Note:  This field will be greyed out unless you choose “Custom” for the Email Archive type on the  
Options > Email tab. You can also choose on the Options > Email tab to use the Generic Documents 
Folder or the Company Documents folder – both of which are specified on the Options > Document 
Folders tab.  
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If you choose “Custom” on the Options > Email tab, but do not specify a folder here, CRM will use the 
Generic Documents folder specified on the Options > Document Folders tab. If the Generic Document 
Folder path is blank, CRM will use <shared data>\COMPANY\<company ID>\TaiRox CRM\Documents. 

Organize Documents:  This dropdown lets you save archived invoice emails in subfolders of the Email 
Archive Folder you specified above, organized by Year (ArchiveFolder\YYYY), Year and Month 
(ArchiveFolder\YYYYMM) or Year, Month, and Day (ArchiveFolder\YYYYMMDD). 

Scheduling Tab 

The Scheduling tab provides user settings that will be in effect when running Send Statements as a 
scheduled background task.  

See the CRM and Collections Scheduler User Guide for information on setting up Windows scheduled 
tasks for sending statements. 

 

Send Email Substitution Variables 

• Use the Variables values to provide the name, email address, and phone number that you want 
to appear in emails when the program is launched from a scheduled task. (Note that the actual 
task user may be the Sage 300 Admin user, but you may want emails to be from the Accounts 
Receivable manager.) 

Editing Send Statement Templates 

See Appendix C: Editing Email Templates for Send Invoices, Send Statements, Payment Due Alerts, 
and Overdue Payment Reminders for more information on editing email templates. Note that each 
recipient receives only one email per mailout. 

Send Statements templates are ANSI text or HTML files that provide the contents of the reminder emails. 
Make sure that you use a plain text editor – like NotePad – to edit email templates. 

Template files must be saved in ANSI text format – not in a Unicode variant. You can check the format by 
opening the fie in Notepad and clicking File > Save As. The Encoding appears at the botton of the form. 

https://www.tairox.com/downloads/crm/Scheduler%20User%20Guide.pdf
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The Send Statements Setup program looks for email template files in the following location: 

<SharedData>\COMPANY\<OrgID>\TaiRox CRM\Templates\Send Statements 

See Sending Emails and Invoices Using the “Preferred Language” Company Setting for more information. 
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Statement Profiles 

Statement profiles are a collection of settings that determine the type of statement that gets created as 
well as when the statement gets created and sent. Any company and national account that is to receive a 
statement must have selected a statement profile. 

Note: During initial activation CRM assigns the profile DEFAULT to companies and DEFAULTNA to 
national accounts. You should review the settings in the default profiles before running Send Statements 
for the first time. In particular, you must select a Schedule Code that determines when customers and 
national accounts using a profile receive their statement. 
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Notes: 

• The schedule determines the cutoff date (period end date) for the statements. 

• The run – or statement – date can be either the cutoff date or the day the statements are created. 

• The Run Type determines if the profile is for use by National Accounts or Customers. 

• The settings in the profile have the same effect as the same-named setting in the A/R Statements 
screen. 

• The Notes field can be up to 250 characters long. 
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Opportunity Stages 

Opportunity Stages is a maintenance program that lets administrators specify the stages of an 
opportunity. See Opportunities for information on using opportunities. 

Opportunity Stages will not appear if you are using the Collections module without CRM. 

CRM creates a default set of stages when you create the CRM database, but you can change the stages 
to suit your company. The opportunity stages should match the steps in your sales process.  

  

Notes: 

• The Sort Order determines the order for listing the opportunity stages in drop-down lists and 
charts. 

• When your CRM data is first activated, the following stages are created. You can add more 
stages, and change the order.  

o UNQUAL      (sort order 1) 
o QUALIFIED  (sort order 2) 
o MEETING  (sort order 3) 
o PROPOSAL (sort order 4) 

For example, you might add “NEGOTIATION” to the default set. 

• When an opportunity stage is marked Inactive, it will no longer be presented as an option when 
adding new opportunities. An inactive stage will continue to be displayed in grids and charts if 
present in the selected data.  

• The Notes field can be up to 250 characters long. 
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Case Stages 

Case Stages is a maintenance program that lets administrators specify the stages of collection, support, 
appointment, or other processes. See Cases for more information. 

Cases include a “Type” field, which can be Collections, Support, Appointment, or Other, and you can set 
the sort order for case stages to separate the stages by case type.  

For example, if you have collection cases only, your codes might look like this: “REMINDER”, 
“DEFAULTNOTE”, “DEMAND”, and “LEGAL”.  

However, if you have different types of cases, you might have codes like C1, C2, C3, and S1, S2, S3 – 
with appropriate descriptions for collection and support cases, and use the sort order to list collection 
case stages first in the Finder. 

All stages are user-defined. You do not have to use them. 

  

Notes: 

• The Sort Order is a number used for presenting data in the Finder and in drop-down lists and 
charts. 

In this example, the Finder on the Cases screen shows stages with sort order 1-9. The first stage 
listed is for an appointment, the next group shows collection stages, and the last group is for 
support issues. 

 

• When a case stage is marked Inactive, it will no longer be presented as an option when adding or 
updating cases. An inactive stage will continue to be displayed in grids and charts if present in the 
selected data.  

• You can use the notes to describe what action should be taken at each stage, who should be 
informed, etc. 

• The Notes field can be up to 250 characters long. Use it to describe what steps should be 
performed at each stage. 
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Communication Types 

Communication Types is a maintenance program that enables administrators to identify the different 
types of communications.  

 

Notes: 

• When data is activated, the following types are created: 

o EMAIL 
o FAX 
o MAIL 
o PHONE 
o TEXT 

• When a communication is marked Inactive, it will no longer be presented as an option when 
adding new communications. An inactive type will continue to be displayed in grids if present in 
the selected data.  

• The Notes field can be up to 250 characters long. 
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Territories 

Territories is a maintenance program that enables administrators to add the territories to which 
companies belong, and to specify which users have access to each territory.  

All new customer companies must be assigned to a territory when they are set up. The territory can be 
any that you imported from Sage 300 or added in CRM and Collections – or can be the default (blank) 
Territory.  

Note:  CRM and Collections restricts what a Sage 300 User can see based on the territories to 
which they belong.  

 

Options when using Territories: 

• CRM and Collections users can be granted a right to see company data for all territories. This is 
a switch in the User record that effectively turns off all restrictions based on territory for that user. 

• CRM and Collections users can be granted a right to see companies in any number of specific 
territories. There is no hierarchy of territories – this provides maximum flexibility. 

To assign a user to a territory 

• Add the user to Sage 300. 

• Add the user to CRM and Collections with the Users Setup program. 

o Select All Territories for the user in the Users Setup program, or add a list of Territories. 

OR 

o Select a territory in the Territories Setup program, and add users to the User tab. You can 
select All Territories for users that you add to User tab to grant them access to all territories. 
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Users 

The Users program presents a search field so you can immediately find users if you have more than one 
page. Double-click a row to open the user record. 

User must be added to CRM and Collections and assigned to territories – or all territories – before they 
can enter or view any company data. 

Note:  TaiRox CRM restricts what a Sage 300 User can see based on the territories to which they belong.  

 

To add a user to CRM and Collections 

• Click the Add button. 

• Click the Finder button on the User screen that appears. (see screen below) 

• Select the Sage 300 User from the Finder. 

• Click the Add button, then Close the User window. 

• Double-click the All Territories column to provide access to All Territories, or go to the Territories 
tab and click the Link button to add a list of territories to which the user has access. 

Notes: 

• A CRM and Collections user must first be added to Sage 300 as a user. 

• Users can be assigned to a list of territories, or they can be assigned to all territories. 

• The CRM and Collections user “ADMIN” is created when CRM and Collections data is activated. 
All other CRM and Collections users must be added with the Users program. 

• The Territories tab has a Link button for granting selected user access to one or more territories. 
The Unlink button removes that access. 
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User popup window for adding new users and viewing existing ones 

The User popup window lets you add Sage 300 users to CRM and Collections and edit existing users. 

      

Notes: 

• All CRM users must first be added in Sage 300 as Sage 300 users. 

• Individual Sage 300 users must then be added as CRM users before they can use CRM.  

• The Notes field can be up to 250 characters long. 

• The Optional Fields tab appears if you use the Optional Fields module and assigned optional 
fields to users. 

To Delete a User from CRM and Collections 

• Select the user in the grid on the Users tab. 

• Click the Delete button or press the Delete key. 

• You can view deleted users by right-clicking the Title bar on the grid and choosing Show Deleted. 

 

To Undelete a User from CRM and Collections 

• Use “Show Deleted” to see the deleted user. 

• Double-click the Deleted column for the user you want to undelete. 

 

• Confirm that you want to undelete the user. 

See Add, Delete, Link, Unlink and Change Log Buttons for more information on deleting and 
undeleting (restoring) records in CRM and Collections. 
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To Link a User to a Territory 

• Select the user from the grid on the Users tab, then select the Territories tab. 

 

• Click the Link button (or press the Insert key in the grid). 

• Enter the code for the territory, or use the Finder to select it.  

To Unlink a User from a Territory 

• Select the user from the grid on the Users tab, and click the Unlink button (or press the Delete 
key). 

• Users will no longer appear in the grid for this territory.  

See Also: 

Appendix A - Common Screen Operations for searching, sorting, tabs and common button explanations. 

Appendix B – Using Data Entry Programs for tabs and common button explanations. 
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Optional Fields 

Optional Fields is a maintenance program that lets administrators specify the optional fields that will 
appear on the Company, Contact, Opportunity, Case, User, Document and Communication screens.  

TaiRox optional fields are searchable, sortable and displayed in grids. For example, if you add a “sales 
rep” optional field to company records, you will see the “sales rep” field in the Companies window grid, 
and you can list companies in “sales rep” order or select all companies for a particular sales rep. 

You can also specify company optional fields to search for disputed invoices, overdue invoices, tracked 
invoices, and promised payments, allowing you to find items by “sales rep” (using our previous example). 

In addition, CRM and Collections synchronizes optional field values if optional fields for a company or 
national account are the same as the optional fields for an A/R Customer or national account. 

To use optional fields in CRM and Collections: 

• First, add optional fields to Sage 300 using Common Services > Optional Fields. You can also 
add values for a Finder list when you add the fields. 

• Second, add the Sage 300 optional fields to CRM and Collections using TaiRox CRM and 
Collections > Setup > Optional Fields. 

 

Notes: 

• If the list is empty, just click the Finder in the first column heading to select the new optional field 
from the list that appears. 

If the list already contains optional fields, click the Insert key, and then click the Finder to select 
the new optional field from the list. 

• Double-click the Value Set field to set a default value for the field. 

• Use the Finder in the Default Value field to select from values or enter a default value if no list of 
values exists. 

• When an optional field for a company or national account is the same as an optional field for an 
A/R Customer or national account, the Promote function (Promoting a Company to an A/R 
Customer) will copy this field to the A/R Customer's optional fields. 

• If you add an optional field to CRM and Collections that is already used for A/R customers or 
national accounts, the program will display a message stating that the optional fields match. You 
can click the Yes button to set the values for the new field to the values in A/R records. 
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Accounting Documents 

Accounting Documents is a maintenance program that lets administrators specify Email messages and 
various email options for Send Statement/Letters, Send A/R Invoices, and Send O/E Invoices. 

 

 
The Accounting Documents program lets you 
specify email messages for three programs in the 
Send Documents folder – Send Statements/Letters, 
Send A/R Invoices, and Send O/E Invoices. 

Access:  Open Setup > Accounting Documents. 

 

Name (of accounting document):  Select the document type from the “Name” dropdown for which you 
want to set up message and server settings – i.e. A/R Statement, A/R Letter, A/R Invoice, or O/E Invoice.  

Once you choose the document type, you can specify the properties and email message for this 
document type, as well as where to store copies of all sent emails. 

Note that this form does not apply to Overdue Payment Reminders, Payment Due Alerts or the Send 
Invoices program.  

Inactive Checkbox:  Select this checkbox if you do not want to email this document type. 

The “Inactive” checkbox lets you set up email settings and contact email addresses before activating the 
Send Documents feature.  

Specify the Email message settings for the currently selected accounting document: 

Note that the accounting documents on this form use the email server settings in CRM Options. This 
screen lets you change some of the information on the emails sent to customers. 

Reply To Email:  CRM lets you use a different Reply To address for each form. This allows 
customers to reply to different email addresses for statements, letters and invoices. The Reply To 
address overrides the “From Email” address specified on the Options form. 

Cc and Bcc:  Each form can also have different email addresses Cc’d or Bcc’d.  
To Cc or Bcc multiple recipients, separate the recipient email addresses with commas or semicolons. 
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Subject and Body:  Enter the subject and the content of your email. CRM adds information to the 
email from the customer record.  

• Click the Zoom button by the Subject and Body fields to insert customer-specific data, or press F9 
in the subject or body field. (F9 may not work in some versions of Windows or if using a VM.) 

 

The $INVOICE_NUMBER macro for A/R Invoices creates a comma separated list of invoice 
numbers in the subject line or email body. If you set the attachment limit to 1 – and you select 
“Create a separate PDF for each invoice” on the Send A/R Invoices form – the macro will list the 
single attached invoice.  

Note:  You can copy the default email messages from Sage 300 A/R Statements/Letters/ 
Labels, A/R Invoices, and O/E Invoices screens to CRM’s Accounting Documents screen.  

For example:  

 1. Select email recipients on the Contacts tab for each company (on the Company 
screen in CRM). 

 2. Open A/R Statements/Letters/Labels and select “Statement” or “Letter” as the 
document type. 

 3. Select “Customer” as the Delivery Method. 

 4. Click the Zoom button ( ) to the right of the Email Message field.  

 5. Highlight the body of the email, and press Ctrl-C to copy or right-click and choose 
Copy.  

 6. Select A/R Customer Statement at the top of the Accounting Documents form and 
paste the text into the email body (Ctrl-V or right-click and select Paste). 

Attachment Limit:  This setting controls the maximum number of attachments that can be included 
with an email. CRM will create additional emails if the maximum number of attachments is exceeded. 

When sending invoices, CRM sends a single email to each company contact with all invoices that 
meet the selection criteria attached. In some circumstances (if this number is too large) emails may 
be rejected because there are too many attachments. Senders have no way of knowing if an email is 
rejected for this reason. If you set the attachment limit for A/R invoices to 1, you must also select 
“Create a separate PDF for each invoice” on the Send A/R Invoices form to send 1 invoice per email. 

Notes:  Add any notes you like – such as when or why you last updated the email, why the 
accounting form is currently “Inactive,” etc.  The field is up to 250 characters long. 

Create a Communication When You Send an Email:  Select the “Create a Communication” 
checkbox to create a communication when documents are emailed to customers. 

Note:  This checkbox creates a communication for each contact that receives an email. See the 
next section for Selecting Recipients for Emailed Invoices, Statements, Letters, Payment 
Reminders and Payment Due Alerts. 



Setup and Maintenance Screens Accounting Documents 

TaiRox CRM and Collections for Sage 300 224 User Guide 

Email Archive Folder:  Specify a different archive folder for each document type. If you do not 
specify a folder, CRM will use the folder specified on the first tab in the Options form.   

If you do not specify a folder in the Options form, CRM will store EML files in the Sage 300 Shared 
Data folder under COMPANY\Company ID\TaiRox CRM\Documents. (EML files include the email 
message and all attachments.) 

Organize Documents:  This dropdown lets you save archived emails in subfolders of the Email 
Archive Folder you specified above, organized by Year (ArchiveFolder\YYYY), Year and Month 
(ArchiveFolder\YYYYMM) or Year, Month, and Day (ArchiveFolder\YYYYMMDD). 
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Select Recipients for Emailed Invoices, Statements, Letters, 
Payment Reminders, and Payment Due Alerts 

You use the Contacts tab in the Company window and National Accounts window to select the contacts 
that are emailed invoices, statements, letters, overdue payment reminders, and payment due alerts. 

To email statements, letters, and invoices to customers, you must: 

 1. Specify the “Customer” Delivery Method when you print Statements, Letters, or Invoices from 
CRM and Collections. 

  If the Print function’s Delivery Method is set to “Print Destination”, CRM will NOT send emails. 

 AND select the contacts that will receive the emails 

 2. Provide an email address for each A/R customer and national account and for the 
principle company / national account contact in the A/R Customer / A/R National Account 
record (or in TaiRox Collections’ Company or National Account record). 

  Choose Email (customer / national account) or Email (contact) as the Delivery Method on the 
Processing tab for each A/R Customer / National Account record. 

  TaiRox will use the email templates set up in the Accounting Documents Setup function for 
Send Statements/Letters, Send A/R Invoices, and Send O/E Invoices . 

  AND/OR 

  Select the documents sent to contacts for each company and national account on the 
Contacts tab on the CRM Company and National Account screens (or select the documents 
for contacts on the Companies and National Accounts tab in the Contacts window).  

   

Using Email or Contact’s Email addresses after you set up accounting documents: 

If the Delivery Method set on the A/R Customer or National Account Processing tab is Email (customer / 
national account) or Email (contact), CRM will send documents to that email address IN ADDITION TO all 
contacts selected for the document type on the Contacts tab in the Company or National Account 
window. 

• CRM will not create a communication if the Delivery Method for the A/R customer or national 
account is “Mail” and accounting documents are not set up (in Setup > Accounting Documents).  

• If you do not want to send to the customer or national account email addresses or contact email 
addresses specified in the A/R Customer and National Account records, specify “Mail” as the 
Delivery Method in A/R customer and national account records. 

• If you select Email (multiple contacts), you must also select the accounting documents for 
contacts on the Contacts tab in the Company and National Account windows (or select 
documents for contacts on the Companies / National Accounts tab in the Contacts window). 

How to Select Email Recipients on the Contacts tab for Each Company 

For each company or national account, select the email recipients for each document on the Contacts tab 
in the Company or National Account window. You can specify any number of recipients for each 
document from the list of company / national account contacts. 
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Send Statements, Letters, and Invoices:  TaiRox’s Send Documents features will email statements, 
letters and invoices to customers if their Delivery Method in the A/R customer / A/R national account 
record is set to Email (customer / national account), Email (contact) or Email (multiple contacts). It will 
also create a communication for statements, letters and invoices and attach it to the company / national 
account. 

If you select Email (multiple contacts), you must also select the accounting documents for each contact. 

XQ Payment Reminders:  You must select XQ Payment Reminders on the Contacts tab in the Company 
/ National accounts window for each Overdue Payment Reminders and Payment Due Alerts email 
recipient. 

Send A/R Invoices and O/E Invoices.  CRM and Collections’ Send Invoices program sends A/R and 
O/E invoices and CR/DR notes to all contacts if you select A/R Invoices and/or O/E Invoices in the 
Contacts grid. Essentially, if any of these flags is set, the program will send all receivables type 
documents. 

To Select Email Recipients for each company and national account 

• Select the company or national account in the CRM and Collections Companies or National 
Accounts window. 

• Choose the Contacts tab for the company or national account. 

• For each contact row, double-click the column for the document that you want to email.  

  

Hint:  Right-click the column headings in the grid and choose “Hide Most Columns” to easily view 
the contact names and the email forms (as shown above). You can reset the columns after 
selecting email recipients. 

 

• Note that the Send Documents programs will honor the A/R Delivery Method setting if Accounting 
Documents are not set up for a company or national account. This means that the programs will 
also print statements, letters and invoices if the delivery method is “Mail.” 

 

• If a company or national account no longer wants to receive emails, uncheck the recipients on the 
Contacts tab, as well as set the delivery method to “Mail” on the A/R account Processing tab. 
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Set Up Bulk Email Accounts 

The Bulk Email Accounts program stores email account information for sending bulk emails to customers. 
You must get an email account with a supported provider and enter the account information here before 
you can use the Send Bulk Email program in the Send Documents folder. 

Note:  

• Bulk Email Accounts will not appear on the Sage 300 Desktop if you are using the 
Collections module without CRM. 

• Bulk Email Accounts appears in the Marketing folder – not in Setup. 

TaiRox CRM also lets you send bulk emails using the SMTP email server specified in CRM > Setup > 
Options if you do not subscribe to a bulk email service. 

General steps for setting up bulk emailing with a bulk emailing service: 

1. Subscribe to MailChimp or SendGrid services (or other services supported by CRM and 
Collections) – or use the SMTP server specified in Setup > Options. 

2. Add bulk email service account information to CRM using the Bulk Email Accounts setup program 
in the Marketing folder. (This program is not in the CRM Setup folder.) 

3. Create contact groups in CRM for sending bulk emails. You can also choose email recipients by 
selecting ranges of CRM companies or ranges of A/R customer accounts.  

4. Log in to your bulk email service to: 

o Create email templates for bulk emails. 
o Create unsubscribe groups for each kind of emails that you send. 
o Associate your sending domain with the bulk email provider (if feature is available). 

etc. 

Subscriber features are dependent on the email service provider. 

5. Send test emails to a limited group of recipients. 

For more information on setting up email templates for bulk emails, see Appendix D: Sending Bulk Emails 
and Using Bulk Email Templates. 

Access:  Select TaiRox CRM and Collections > Marketing > Bulk Email Accounts. 
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To add account details for a bulk email account: 

• First, subscribe to an emailing service such as MailChimp and SendGrid and follow their 
instructions for getting a suitable API key for CRM program access.  

See Using CRM’s Send Bulk Emails Program, in Appendix D, for details. 

• Choose your subscription provider from the Provider dropdown list. CRM and Collections 
currently supports bulk emailing through MailChimp and SendGrid. More providers will be added 
in future.  

• Enter the API key supplied by your email provider. (You may have to generate it while logged in 
to the email provider’s website.) 

The Send BuIk Email program uses the API key to log in to the bulk email provider’s website 
when you perform a bulk email run.  

If you are creating the key, you must give it sufficient permissions to perform a bulk email run. For 
example, if you use SendGrid, the API key should have “Full Access”, which allows CRM to 
access GET, PATCH, PUT, DELETE, and POST endpoints within the selected permission. 

• You can enter any notes with the account record. 

For information on setting up email templates for bulk emails, see Appendix D: Sending Bulk Emails and 
Using Bulk Email Templates. 
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Import Productivity Tools Contacts from TaiRox Productivity Tools 

If you use TaiRox Productivity Tools and you have set up contacts in the TaiRox Extended Customers 
program, you can import your A/R contacts into CRM and Collections. Productivity Tools lets you add 
multiple contacts to Sage 300 A/R customers. 

The Import Prod. Tools Contacts program does not import contact information from Accounts Receivable 
customer records. 

Note:  This program will not appear in the CRM and Collections Setup Folder if you 
activated the Sage 300 Multiple Contacts module. 

See Appendix F: Exporting and Importing Companies, Contacts and Notes for information 
on importing contacts from other contact management programs. 

 

Notes: 

• Use “Import Prod. Tools Contacts” to import contacts from TaiRox Extended Customers when 
initially setting up the CRM data – using the Insert Only operation. You can also filter contacts 
belonging to specific customers if you want. 

• Operations include Insert Only, Update Only, and Insert and Update.  

• An option is provided for including inactive contacts or contacts for inactive customers. 

• Optional fields are not imported using this program. 
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Create Demo Data 

Create Demo Data quickly creates demonstration data from Sage 300 sample data or from a copy of a 
production database. The data is created relative to the Sage 300 session date. 

 

Important Notes: 

• Create Demo Data can only be run on databases with empty CRM and Collections tables. 

• Create Demo Data marks the database as “Demo”. In that state a warning message appears 
whenever the Sage 300 desktop is opened.  

 

• You can run Remove CRM Data on a database marked as Demo. Remove CRM Data will delete 
all CRM and Collections tables and deactivate the application, removing CRM and Collections 
entries from common services. 

Notes: 

• A key reason to create demonstration data is so that sales pipeline charts generated from 
opportunities will look meaningful.  

• A pseudorandom number generator (aka a deterministic random bit generator) is used to vary the 
data in a consistent way. This means companies will have no contacts, one contact or several 
contacts. The same holds true for other entity relationships. Dates will also be varied. 

• All demonstration data is created relative to the session date. Some data (e.g. created-on and 
modified-on dates) will be set to a value earlier than the session date ("the past"). 

• Opportunity stages and communication types are varied as might be expected in a typical 
pipeline. 

• Opportunities have special dates (expected-closed, revisit-on) that would normally be set to a 
value later than the session date (“the future”), unless the opportunity stage has been won or lost; 
in which case, these dates and the closed-on date will be in the past. 

• Contact names are created with various first and last name combinations so that searching will 
find more than one name in a search (e.g. same first name) and yet the first and last names will 
be different.  

• Optional fields are not created using this program. 
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A/R and M/T Integration are suspended in CRM Demo Data: 

Note that A/R and M/T Integration are suspended when you create CRM Demo Data. If you look in 
Setup Options, you will see that both “suspend integration” options are checked, as below. 

 

If you select Sync Contacts, Companies, or National Accounts, the following messages will appear. 

       

    Note that A/R and M/T Integration are suspended for your protection! 

Integration is suspended to ensure that CRM does NOT update the Sage 300 Multiple Contacts 
and Accounts Receivable data.  

If you created Demo Data with SAMLTD or SAMINC – or with a copy of your company database 
and want to see the results of A/R and M/T Integration, you can turn on integration in Setup 
Options.  

If you uncheck the “Suspend xx Integration checkboxes, the program will display a message like this: 
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Remove Demo Data 

Remove CRM Data quickly deletes all CRM and Collections tables and deactivates the application, 
removing CRM and Collections entries from Common Services.  

 

You must type YES – all uppercase – to enable the OK button. 

Important Notes: 

• Create Demo Data marks the database as "Demo". A warning message will appear whenever 
you open a Sage 300 demo database, stating that you are in Demo mode. 

• Remove CRM Data is the only way to exit Demo mode for that database. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

 

 
  



Setup and Maintenance Screens XQScheduler 

TaiRox CRM and Collections for Sage 300 233 User Guide 

XQScheduler 

The CRM and Collections Scheduler lets you create Windows scheduled tasks to automatically send 
Overdue Payment Reminders, Payment Due Alerts, and Invoices to customers as well as Statements to 
customers and national accounts. It also lets you update overdue payments in the Overdue Payments 
program grid. See the Scheduler User Guide. 

CRM provides two ways to send overdue payment reminders, payment due alerts and invoices to clients: 

• Interactively – using the Overdue Payment Reminders, Payment Due Alerts, and Send Invoices 
programs to select recipients and choose runtime options. 

• In the background using a Windows Scheduled Task – using the runtime settings on the 
Scheduling tabs for the Overdue Payment Reminders Setup program, Payment Due Alerts Setup 
program, and Send Invoices Setup program.  

See the Scheduler User Guide for instructions on creating Windows Scheduled Tasks.  

• Start the Scheduler and select User Guide from the Help menu. 

 

General steps for creating Windows Scheduled Tasks for overdue payment reminders and 
payment due alerts: 

• Enter default program settings using the Overdue Payment Reminders Setup, Payment Due 
Alerts Setup, and Send Invoices Setup programs. 

The Settings tabs for the setup programs include default settings for using the programs 
interactively or when launched by Windows scheduled tasks. 

The Scheduling tabs provide the email and task assignment options that are in effect when 
running the programs as scheduled tasks. Most of these options appear in a popup window when 
you run the programs interactively from the Collections folder. 

• Run the CRM and Collections’ Scheduler program and enter Sage 300 login settings and email 
notification information. 

• Save the XML parameter file for running Overdue Payment Reminders, Payment Due Alerts, and 
Send Invoices to the Shared Data Folder for your company.  

• Use the Create Scheduled Task button on the CRM and Collections Scheduler’s Settings tab to 
create a basic scheduled task. 

• Use the Start Task Scheduler button to open the Windows Task Scheduler and change security 
options to run the task whether the user is logged on or not. 

• Set the task to run with the highest privileges. 

The CRM and Collections Scheduler program creates a basic Windows scheduled task that points to the 
current XML path and name.  

Make sure that the Windows task points to the correct XML file. This is the most common error made by 
Sage 300 consultants not familiar with the Task Scheduler.  

Also, the task created by the CRM and Collections Scheduler will not run on a regular basis until you edit 
the task and provide Windows login credentials.  

https://www.tairox.com/downloads/crm/Scheduler%20User%20Guide.pdf
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Appendix A: Common Screen Operations 

Using Tabs, Search, Advanced Search, and Sorting 

Tabs display more information for the item selected in the first tab:  

When a row in the main display grid on the first tab is selected, clicking on another tab shows all of the 
entities that are linked to the selected entity. New entities can be added from those additional tabs.  

Contacts and documents can be linked to any entity (a many-to-many relationship). 

For example, select a company on the Companies tab, and then view all contacts, opportunities, etc. for 
the selected company on the other tabs. 

 

 

 

 

 

 

 

Search: 

Searching works "like an internet search engine".  

• Enter a single word (or part or a word) and press Enter or click the Search button to display all 
entities with that word in any text field.  

• Enter a second word to refine the search. The second word can also be in any text field – such as 
“black” and “los” for Ronald Black in Los Angeles. 

 

• Click the red X at the end of the Search field to remove search terms.    

Company search filter: 

On many screens you can filter your search with the Company field. 

 

• Click the Company Finder (shown above) and select the company you want.  

You can use the top Search field on the form to refine your search after selecting the company. 

• Click the red X in the Company field to remove the company filter. 

 



Appendix A: Common Screen Operations Using Common Buttons on CRM and Collections Forms 

TaiRox CRM and Collections for Sage 300 235 User Guide 

Advanced: 

To search by a specific value or range of values (e.g. a date range), use the Advanced Search 
capabilities.  

For some records – such as Opportunities – Advanced Search also lets you select subsets of these 
values, such as the opportunity status.  

 

Sorting:  

Each display grid for entities has an appropriate drop-down that lets you select the sort order.  

Hovering above the icon to the right of the drop-down will show "Ascending" or "Descending", the current 
order. Clicking on this icon will reverse the sort order. 

 

Navigation:  

Navigate through multi-page lists using the navigation icons, or enter the page number and tab out of the 
field. 

 

Drag the bottom of the window to enlarge it and increase the number of items displayed in the grid. The 
program will return you to the first page of items when you change the grid size. 

Using Common Buttons on CRM and Collections Forms 

Add  

Adds a new entity. You can also use the Insert key while in the grid. Or, on some forms, use the 

+ button. 

Delete 

Deletes the currently selected entity (after confirmation). The program displays *** DELETED *** 
on the entity record, and the Delete button on the record changes to “Undelete”.  
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You can also recover deleted entities in grids by double-clicking the Deleted column: 

Double-click the title bar on the grid, and select "Show Deleted" from the dropdown menu to 
display deleted entities, then double-click the deleted entity to restore it. 

 
 

See Add, Delete, Link, Unlink and Change Log Buttons for more information on deleting and 
undeleting (restoring) records in CRM and Collections. 

Link / Unlink / Promote 

Are used when two types of entities can be linked together. Promote is a special case of Link that 
connects a CRM Company to an A/R Customer. 

Unlink removes the link by deleting a row in the link table. 

"Show Deleted" will not show a deleted link, but the link can easily be re-added.  

Change Log 

Every change to every field in every key entity is logged. When viewing a change log, select a 
row in the top grid to display all changes in the bottom grid. 

In this example, the Opportunity Stage and Revisit Date have been changed by user KEITH, and 
the program has also updated the Modified By and Modified On values.  

 

You can double-click a row in the bottom grid to open a window for side-by-side comparisons. 
This is particularly useful for comparing Notes. 
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Appendix B: Using Data Entry Programs 

CRM and Collections data entry programs let you enter and edit data using familiar Sage 300 controls. All 
CRM records – such as companies, contacts, opportunities – include an ID that’s displayed beside the 
main entity name. The ID is a unique number, internally generated by CRM and Collections. 

Data for each record appears on tabs, similar to Sage 300 entry screens. For example, the Company 
maintenance program has tabs for the Optional Fields, Contacts, Opportunities, Documents, Cases, 
Notes, and Communications that are linked to the company. 

 

Click the Contacts tab to see the linked contacts for the company. If you have a large number of contacts 
attached to a single company, use the Search function to narrow down the contact list – as below. 

 

There are many ways to drill down to data from different locations. 

Add, Delete, Link, Unlink and Change Log Buttons 

Some or all of the following buttons will appear on each tab of a maintenance program. 

 

Add:  Lets you add new entries by popping up an entry form. 

Delete:  Deletes entries. Note that deleted entries are retained in the database and can be viewed by 

right-clicking the title bar on the grid and choosing "Show Deleted". 
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Double-click the “Deleted” column to restore the record (undelete it). 

 

When you view a deleted record, the program displays the word *** DELETED *** on the screen, and the 
“Delete” button at the bottom of the screen becomes an “Undelete” button, allowing you to restore the 
record: 

 

Click the “Undelete” button to restore the record. 

Link:  The same document can be linked to multiple entities of any type. Clicking Link adds a link to an 

existing document. It does not create a new document. 

Unlink:  A link to a document can be removed. This removes the link by deleting a row in the link table. 

"Show Deleted" will not show a deleted link (the link can be easily re-added). 
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Appendix C: Editing Email Templates for 
Send Invoices, Send Statements, Payment 
Due Alerts, and Overdue Payment 
Reminders 

Template Locations on Sage 300 Servers  

The CRM and Collections installation program installs eight email templates for the Overdue Payment 
Reminders program and two templates each for the Payment Due Alerts program, Send Invoices program 
and Send Statements program in the Templates subfolder for the CRM and Collections application: 

\<Sage300>\XQ61A\Templates\Overdue Payment Reminders  
\<Sage300>\XQ61A\Templates\Payment Due Alerts  
\<Sage300>\XQ61A\Templates\Send Invoices 
\<Sage300>\XQ61A\Templates\Send Statements 

 

When you activate CRM and Collections for a new company, activation also copies the email templates to 
the following company-specific folders – so they are available to the Overdue Payment Reminders Setup, 
Payment Due Alerts Setup and Send Invoices Setup programs. 

C:\<Sage300SharedData>\Company\<companyID>\TaiRox CRM\Templates\Overdue Payment Reminders 

C:\<Sage300SharedData>\Company\<companyID>\TaiRox CRM\Templates\Payment Due Alerts 

C:\<Sage300SharedData>\Company\<companyID>\TaiRox CRM\Templates\Send Invoices 
C:\<Sage300SharedData>\Company\<companyID>\TaiRox CRM\Templates\Send Statements 

• Email templates must be in the correct company folders to be selected by the Overdue Payment 
Reminders, Payment Due Alerts Setup, Send Invoices Setup and Send Statements Setup 
programs.  

• You can also add French and Spanish versions of email templates in language-specific 
subfolders, such as the following: 

C:\<Sage300SharedData>\Company\<companyID>\TaiRox CRM\Templates\Send Invoices\FRA 

Templates in language subfolders are used according to the “Preferred Language” setting for 
companies. See Sending Emails and Invoices Using the “Preferred Language” Company Setting 
in this appendix for details. 

If you are updating CRM and Collections, you can copy any new templates for Overdue Payment 
Reminders and Payment Due Alerts from the program folders to the \Company\<companyID>\TaiRox 
CRM\Templates\ folders.  

Include tairox-logo.png when you copy new sample emails to your sample data and company folders. 
New email templates include an embedded logo – see Adding a Logo for more information. 
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For Overdue Payment Reminders, you can click the “Install Current Templates” button on the Overdue 
Payment Reminders Setup screen to copy new templates from \XQ61A\Templates\Overdue Payment 
Reminders to the company folder.  

 

Note that the program will copy over the previous templates of the same name. You should rename 
templates that you are using to ensure they aren’t replaced. 

The email templates provide the body text for emails. The subject, email sender, Cc and Bcc addresses 
come from the Overdue Payment Reminders Setup program, Payment Due Alerts Setup program, Send 
Invoices Setup program and Send Statements Setup program.  

The sample email templates include one HTML email and one text-only email template for each of the 
four aging stages used by the Overdue Payment Reminders program and one HTML email and one 
text-only email template for the Payment Due Alerts program, Send Invoices program and Send 
Statements program. 

By default, programs use HTML versions of the default templates. You can change the selection 
using Overdue Payment Reminders Setup, Payment Due Alerts Setup, Send Invoices Setup and 
Send Statements Setup.  

The following screen shows the email header fields on the Overdue Payment Reminders Setup screen for 
Overdue Payment Reminders. 

 

Important Information Message if Templates Have Significantly Changed  

The message may be different in later versions of CRM and Collections. 

For example, as of September 2020, this message appears when you click the Process Overdue 
Payment Reminders button if any payment reminder templates – or if the email subject line – included a 
$DOCUMENT macro.  

  

In June 2023, we dropped the deprecated macros starting with $DOCUMENT_. They can no longer be 
used with payment due alerts or with overdue payment reminders. 

In September 2020, we added the $OVERDUE_INVOICES macro to insert a table with all overdue 
invoices into payment reminder emails. See the list of macro variables later in this appendix. 
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To cancel the mailout and update your email templates, click the cancel button. 

Note:  The email subject, from email address, reply-to email, Cc and Bcc fields are set in the 
Overdue Payment Reminders Setup, Payment Due Alerts Setup, Send Invoices Setup and Send 
Statements Setup programs. 

HTML and Text-Only Email Templates 

CRM and Collections provides a company and a national account HTML email and text-only email 
template for each of the four aging stages used by the Overdue Payment Reminders program, and 
provides one HTML email and one text-only email template for the Payment Due Alerts program, the 
Send Invoices program and the Send Statements program.  

You select the default email templates that you want to use in the Overdue Payment Reminders Setup 
and Payment Due Alerts Setup, Send Invoices Setup and Send Statements Setup programs. You can 
override the default templates at runtime. 

        

• Email templates must have an “html” or a “txt” extension and must be in the following directories 
in order to be selected.  

C:\<Sage300SharedData>\Company\<companyID>\TaiRox CRM\Templates\Overdue Payment Reminders 
C:\<Sage300SharedData>\Company\<companyID>\TaiRox CRM\Templates\Payment Due Alerts 
C:\<Sage300SharedData>\Company\<companyID>\TaiRox CRM\Templates\Send Invoices 
C:\<Sage300SharedData>\Company\<companyID>\TaiRox CRM\Templates\Send Statements 

• Click the Preview button to see how the email will appear to recipients. 

The following example illustrates the main difference between the HTML and text-only email 
templates – where the HTML template displays overdue invoices in a formatted table, the text-
only template lists the invoice details vertically. 
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• The Preview button opens the email template using the default program for the file type that’s set 
up in the Windows File Explorer. 

• If you use the Sage 300 National Accounts, the following popup will appear when you click the 
Preview button to let you view the email for company recipients or the email for national accounts. 

 

Editing Email Templates 

Email templates for payment due alerts, overdue invoice reminders and the Send Invoices program are 
ANSI text or HTML files that provide the body of the emails. Use a plain text editor – like NotePad – to 
edit the text and HTML email templates. Do not use an editor that might change the file format and insert 
hidden formatting. 

Note that reminder emails for payment due alerts list ALL due invoices and emails for overdue payment 
reminders list ALL overdue invoices for each company (unless the invoices are on hold) – so each 
recipient receives only one email per mailout.  

Templates for payment due alerts and overdue invoice reminders can also include macros that lists all 
pending or overdue invoices and invoice amounts for the company: 

• $INVOICES  lists all not-yet-due invoices on payment due alerts emails. 

• $OVERDUE_INVOICES  lists all overdue documents – or all unpaid documents -- on overdue 
payment reminder emails, depending on whether you choose the Overdue Invoices format or the 
Account Summary format from the Format dropdown on the Overdue Payment Reminders Setup 
screen. 

• $AGING_TABLE  displays overdue amounts for the standard aging periods – 30, 60, 90, and 
over 90 days – and current amounts if you choose the Account Summary format for documents. 

The Overdue Payment Reminders program uses the email template for the oldest overdue invoice – 
unless the aging period is set to generate phone call tasks instead of send email reminders. 

For example, the following HTML overdue payment reminder email – 4Delinquent.html – might be sent to 
customers whose oldest invoice payment is over 90 days overdue. 

Note that this example lists overdue invoices only. You can change the Format setting in the Overdue 
Payment Reminders Setup screen to display all unpaid documents instead. See Overdue Payment 
Reminder Setup.  
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• The image on the left shows what you see when you click the Preview button. 

• The image on the right shows the email in a text editor – in this case, NotePad++. 

• The $CUSTOMER_CONTACT macro displays the contact name in the email. 

• $OVERDUE_INVOICES generates the first table shown above, with invoice information for all 
overdue invoices that are not on hold – or for all outstanding documents (depending on the 
Format setting on the Overdue Payment Reminder Setup screen). 

• $AGING_TABLE generates the second table, showing overdue or outstanding amounts by aging 
period. 

• $INVOICES is used for payment due alerts to list all due invoices instead of overdue ones. 

• The $USER macro inserts information for the user generating the emails. 

Template files must be saved in ANSI text format – not in a Unicode variant. You can check the format by 
opening the fie in Notepad and clicking File > Save As. The Encoding appears at the botton of the form. 

 

The CRM and Collections Setup programs look for email template files in the following locations. You 
must put all templates that you want to use in these locations, and then select them using the Setup 
programs. 

<SharedData>\COMPANY\<OrgID>\TaiRox CRM\Templates\Overdue Payment Reminders  
<SharedData>\COMPANY\<OrgID>\TaiRox CRM\Templates\Payment Due Alerts 
<SharedData>\COMPANY\<OrgID>\TaiRox CRM\Templates\Send Invoices 
<SharedData>\COMPANY\<OrgID>\TaiRox CRM\Templates\Send Statements 

Macro Variables in Email Templates 

You can use the following variables in email templates. Note that templates for the Send Invoices 
program can include the Customer Information and User information but not Document Information. You 
can also include most variables (except ones that generate a table) in the email subject. 
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Company and Customer / 
National Account Information  

Document Information User  
(Sage user account information) 

Sage Company Profile Info 
$COMPANY_PHONE 

$COMPANY_FAX 
$COMPANY_CONTACT 
$COMPANY_NAME 
 

A/R Customer / Nat Acct Info 
$CUSTOMER_NUMBER 
$CUSTOMER_NAME 
$CUSTOMER_CONTACT 
$CUSTOMER_BALANCE 

For Payment Due Alerts 
$INVOICES – for payment due alerts. 
Lists all not-yet-due invoices for the 
company: 
− Document number 
− Document date 
− Document amount 
− Due date 
− Balance 

For Overdue Payment Reminders 
$OVERDUE_INVOICES – for overdue 
payment reminders. Lists all overdue 
invoices or all unpaid invoices for the 
company (depending on the format): 
− Document number 
− Document date 
− Document amount 
− Due date 
− Balance 
− Days overdue 

$AGING_TABLE –amount for each aging 
period defined in CRM Options 
(including “Current” if using the 
Account Summary format) 

$OVERDUE_AMOUNT – total balance of 
overdue amounts in table 

$OVERDUE_DAYS – most overdue inv. 
$AS_OF_DATE – system date when the 

overdue payment data was updated 
$FORMAT – displays "Account Summary" 

or "Overdue Invoices" depending on 
the options setting for reminders  

$USER_NAME 
$USER_PHONE 
$USER_EMAIL1 
$USER_EMAIL2 

− Inserts the user information for the 
user account generating the 
overdue payment reminders. 

 

Current Date 
$TODAY 
 

For Statements 
$CUTOFF_DATE 
$RUN_DATE 

The sample email shown previously: 

• Includes the Customer Contact name in the greeting.  

Emails can be sent to multiple contacts at each company, but the $CUSTOMER_CONTACT 
macro retrieves the main contact name from the customer or national account record. You may 
want to use the $CUSTOMER_NAME in the greeting if you are sending to multiple contacts. 

• Includes $OVERDUE_INVOICES. This macro expands to include all overdue invoices – or all 
unpaid documents – listing the invoice #, date, amount, due date, current balance outstanding, 
and days overdue.  

Example of a table if you choose Overdue Invoices as the Format in Overdue Payment 
Reminders Setup. 

 
o On Hold invoices will not appear in the list of overdue invoices. 

Example of table if you choose Account Summary as the Format in Overdue Payment Reminders 
Setup. 

 

The $INVOICES macro for payment due alerts is similar, but does not have a “Days Overdue” 
column. 
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• $AGING_TABLE generates the second table, showing overdue amounts by aging period. A 
“Current” period will appear if you choose the Account Summary format in Overdue Payment 
Reminders Setup. 

• The signature line of the letter shown above includes the $USER_NAME only, because the other 
$USER information is missing from the user record. 

Note that the user information is for the logged-in Sage 300 user that is running the Overdue 
Payment Reminders program. You may want to substitute a single company representative, 
email address, and phone number for these macro variables.  

• Note that $DOCUMENT variables are no longer valid. Previously, these variables listed the 
details of the OLDEST overdue invoice. They can no longer be used with payment due alerts or 
with overdue payment reminders. 

Embedded CSS and Table Formatting in HTML Email Templates 

The header information in the sample email templates sets the font style, font size, and grey background 
for the overdue invoices table. Do not edit this section unless you are very familiar with HTML. 

 

The body of the email is set up as a series of tables, with each paragraph in a table cell. Do not change 
the email structure unless you are familiar with HTML. We suggest that you just edit the text in each cell. 

You can preview your email templates using a browser, then by using the Preview button in the Overdue 
Payment Reminders Setup, Payment Due Alerts Setup, and Send Invoices Setup programs after you 
copy the edited file back to the correct SharedData folder and select it in the Setup program. 
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Adding a Logo 

The sample email templates installed by CRM and Collections include an embedded logo to illustrate how 
you can add your own logo to Overdue Payment Reminders, Payment Due Alerts, and Invoice emails. 

Here is an email template loaded in a browser, showing the company logo at the top: 

 

And here is the HTML segment for the embedded logo: 

 

Note:  

• The image is embedded in a table at the top of the email. 

• The image files must be located in the same folder as the template. 

• Don't use any special characters in the filenames. 

• You can enclose the filename in quotes or apostrophes in the html template. 
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Sending Emails Using the “Preferred Language” Company Setting 

TaiRox Collections provides multi-language support for sending emails from the Overdue Payment 
Reminders, Payment Due Alerts, Send Invoices, and Send Statement programs. 

 

You select a company’s preferred language on the Company screen (shown above) and on the National 
Accounts screen, along with other options for sending overdue payment reminders for companies and 
national accounts, and payment due alerts and invoices for companies.  

TaiRox CRM and Collections provides support for English, French, and Spanish language preferences. 
The program will send emails in the selected language, and will also provide translated versions of 
attached invoices. 

Here are the steps for sending French or Spanish emails with translated invoice attachments: 

• Install the Sage 300 language files for French and/or Spanish to send emails and invoices in the 
target languages.  

• Select the Preferred Language for all customers and national accounts that should receive 
French or Spanish emails. 

• Add the English versions of your email templates to the default templates folders for overdue 
payment reminders, payment due alerts, invoices, and statements.  

• Create FRA and ESN subfolders for the translated versions of your email templates. 

• Add the French and Spanish versions of your email templates to the default templates folders for 
overdue payment reminders, payment due alerts, invoices, and statements. 

o The translated templates must have the same names as the English versions in the root 
folders. 

o You must also include any image files for the emails in the language subfolders. 

The following screen shows the root template directory for the Send Invoices program, with html and 
text versions of the template, along with a picture file for the logo that appears in the email. 
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The screen also includes two subfolders for Spanish and French versions of the email templates. 

Note the following points: 

o When you select a template using Setup program for Overdue Payment Reminders, Payment 
Due Alerts, Send Invoices or Send Statements, the program looks for html or txt files in the 
root folder for Overdue Payment Reminders, Payment Due Alerts, Send Invoices or Send 
Statements root folder. For example: 

\Sage300\SharedData\Company\<ORGID>\TaiRox CRM\Templates\Send Invoices 

The dropdown that you use to select a template file will not display template files that are in 
the language subfolders.  

o When you run the Send Invoices program (for example), the program will check the preferred 
language code for each customer, look for the appropriate language subfolder, and, if it 
exists, look for a template that matches the selected email template name.  

If the template does not exist in the language subfolder, the program will use the English 
template file in the “…\Templates\Send Invoices” root folder. 

In other words, you must create the language-specific versions of your template using the same 
template names and copy them to the appropriate language subfolder where the program can 
find them.  

The contexts of the language subfolder will look like this – with similarly-named *.html, *.txt and 
image files: 

 

In this case, the French-language version has all the same files as the default English folder – 
including the logo file. 
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Also Note: 

o The subject line for the email comes from the setup programs for Overdue Payment 
Reminders, Payment Due Alerts, Send Invoices, and Send Statements. It does not get 
translated. 

o The Crystal Report form used for A/R and O/E invoices and CR/DR notes is set on the 
Customer PDFs tab in CRM Options.  

By default, the program will browse to the AR\ENG or OE\ENG folder to let you choose the 
report for invoices. When you run the program, it will select the preferred customer language 
from the language folders.  

o Do not specify a path when you choose an invoice print form in CRM Options.  

 

o Column titles in tables will be translated to French and Spanish – the two other languages 
supported by CRM and Collections. 

o If you are inserting an image in your email – such as the logo – it must be copied to the 
language folder with the email template. 

Previewing Translated Email Templates 

The Preview buttons for Overdue Invoice Reminders, Payment Due Alerts, Send Invoices, and Send 
Statements work as follows: 

• If the template preview is for a specific customer – such as when you select a customer in the 
Overdue Payment Reminders or Payment Due Alerts grid and click the Template column heading 
– the program will display the email for the customer’s preferred language (if the email template 
exists).  

 

• If the template preview is not for a specific customer – such as when you click the Preview button 
on the Send Invoices screen or on the setup screens for Overdue Payment Reminders, Payment 
Due Alerts, and Send Invoices – the program will display the email template that matches the 
Sage 300 user’s language setting.  

So, if you are running Sage 300 in French, the program will preview the French email template. 
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Appendix D: Sending Bulk Emails and 
Using Bulk Email Templates  

TaiRox CRM and Collections provides several ways to send mass email messages to contacts using 
mass emailing programs such as MailChimp, SendGrid, or Swiftpage.  

• Upload a contact list to your bulk mail account and use it to send out emails. 

o Export a selection or group of contacts – or all contacts belonging to a communication. 
o Upload the contact file to MailChimp, SendGrid, or Swiftpage websites. 
o Send emails to all contacts on the uploaded list. 

The contact must have an email address, first and last name, must consent to receiving emails 
(set on the Contact screen), and not be inactive or belong to an inactive or deleted company. 

• Use CRM’s Send Bulk Email program to send personalized emails to selected contact 
groups, CRM companies’ contacts, or A/R customers’ contacts. 

Using a bulk email provider to send emails: 

o Create email templates and unsubscribe groups using the facilities on your bulk email 
provider’s website. 

o Run the Send Bulk Email program to send out bulk emails from your provider, using the 
program to select the email template, unsubscribe list, and set of email recipients. 

Sending bulk emails directly from CRM: 

o Optionally create email templates for use with the Send Bulk Email program – such as 
company information letters or newsletters. 

o Run the Send Bulk Email program to send bulk emails from CRM using an email template 
stored on your server or directly adding the email text and specifying the email recipients. 

The Send Bulk Email option is available with CRM and Collections. It is not included in the stand-
alone Collections module from TaiRox Software. 

This appendix describes the process for sending emails using both methods. 

Exporting Contacts and Uploading a Contact List 

In order to export and upload contacts to a bulk email provider, each contact must have an email address, 
a first and last name, must consent to receiving emails (this is a checkbox on the Contact screen), and 
not be inactive or belong to an inactive or deleted company. 

You can export a list of contacts using any of the following methods: 

• Export all filtered contacts from the Contacts program using the File > Export function. 

• Export all contacts belonging to a Contact Group from the Contact Groups program by clicking 
the Export Contacts button at the bottom of the Contact Group record... 

 

…or by clicking the Actions button ( ) at the top of the screen beside the Name field and 
choosing Export to MailChimp or Export to Swiftpage.  

  

• Export all contacts belonging to a Communication from the Communications program by 
clicking the Export Contacts button. 
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Choose MailChimp or Swiftpage 

The Export function lists two email options – MailChimp and Swiftpage. 

 

The MailChimp format includes just 3 fields: Email Address, First Name and Last Name. This format can 
also be imported into Swiftpage or other services.  

The Swiftpage format includes many other fields that could be used for more complex communications. 
These fields will need to be remapped when importing into Swiftpage. The Swiftpage remapping input will 
look something like this: 

 

Using CRM’s Send Bulk Email Program 

The Send Bulk Email program lets you send emails using a bulk email provider or using the email server 
specified in CRM Options. 

You can also use templates from your email provider’s site, or add the email subject and body on-the-fly. 

To Set Up Bulk Emailing with a bulk email provider: 

1. Subscribe to MailChimp or SendGrid services (or other services supported by CRM and 
Collections). You can also set up and use the email server that is specified in CRM Options. 

2. Add bulk email service account information to CRM using the Bulk Email Accounts setup program 
in the Marketing folder. (The Marketing folder does not appear in TaiRox Collections.)  
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3. Create contact groups in CRM for sending bulk emails. You can also choose email recipients by 
selecting ranges of CRM companies or ranges of A/R customer accounts.  

4. Log in to your bulk email service to: 

o Create email templates for bulk emails. 
o Create unsubscribe groups for each kind of email that you send. 
o Associate your sending domain with the bulk email provider (if feature is available). 
o Create customer surveys. 

Features are dependent on the email service provider. 

5. Send test emails to a limited group of recipients. 

Using the Email Server Specified in CRM Options 

This is an ideal option if you do not have a bulk email provider or if you are sending an email to just a few 
recipients. 

To send the email, you just: 

• Select the “Email Server set up in Options)”. 

• Enter a “From” email address and name. 

• Select recipients by choosing the contact group, contacts for a range of companies, or contacts 
for a range of A/R customers. 

• Enter the subject and body of an email directly on the Send Bulk Email screen, or choose an 
email template stored on the Sage 300 server. 

See Editing Payment Due and Overdue Reminder Templates for general information on editing 
email templates. Note that substitution variables are not supported in bulk email templates. 

• Select attachments for the email and optional fields for the communication it creates. 

• Click the Send button to send. 

Send Bulk Email is ideal for sending out a new price list to contacts or letting customers know that their 
sales rep has changed. 

Using a Bulk Email Provider 

The Send Bulk Email program lets you send emails through a bulk email provider using templates and 
unsubscribe lists from the email provider’s site. 

To send the email: 

• Select the “Bulk Email Provider”. 

• Select the email template stored on the bulk email provider’s site. 

• Select the unsubscribe list that matches the email you are sending. 

• Enter a “From” email address and name. 

• Select recipients by choosing the contact group, contacts for a range of companies, or contacts 
for a range of A/R customers. 

• If you are not using a template, enter the subject and body of an email directly on the Send Bulk 
Email screen. 

• Select attachments for the email and optional fields for the communication it creates. 

• Click the Send button to send.  
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Using your Provider’s Bulk Email Templates and Unsubscribe Lists 

Send Bulk Email lets you select a bulk email template and an unsubscribe group set up on your provider’s 
website. Using multiple templates and unsubscribe lists, you can: 

• Send on-brand HTML newsletters viewable through a browser and employ a newsletter 
unsubscribe list so users can stop receiving newsletters. 

• Send business announcements with a business announcements unsubscribe list – to announce 
address changes, salesperson changes, etc. 

• Send promotional emails using a PROMOTIONS unsubscribe list. 

• Send informational emails, attach price lists, and use a different unsubscribe list. 

• Take advantage of other provider features, such as surveys or landing pages. 
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Appendix E: 
Updating Calendars with .ics Event Files  

CRM and Collections generates .ics files when employees add or change revisit dates and user 
assignments for cases, opportunities, and tasks, and sends them to the “Email 1” address entered in 
Sage 300 for the newly assigned and newly unassigned users. 

.ics files (iCalendar files) are plain text files containing the details for a calendar event or a to-do 
item. Typically, they are sent as attachments to emails that you can save to a calendar, such as the 
calendar in Outlook or the Google calendar.  

Note: CRM and Collections does not send calendar files when tasks are generated by the Overdue 
Payment Reminders program. However, it will send calendar reminders when you change the revisit date 
or user for tasks generated by overdue payment reminders. 

Setting Up TaiRox CRM and Sage 300 to Email Calendar Events 

Setting up TaiRox CRM and Sage 300 to send calendar event files involves the following steps: 

• Add “Email 1” email addresses for all users in Sage 300 > Administrative Services > Users. 

 

TaiRox CRM and Collections sends calendar events to the Email 1 email address. 

• Add the settings for your email server in CRM and Collections > Settings > Options.  

 

Use the Send Test Email button to test the email server settings. 
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• Select the entities that you want to update calendars. The program lets you send calendar events 
whenever the revisit date and user assignment changes for cases, opportunities, and tasks. 

Note that “Opportunities” will not appear if you are running the Collections module without CRM.  

 

How Calendar Events Update Your Calendar 

Calendar events are generated and emailed to assigned users: 

• When you manually create a new case, opportunity, or task with an assigned user and revisit 
date. The revisit date is the date for the calendar event. 

• When the revisit date and/or user assignment changes for cases, opportunities, and tasks.  

The program sends a calendar event to the assigned user—and to the previous owner if the 
ownership changes – when you save the case, opportunity, or task. 

Examples of Calendar Events 

Calendar events are sent as email attachments and are handled differently by different email clients.  

Outlook email client 

The following screens show a typical sequence for adding the emailed calendar event for a case to your 
calendar. 

• Email arrives in email client – such as Outlook: 

 

• Double-click on the calendar event attachment, or right-click the  
attachment and choose the “Open” command.  

• If Outlook is set as the default program for “.ics” files, the  
program prompts you to add the calendar event to Outlook. 

 

If this message does not appear, you can change Windows Settings to add Outlook as the default 
program. See below, To change the default app….  
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• To Add this Internet Calendar to Outlook, click the Yes button in the above dialog box to open 
the event, and then click the Accept button to add the calendar event. 

 

The new calendar event will now appear in the Outlook calendar. 

 

• If a case is reassigned to another user, you might see a calendar event like this appear, allowing 
you to delete a previously scheduled event from your calendar. 

 

To change the default app to Outlook: 

o Choose Settings > Apps. 

 

o Choose Default Apps. 

 

Scroll down and choose  

o Scroll down to “.ics”, and select Outlook if it’s not already selected. 
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Gmail email client 

The following screen shows the same new calendar event in Gmail. 

 

• Click the Add to Calendar link to add the event to the Google Calendar, where you can edit the 
entry before saving. 

 

The next screen shows a calendar event being cancelled in Gmail. 

 

If viewing the Gmail message on your phone, the screen may look like this: 

  
Email message for new  
calendar event 

Opened Email attachment for  
cancelled calendar event 
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Examples of Calendar Event Files 

CRM creates two main types of calendar event files for each entity that generates .ics files: 

• METHOD = PUBLISH – used to create or update an event in a user’s calendar when the case, 
opportunity or task is first reassigned to a user or is updated with a new revisit/meeting date. 

• METHOD = CANCEL – used to delete an event in a user’s calendar when the case, opportunity 
or task has been reassigned to a different user. 

For example, here is a sequence of calendar events sent to a single user regarding a revisit date / 
meeting date for a case. 

Note: 

• The UID identifies the case. 

• The sequence number shows the order of events. 

• The title of the case is “Bargain Mart - Damaged desk in delivery - OEORD00009784”. 

• The administrator is the user who updated the file each time – set as event organizer. 

• The event was cancelled when the assigned user was changed from Morgan to Carla. 

• File dates are in UTC, not local time. 

 

Calendar file adds an event on 
August 13 for Morgan 

Date and Time changed to 
Monday at 10:00 am 

Calendar event cancelled 
(reassigned to Carla) 

BEGIN:VCALENDAR 

VERSION:2.0 

PRODID:-//TaiRox Software 

Inc.//TaiRox CRM and 

Collections//EN 

METHOD:PUBLISH 

BEGIN:VEVENT 

ORGANIZER;CN=Administrator:

MAILTO:mthomas@telus.com 

UID:CASE_0000000012 

SEQUENCE:0 

SUMMARY:Bargain Mart - 

Damaged desk in delivery - 

OEORD00009784 

DTSTART:20210813T080000 

DTSTAMP:20210811T160450Z 

CREATED:20210811T160450Z 

TRANSP:TRANSPARENT 

PRIORITY:5 

CLASS:PUBLIC 

END:VEVENT 

END:VCALENDAR 

BEGIN:VCALENDAR 

VERSION:2.0 

PRODID:-//TaiRox Software 

Inc.//TaiRox CRM and 

Collections//EN 

METHOD:PUBLISH 

BEGIN:VEVENT 

ORGANIZER;CN=Administrator:

MAILTO:mthomas@telus.com 

UID:CASE_0000000012 

SEQUENCE:1 

SUMMARY:Bargain Mart - 

Damaged desk in delivery - 

OEORD00009784 

DTSTART:20210816T100000 

DTSTAMP:20210811T163143Z 

CREATED:20210811T163143Z 

TRANSP:TRANSPARENT 

PRIORITY:5 

CLASS:PUBLIC 

END:VEVENT 

END:VCALENDAR 

BEGIN:VCALENDAR 

VERSION:2.0 

PRODID:-//TaiRox Software 

Inc.//TaiRox CRM and 

Collections//EN 

METHOD:CANCEL 

BEGIN:VEVENT 

ORGANIZER;CN=Administrator:

MAILTO:mthomas@telus.com 

UID:CASE_0000000012 

SEQUENCE:2 

STATUS:CANCELLED 

SUMMARY:Bargain Mart - 

Damaged desk in delivery - 

OEORD00009784 

DTSTART:20210816T100000 

DTSTAMP:20210811T163236Z 

CREATED:20210811T163236Z 

TRANSP:TRANSPARENT 

PRIORITY:5 

CLASS:PUBLIC 

END:VEVENT 

END:VCALENDAR 
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Appendix F: Exporting and Importing 
Companies, Contacts, and Notes 

CRM and Collection’s programs for exporting and importing companies, contacts, and notes provide a 
flexible way to import company, contact and note data from non-Sage 300 databases and to create new 
CRM systems from existing ones. Import and export files are in Excel (xlsx) format. 

Export and Import programs provide full support for optional fields, letting you export and import a file with 
a single line per company that includes optional fields.  

Note:  Import Companies does not automatically update A/R Customer records.  

Run Sync Companies from the CRM and Collections Periodic Processing menu after importing records if 
you updated companies that are linked to A/R customers. 

  

  

Full Import / Export Support 

The Export and Import programs for companies, contacts, company contacts, and notes let you: 

• Import company, contact, company contact, and note information into CRM and Collections. 

o Import Companies imports from a file with a single line per company, allowing you to import 
companies from non-Sage programs. It also allows you to import a file that you previously 
exported from CRM and edited.  

o Import Contacts imports from a file of contact information with a single line per contact. It 
allows you to import contacts from non-Sage programs. 

o Import Company Contacts imports records that link contacts to CRM companies and 
specify which accounting forms (statements, invoices, and overdue payment reminders) 
should be emailed to the contact for the company. 

Note: You must add or import companies and contacts before you can add or import the 
company contacts records. 
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o Import Notes imports notes for companies, cases, opportunities, and tracked invoices from 
Excel files with a single line per note. 

• Export company, contact, company contact, and note information to a single record per line that 
includes optional fields (where appropriate). 

o Export Companies creates a file with a single line per company for use with other programs, 
or to edit in a spreadsheet and then reimport the data.  

o Export Contacts creates a file of contact information with a single line per contact for use 
with other programs, or to edit in a spreadsheet and then reimport the data. 

Note that the standard Sage 300 Export choice on the Companies File menu exports 
optional fields to a separate tab of a workbook. TaiRox Export functions include the 
optional fields as additional columns in the company and contact records. 

o Export Company Contacts exports the companies that contact is linked to, along with the 
accounting forms (statements, invoices, and overdue payment reminders) that each contact 
is emailed. 

o Export Notes creates a file with a single line per note for use with other programs, or to edit 
in a spreadsheet and then reimport the data. 

• Easily import additional company and contact fields that are in source programs but not in CRM.  

Just add optional fields to CRM that match the additional source program’s data fields, extract 
records from the source program into a spreadsheet, and then import all the data directly into 
CRM by mapping the additional source fields to CRM’s optional fields. 

TaiRox import programs also let you add new records to CRM and/or update existing records, allowing 
bulk record updates such as the addition of a new optional field. 

Exporting Company, Contact, Company Contact, or Notes Records  

• Select the Export program from the Import / Export folder. 

 

• Use the Finder to specify the destination file name and file location. 

• For notes, choose whether to export notes for companies, cases, opportunities, or tracked 
invoices. 

• For companies, choose whether to export deleted companies. 

• Select which fields you want to export to the spreadsheet. 

• Click the OK button. Optional field columns appear at the end of each company and contact 
spreadsheet line (if you use optional fields). 
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Importing Company Records  

• Select the Import Companies program from the Import / Export folder. 

• Use the Finder to specify the source file name and file location. (If the name is already in the field, 
press Tab or Enter to load the import spreadsheet and display the spreadsheet columns.) 

Note that the program reads the 1st row from the 1st visible worksheet to validate the import file 
and display the import fields. 

 

• Choose Insert, Update, or Insert and Update, depending on the import process. 

• If necessary, match the columns in the spreadsheet to the fields in the Company records. 

 

In the above example, the Deleted and Inactive fields are not in the spreadsheet, and the 
program provides a “default value for these fields. 

The spreadsheet has a column called ABBREV, which is being matched to the Short Name field 
in CRM. 

• Match the optional fields to the import fields at the bottom of the list. 

• Click the OK button to proceed. 

Notes – Import Companies 

• The ID number is a required field. Import will not proceed if you set ID to <Default Value>. 

• Leave the ID number blank for new company records; provide the ID number for updated 
records. The ID is used to match the updated record to the existing record. 

• Currency code is a required field – but you can set it to the <Default Value>. 

• Records with an invalid Territory code will be skipped – but you can set it to the <Default 
Value> (which will appear in the Company record as the Default Territory). 

• Run Sync Companies after importing company records that are linked to A/R customer 
records. 

• When updating a company: 

o If you specify <Default Value>, or if the cell is empty, import will keep the current field value.  

Optional fields are handled as follows: 

o If you specify <Default Value> for the optional field, import will leave the existing value “as is". 
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o If you specify a column, import behaves as follows: 
− If the optional field already exists then it is either updated with the imported value [if there 

is a value] or deleted if the imported value is null. 
− If the optional field does not exist and a value was specified then the optional field is 

inserted. 

• When inserting a new company: 

o If you specify <Default Value>, the program will enter the default value if one exists.  

Optional fields are handled as follows: 

o If you specify <Default Value> for the optional field, it will be inserted if its auto insert property 
is Yes in optional fields setup.  

o If you specify a column, the optional field will be inserted if the column contains a value. 

Importing Contact Records  

• Select the Import Contacts program from the Import / Export folder. 

• Use the Finder to specify the source file name and file location. (If the name is already in the field, 
press Tab or Enter to load the import spreadsheet and display the spreadsheet columns.) 

Note that the program reads the 1st row from the 1st visible worksheet to validate the import file 
and display the import fields. 

 

• Choose Insert, Update, or Insert and Update, depending on the import process. 

Note that Contacts are independent of companies.  

You associate contacts with companies using the Company Contacts import file – or add them to 
companies on the Contacts tab for each company record (or on the Companies tab for each 
contact record). 

• If necessary, match other columns in the spreadsheet to the fields in the Company records. 

 

In the above example, the Deleted and Inactive fields are not in the spreadsheet, and the 
program provides a “default value for these fields. 

• You can match contact optional fields at the bottom of the list to the import fields. 

• Click the OK button to proceed. 
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Notes – Import Contacts 

• The Contact Code is a required field. Import will not proceed if you set the Contact Code to 
<Default Value>.  

The Contact Code is also used to match the record updates to the existing records. 

o Same Contact Code – it’s an update. 

o New Contact Code – it’s an insert. 

• The “Contact consents to receive emails” field is used for mass emails. It filters out contacts who 
don’t want emails when you export to MailChimp or Swiftpage. 

• When updating a contact: 

o If you specify <Default Value>, or if the cell is empty, import will keep the current field value.  

Optional fields are handled as follows: 

o If you specify <Default Value> for the optional field, import will leave the existing value “as is". 

o If you specify a column, import behaves as follows: 
− If the optional field already exists then it is either updated with the imported value [if there 

is a value] or deleted if the imported value is null. 
− If the optional field does not exist and a value was specified, then the optional field is 

inserted. 

• When inserting a new contact: 

o If you specify <Default Value>, the program will enter the default value if one exists.  

Optional fields are handled as follows: 

o If you specify <Default Value> for the optional field, it will be inserted if its auto insert property 
is Yes in optional fields setup.  

o If you specify a column, the optional field will be inserted if the column contains a value. 

Importing Company Contacts Records  

• Select the Import Company Contacts program from the Import / Export folder. 

• Use the Finder to specify the source file name and file location. (If the name is already in the field, 
press Tab or Enter to load the import spreadsheet and display the spreadsheet columns.) 

Note that the program reads the 1st row from the 1st visible worksheet to validate the import file 
and display the import fields. 

 

• Choose the fields for matching contacts to the correct companies in CRM. 
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Note:  The Company Contacts file links contacts to companies and lets you specify the 
accounting documents that each contact is sent. You must add company records and contacts to 
CRM before importing the Company Contacts file. 

You can identify the company that contacts belong to by: 

o The Company ID field – the unique number that CRM assigns to each company in CRM.  

o The Company Name field in the CRM company record. 

o Matching an optional field that has been added to the company to a field in the import file. 

Choose the field in the customer record for identifying the customer record from the left 
dropdown, and the column that matches it in the import spreadsheet. 

In this case, we are matching the Company Name in CRM to a “NAMECOMP” column in the 
import file. 

 

• If necessary, match other columns in the spreadsheet to the fields in the Company records. 

 

• Click the OK button to proceed. 

Importing Notes Records  

• Select the Import Notes program from the Import / Export folder. 

• Use the Finder to specify the source file name and file location. (If the name is already in the field, 
press Tab or Enter to load the import spreadsheet and display the spreadsheet columns.) 

Note that the program reads the 1st row from the 1st visible worksheet to validate the import file 
and display the import fields. 

 

• Choose the type of notes that you are importing – Companies, Cases, Opportunities, or Tracked 
Invoices. 

• Choose Insert, Update, or Insert and Update, depending on the import process. 

• Choose the fields for matching notes to the correct companies, cases, opportunities, or tracked 
invoices in CRM. 
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You can identify the company/case/opportunity/tracked invoice that notes belong to by: 

o The Company ID/Case ID/Opportunity/Tracked Invoice ID field – the unique number that 
CRM assigns to each record in CRM.  

OR 
− If you are importing notes for companies, the Company Name field in the CRM company 

record. 
− If you are importing notes for tracked invoices, the Document Number. 

• Match other columns in the spreadsheet to the fields in the CRM records. 

Note that you MUST choose the matching spreadsheet field for each record field – as in the 
following example. 

 

• Click the OK button to proceed. 

Notes – Import Notes 

• When inserting a new note: 

o The note IDs in the Excel file must be 0. CRM will assign IDs to all new notes. 

• When updating an existing note: 

o The note ID in the spreadsheet file must match the ID of the note you are updating/replacing.  

View Import Log File 

The import programs generate a log file that lists any issues from the import procedure. 

• Choose File > Log Files… to display the file. 

 

• The log shows the number of records added, updated, or skipped, as well as any import errors. 
 
================================================================================ 
Import Companies   2019-10-21 17:07:49 
 
Performed by user: ADMIN 
File: C:\Users\user\Documents\Import test.xlsx 
Operation: Insert and Update 
 
Row 3 
   Invalid input. Territory OR does not exist. 
Row 4 
   Invalid input. Currency cannot be blank. 
 
3 record(s) were read from the file. 
 
0 records added. 
0 records updated. 
1 records skipped. 
2 records not processed due to error(s). 
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Appendix G: CRM and Collections Security  

CRM and Collections provides two layers of security on user access to customer account data: access by 
territory and access by security authorization. 

• Access by territory – users see companies, opportunities, cases, and tasks based on the 
territories to which they belong. Tasks that are not associated with a company are not filtered by 
territory. 

o Users can be granted rights to see any number of specific territories. There is no hierarchy of 
territories.  

 

o Users can be granted the right to see all territories. CRM and Collections includes a switch 
that effectively turns off all territory restrictions for a user.  

 

• Access by security authorization – CRM and Collections provides a full set of security 
authorizations to control access to CRM settings, user maintenance, customer data, collections 
data, etc.  

− Setup Maintenance − Opportunity Maintenance − Note Maintenance 

− Setup Inquiry − Opportunity Inquiry − Note Inquiry 

− Import Processing − Contact Maintenance − Collections 

− Export Processing − Contact Inquiry − Case Maintenance 

− User Maintenance − Document Maintenance − Case Inquiry 

− Company Maintenance − Document Inquiry − Send Documents 

− Company Inquiry − Communication Maintenance − Accounting Doc Maintenance 

− Promote/Unlink 
Companies 

− Communication Inquiry − Accounting Doc Inquiry 

o Disputed invoices, promised payments, and tracked invoices (collections related entities) 
appear only if the user has been granted "Collections" security access. 
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o Collections type cases also appear only if the user has been granted “Collections” security 
access. 

o Users must have been granted Opportunity Inquiry (or Opportunity Maintenance) security 
access in order to see opportunities. 

o Users must have been granted Case Inquiry (or Case Maintenance) in order to see cases. 

o Security groups and user authorizations are all defined through Administrative Services – just 
like core Sage 300 modules. 
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Appendix H: Check for Updates 

Use Check for Updates to see if a new version of CRM and Collections is available. 

Updates can be downloaded from the TaiRox web site and installed by your Sage 300 dealer for 
as long as you license this TaiRox product. 

Note that you do not have to update Sage 300 to get the latest versions of TaiRox products. 
TaiRox Collections updates (and TaiRox CRM and Collections updates) work with all Sage 300 
versions from 2018 to the present. 

  

  

The above screen shows that you are up to date. Your version date matches the latest release date. 

Information Provided by Check for Updates 

Version Currently Installed on your System 

The first line on the screen – Version You Are Using – shows the release date for the version of this 
product that is currently installed with Sage 300.  

Newest Version Available for Installation 

The next line on the screen – Newest Version– shows the release date for the latest version of this 
product.  

In the example shown above, the installed version and latest version release dates are the same – and 
the Update screen also notes that your installed version is up to date.  
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TaiRox CRM and Collections Web Page on TaiRox.com 

Click the link for TaiRox CRM and Collections to view the CRM and Collections web page on TaiRox.com.  

Note that the newest TaiRox CRM and Collections features are listed on the page. 

Click the “TaiRox Collections” link to see the features provided by the Collections module. 

  

Most Recent Video for this Product 

Click the Video link to view the TaiRox CRM and Collections overview on the Vimeo web site.  

Click  to start the video. 
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Release Notes that List Recent Features and Fixes 

Click the Release Notes link to view the notes for the latest release of CRM and Collections. The release 
notes include all new CRM and Collections features and fixes. 

For example: 

  

User Guide for the Newest Version 

Click the User Guide link to view the most recent version of the CRM and Collections User Guide. The 
User Guide provides details for all TaiRox Collections and TaRox CRM and Collections features. 

The User Guide link on your CRM and Collections help menu documents the version of CRM and 
Collections that you are currently using. 
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Frequently Asked Questions (FAQ)  

Read the user guide for TaiRox CRM and Collections in addition to reviewing this FAQ. 
The CRM and Collections user guide provides specific guidelines for setting up TaiRox 
as well as general information and notes on all CRM and Collections features. 

Resources Available to Answer Sage 300 Questions? 

In many cases, issues with CRM and Collections are actually Sage 300 issues – such as database 
connectivity issues or issues where Sage 300 cannot create a control, and many of these issues have 
been encountered by other Sage 300 users. 

Q: Where can you get fast answers to Sage 300 issues? 

A: Google the error message and check the results. 

Sage 300 error messages are often self-explanatory or can be Googled for an explanation. These 
messages may indicate fairly simple issues that users can resolve, or environmental issues that 
consultants can resolve. 

In many cases, you may find your answer on an existing Sage 300 support forum, posted by partners 
who have already encountered your issues. 

For example: 

https://support.na.sage.com/selfservice/ 
www.pluscommunity.com/ubbthreads/ 
https://www.sagecity.com/support_communities/sage300_erp 
https://www.acutedata.com/sage-300-kb/ 

CRM and Collections Installation and Upgrade Issues 

Q: Where can I get CRM and Collections release notes, and what will they tell me? 

A: Click the Release Notes link in the upper left-hand corner of the TaiRox CRM and 
Collections product page on the TaiRox web site. 

Among other things, the Release Notes will tell you about recent fixes and provide program 
compatibility information. For example: 

 

Build 2023-10-04 

 - Support added for Sage 300 2024. 

 - Contract Groups have enhanced management of copy and merge operations. 

 

Build 2023-07-31 

 - Marketing menu added with Bulk Mail setup and send functions, enhanced 

Contact Group functions. 

   Send emails to multiple users through local mail server, MailChimp and 

SendGrid. 

https://support.na.sage.com/selfservice/
http://www.pluscommunity.com/ubbthreads/
https://www.sagecity.com/support_communities/sage300_erp
https://www.acutedata.com/sage-300-kb/
http://tairox.com/downloads/crm/TaiRoxCRMReleaseNotes.txt
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Q: How do you install TaiRox CRM and Collections? 

A: TaiRox CRM and Collections has a standard Windows installation file that follows standard 
removal protocols. 

As of September 2022, the installation file – Setup-2018-202n.msi – works with Sage 300 
2018 to the current version.  

Important:   

• Sage 300 must already be installed on the machine before you install TaiRox CRM.  

• Activate Sage’s M/T Contacts module if available in your version of Sage 300. CRM 
contacts are totally compatible with Sage’s Multiple Contacts module. 

• When upgrading, uninstall the previously installed version of TaiRox CRM using the 
Windows Control Panel/Windows Settings before installing the new version. 

Q: What is the upgrade procedure for TaiRox CRM and Collections? 

A: When upgrading, uninstall the previously installed version of TaiRox CRM using the 
Windows Control Panel/Windows Settings before installing the new version. 

Q: TaiRox CRM and Collections does not appear on the Sage 300 Desktop. 
What’s wrong? 

A: If CRM and Collections does not show up on the Sage 300 Desktop, you need to install the 
C/C++ runtime that is shipped with the CRM and Collections installation files -- 
vcredist_2013_x86.exe. 

As noted in the readme file “READ-WHY-NEEDED-vcredist_2013_x86.txt”, the C/C++ 
runtime required by CRM and Collections may not be present on newer versions of 
Windows such as Windows 10. 

  

Q: How do I synchronize TaiRox CRM contacts with Sage 300 after activating the 
Sage 300 M/T Contacts module?  

A: Sage’s M/T Contacts module was added in versions of Sage 2020 Product Upgrade 1.  

To use Sage contacts: 

• You must first install a version of Sage 2020 PU1 or higher that has the Multiple 
Contacts module. 

• Upgrade TaiRox CRM to the most recent version. 

 Step 1: Activate Sage 300 Multiple Contacts using the Data Activation program in 
Administrative Services. (And activate the most recent version of CRM, if necessary.) 
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 Step 2: Run Sync Contacts in the TaiRox CRM Periodic Processing folder on the Sage 300 
Desktop. Sync Contacts will add all CRM contacts to the Sage 300 M/C Contacts module.  

 Step 3: Run Sync Companies in the TaiRox CRM Periodic Processing folder on the Sage 
300 Desktop. Sync Companies will update Sage A/R customer records with the contacts 
maintained for CRM Companies.  

 Step 4: Run Sync National Accounts (if you use National Accounts) in the TaiRox CRM 
Periodic Processing folder on the Sage 300 Desktop. Sync National Accounts will update 
Sage A/R national account records with the contacts maintained for CRM National 
Accounts.  

After completing these steps, A/R customer and national account contacts will match the 
contacts in CRM, and updates to contacts in either CRM or A/R will be reflected in both 
systems. 

Q: I have issues running Sage 300 and CRM after completing a Sage 300 upgrade. 
What can I do? And how can I diagnose installation issues? 

A: Always upgrade all of your TaiRox products to the most recent versions when you upgrade 
Sage 300 products. 

The latest version of a TaiRox product replaces all previous versions of that product. CRM 
and Collections supports all versions of Sage 300 from 2018 through to the current version. 
In other words, the TaiRox CRM installation program is not Sage 300 version specific. If you 
upgrade Sage 300, make sure that you also upgrade TaiRox CRM and Collections. 

A: Run TaiRox Install Check (available here on the TaiRox website -- http://tairox.com/install-
check-for-sage-300-erp-accpac.html) 

Install Check checks the environment on a computer running Sage 300. If the environment 
is not correct, some or all functions in Sage 300 and third-party applications may not operate 
correctly.  

Install Check leaves no footprint – it does not install, does not change the Windows registry, 
and does not require a license.  

Install collects basic environmental information and checks that certain Sage 300 related 
operations can be performed. The download is a zipped-up EXE file. Run the EXE, click the 
Installation Check & System Information buttons, copy the results to the clipboard, save in a 
Word document and analyze: paying particular attention to any red message.  

If you are running a TaiRox program that provides a log file that shows a problem, review 
the log file as well.  

If you can re-create a problem in a known environment (all O/S, Sage 300 and third-party 
software freshly installed in a recorded order), we can check what might be happening in a 
matching environment using our developer tools. 

Note that SDK applications publish a list of files that are part of their application. Install 
Check checks this list against files that are actually installed. This helps diagnose situations, 
for example, when an anti-virus program has incorrectly quarantined a legitimate file. 

http://tairox.com/install-check-for-sage-300-erp-accpac.html
http://tairox.com/install-check-for-sage-300-erp-accpac.html
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Q: Why did the Sage Desktop stop working? 

We just upgraded a client to a new version of Sage 300. All workstations except one are 
working fine. One workstation gets a “DESKTOP has stopped working” message when the 
user attempts to log on to their live company database; however, it works fine when they log 
in to SAMINC or SAMSYS. 

A: This error is usually indicative of a Product Update mismatch.   

For example -- We had this error when setting up a test environment. The live data was from 
Sage 300 2018 PU6 and we restored it into the test environment where the application files 
were Sage 300 2018 Rev 0. The error went away when we installed PU6 in the test 
environment. 

Q: Where can I find TaiRox CRM log files? 

A: CRM creates logs when it runs processes for Emailing Statements, Letters and Invoices to 
customers, and it creates change logs whenever you change a company, contact, contact 
group, opportunity, case, document, communication, note, disputed invoice, promised 
payment, task, tracked invoice, territory, or user. 

To see a log file for Send Statements / Letters, Send A/R Invoices and Send O/E Invoices, 
open the program and click the Log button.  

To view change logs, open the maintenance program and click the Change Log button, or 
open the Change Log folder and choose the Change Log icon to view change logs, or use 
the Change Log Report to print change reports.  

Q: How can I deactivate a product that is installed with Sage 300?  

A: Fast DBTools has a deactivation function that correctly deactivates products by deleting all 
tables with the prefix and the rows in Common Services tables that refer to the prefix. For 
example, CRM uses data prefix “XQ”.  

Q: Why does message “Can’t Create Control” appear when running a TaiRox 
CRM or Sage 300 program? (The problem is only occurring for a specific 
user.) 

A user gets the following message when opening a CRM program or drilling down to Sage 
300 from CRM. 

 

Other users logging in from the same workstation have no problems – for example as either 
ADMIN or with their own ID. 

This user was previously able to run this program successfully, but had an issue and hasn’t 
been able to use the program since. 
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A: There are many possible reasons for this message to appear.  For example, some Sage 
300 containers have had issues. 

First thing to try:  Restore Defaults on the Sage screen where there were issues and on the 
TaiRox Extended version of the screen. 

• Right-click the icon on the Sage desktop, and choose Restore Defaults from the pop-up 
menu. 

A: You should also check that all Sage 300 and TaiRox CRM updates and have been installed.  

A: Another possibility – if using a remote desktop to run Sage 300, check if the program's 
screen size is too large relative to the display resolution of your remote desktop window 
when you get the Can't Create Control error. 

• If you log onto the server (via remote desktop) and change the resolution does the 
problem go away? 

The problem can arise when one user runs the program successfully and resizes the form – 
which then causes problems when another user runs the program as a published 
application. 

A: Google the error message for more troubleshooting leads, and look at the forums listed at 
the top of this FAQ. 

Q: I get this error when trying to “Send Test Email” from Setup > Options in 
Tairox Collections. What is the problem?  

 

A: This problem usually arises when you are running on a workstation, and did not run 
Workstation Setup after installing CRM and Collections. As a result, the Chilkat dll that was 
installed in the Sage 300 runtime folder has not been registered for this workstation.  

You can fix the problem by running Sage's RegAcc.exe program on the workstation to 
register the dlls/ocxs that were installed with TaiRox CRM and Collections. (You can find 
RegAcc in the runtime folder.) 

A/R and M/T Integration with Demo Data 

Q: Why did I get an error message when I unchecked “Suspend A/R and M/T 
Integration in CRM and Collections Options? 

I unchecked the A/R and / or the M/T Integration checkboxes in Setup Options and got the 
following message: 



Frequently Asked Questions (FAQ) User Management 

TaiRox CRM and Collections for Sage 300 276 User Guide 

 

A: A/R and M/T Integration are suspended for your protection to ensure that CRM does NOT 
update the Sage 300 Multiple Contacts and Accounts Receivable data.  

If you created Demo Data with SAMLTD or SAMINC – or with a copy of your company 
database and want to see the results of A/R and M/T Integration – you can turn on 
integration in Setup Options.  

 Do not turn integration on if you are working with a production database! 

User Management 

Q: Why can’t I add a new user to CRM and Collections? 

A: You must first add the user to Sage 300, and then use TaiRox CRM > Setup > Users to add 
the user to CRM. 

• First, add users to Sage 300 using Administrative Services > Users. 

• Second, add users to TaiRox CRM using TaiRox CRM > Setup > Users. 

Using SmartFinder Search 

Q: Why don’t I have any search results? 

A: Check the spelling for the terms you entered. If you are unsure of spelling, shorten the 
search string to characters that you are sure of. 

Deleting, Undeleting and Viewing Deleted Records 

Q: How do I view deleted records, and can I restore them? 

A: Deleted entries are retained in the database and can be viewed by right-clicking the title bar 
on an entity grid and choosing "Show Deleted". 

 

Double-click the “Deleted” column to restore the record (undelete it). 
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When you view a deleted record, the program displays the word *** DELETED *** on the screen, and 
the “Delete” button at the bottom of the screen becomes an “Undelete” button, allowing you to restore 
the record: 

 

Click the “Undelete” button to restore the record. 

Using Contacts 

Q: How do you delete a customer contact from a CRM company? Does it delete 
the contact from Sage 300? 

To delete a contact from a CRM company record, go to the Contacts tab, highlight the 
contact record in the grid, and use the Delete key (or the Unlink button).  

• This will remove the contact from the company record, and, if you are using the M/T 
Contacts module, it will also remove it from the A/R customer record unless you suspend 
A/R integration (in Setup Options). 

Similarly, if you remove a contact from the A/R customer record, it will also be removed 
from the CRM company record unless you suspend A/R integration.  

• The contact will still remain in the CRM Contacts list and in the M/T Contacts module.  

• If you delete a contact from the Sage M/T Contacts module, it will also be removed from 
the CRM Contacts program unless you suspend M/T integration. 

Notes concerning M/T Contacts in Sage 300 A/R and A/P: 

• If you delete the contacts from A/P or A/R, the contacts will be removed only from the 
vendor or customer record. The contact record will still exist in the list maintained by 
Sage’s M/T Contacts module. 

• To delete the contact from Sage 300, use the M/T Contacts module in Common 
Services. Note, however, that in the Sage 2020 versions of A/P and A/R, the code for 
the contact will still appear on the vendor or customer contact tabs until you delete it. 
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Emailing Company Contacts 

Q: Can I send emails to CRM contacts directly from CRM? 

A: Yes.  The Resend Documents button on the Companies screen lets you create an email for 
the currently selected company, add attachments, and select company contacts. The sent 
emails are added as communications for each contact. 

See Sending Miscellaneous Emails and Email Attachments to Contacts for details.  

Emailing Statements, Invoices, Payment Alerts, and Reminders 

Q: I see the following “Important Information” message when I try to send 
overdue payment reminders. What’s wrong? 

 

A: This message (or one like it) tells you that Email templates have changed due to a program 
update, and that you should update your old email templates.  

The message was added in 2020 to warn you that templates – or the email subject line – 
included a $DOCUMENT macro. The message may be different in later versions of the 
program. 

Some changes over the past few years are as follows: 

In June 2023, we dropped the deprecated macros starting with $DOCUMENT_. They can 
no longer be used with payment due alerts or with overdue payment reminders. 

In September 2020, we added the $OVERDUE_INVOICES macro to insert a table with all 
overdue invoices into payment reminder emails. We also changed all macros starting with 
$DOCUMENT to refer to the oldest outstanding invoice. 

If you want to continue and send the Payment Reminder – for example, if you are 
demonstrating the feature or if you want to separately include information about the oldest 
invoice – click the Process Overdue Payment Reminders button to continue. 

To cancel the mailout and update your templates, click the Cancel button. 

The Email Subject, From Email, Reply-To Email, Cc and Bcc fields for A/R Statements/ 
Letters and A/R and O/E Invoices are set in the Setup > Accounting Documents program. 

Those fields for Overdue Payment Reminders and Payment Due Alerts are specified with 
the Overdue Payment Reminders Setup and Payment Due Alerts Setup programs. 
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Q: My invoices are not being sent properly via email. In some cases, an email is 
actually sent, but the log notes a failure and the program does not create an 
EML file or a communication. This a sporadic issue. What’s wrong? 

I ran Send O/E Invoices, but the EML file was not created in the CRM directory, and the 
program did not create a communication, even though an email was sent. However, for no 
apparent reason, the program worked properly when I tried it later. This happens 
sporadically. 

A: Check the log file for a timeout after the program starts to send an email. It may be that your 
email server is not sending a response back in the first 30 seconds, which is the default 
email timeout for CRM and Collections. Your mail server may be busier at some times and 
not so busy at others – when you do not experience the issue. 

If your email server is timing out, you have several options: 

• Check the server to see why it takes over 30 seconds to respond. IT staff may be able to 
upgrade the server or set up a relay email server. 

• Increase the ReadTimeout value in the XQ.INI file in recent versions of CRM and 
Collections (in the Sage300\XQ61A subfolder). This setting was added in July, 2022. 

The downside of this approach is that our program may appear to be “hung” as it waits 
for a longer time to get a response from the mail server.  

The setting is initially commented out (the line starts with “;”) and default to 30 seconds. 

[SendDocuments] 
SendEmails=True 
;ReadTimeout is in seconds. The default value is 30. 
;ReadTimeout=300 

Un-comment the line and specify a larger value than 30. 

Q: I have the wrong “From Email” address in my emailed documents. Where does 
this address come from? 

A: The default “From Email” address comes from the Email tab in the Setup > Options 
program. If this field is blank, the default address will be the Email 1 address from the Sage 
300 user’s account. 

You can override the default email address in Options for the following emailed documents 
using the Accounting Documents Setup program: 

• A/R statements and letters 

• A/R and O/E invoices 

And you can override the default email for Overdue Payment Reminders and Payment Due 
Alerts with the Overdue Payment Reminders Setup and Payment Due Alerts Setup 
programs. 

If you do not specify a From Email address in Accounting Documents, the above programs 
will use the setting in Options. 

You can also override the default From Email address when you resend documents from the 
Company window by specifying a new address in the Resend Documents window. 
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Q: The emails for Overdue Payment Reminders, Payment Due Alerts, and/or Send 
Invoices are not using the customer’s preferred language. What’s wrong? 

A: See Sending Emails Using the “Preferred Language” Company Setting for details on 
sending emails in the customer’s language.  

Here are the steps for sending French or Spanish emails: 

• Install the Sage 300 language files for French and/or Spanish to send emails and 
invoices in the target languages.  

• Select the Preferred Language in the Company window (and National Accounts window) 
for all customers that should receive French or Spanish emails. 

• Create FRA and ESN subfolders for the translated versions of your email templates. 

For example: 

<Sage300SharedData>\Company\<companyID>\TaiRox CRM\Templates\Overdue Payment Reminders\FRA 
<Sage300SharedData>\Company\<companyID>\TaiRox CRM\Templates\Payment Due Alerts\FRA 
<Sage300SharedData>\Company\<companyID>\TaiRox CRM\Templates\Send Invoices\FRA 
<Sage300SharedData>\Company\<companyID>\TaiRox CRM\Templates\Send Statements\FRA 

• Add the French and Spanish versions of your email templates to the default templates 
folders for overdue payment reminders, payment due alerts, or invoices. 

o The translated templates must have the same name as the English versions in the 
root folders. 

o You must include any image files for the emails in the language subfolders. 

Q: The greeting on emails for Overdue Payment Reminders are all for the 
customer contact even though I am sending emails to multiple contacts. 
What’s wrong? 

A: See Macro Variables in Email Templates for details on customer and invoice data that you 
can include in emails.  

The sample emails shipped with TaiRox Collections insert the main customer contact or 
national account contact ($CUSTOMER_CONTACT) in the email greeting.  

Also the Overdue Payment Reminders program sends only one email per customer account 
or national account to one or more customer or national contacts. It is not possible to 
generate separate emails for each multiple contact. 

If your emails are going to multiple contacts per customer or national account, you should 
change your greeting to something more generic. 

For example, use the $CUSTOMER_NAME like this:  Attention $CUSTOMER_NAME payables. 

Or use your Sage $COMPANY_NAME like this:  Your $COMPANY_NAME invoices are overdue. 

Selecting which customer and national account contacts get accounting emails:  

You select email recipients in Sage 300 and TaiRox Collections by selecting: 

• The delivery method for each A/R customer account or A/R national account. 

A/R provides 3 email delivery methods on the Processing tab for A/R Customers and 
National Accounts: 
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o Email (national account) – to send emails to the email address specified for the 
national account on the Address tab. 

o Email (contact) – to send emails to the contact email address specified for the 
national account on the Contact tab. 

o Email (multiple contacts) to send emails to all the contact email addresses specified 
for the national account in the Multiple Contacts section on the Contact tab (if you 
use the Multiple Contacts feature). 

• The customer or national account contacts that you want to receive X/Q Payment 
Reminders. For instructions on selecting reports on the Contacts tab in the Customer or 
National Accounts window, see Specifying the Recipients for Accounting Documents on 
the Contacts Tab. 

Synchronizing Contacts, National Accounts, and Companies 

Q: Why doesn’t Sync Companies add CRM companies to A/R? 

A: Sync Companies synchronizes companies that were not synchronized by CRM’s normal A/R 
Integration – and A/R integration does not automatically add new companies to A/R. 

Usually, you will add prospective customers to CRM, and then promote them to Accounts 
Receivable when they become customers. See Promoting Prospects to Customers in 
Accounts Receivable. 

Sync Companies is mainly used when you first set up CRM and want to add all customer 
records to CRM as companies, and when circumstances have caused the two databases to 
go out of sync (such as suspending A/R Integration on the Setup Options form). 

Q: Why does a message appear when I choose Sync Contacts, Sync Companies, 
or Sync National Accounts? 

       

A: Sync Contacts, Sync National Accounts, and Sync Companies are disabled if you suspend 
integration with the Sage M/T contacts module and with Sage Accounts Receivable.  

To enable these programs, you must uncheck “Suspend M/T Integration” and “Suspend A/R 
Integration” on the first tab of the Setup Options screen. 

Using Sage Number Changers 

Q: I’ve been using the Sage Number Changers and don’t think that all records 
were updated in CRM. Does CRM or CRM and Collections work with Sage 300 
number changers 

CRM or CRM and Collections handles Sage 300 number changers; however, before 
February 16, 2024, it ONLY worked for changing one number to another. It did not combine 
two numbers into one. 
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If you believe you have a problem with the number changers, you should: 

• Make sure that you are using the most recent version of CRM or CRM and 
Collections with Sage 300 to ensure that your version of CRM combines numbers – 
and matches your version of Sage 300. 

• Update generated data after using the number changers – for example, update 
Customer Aging, Overdue Invoices, Payment Due Alerts, and Send Invoices. 

Note also that CRM database tables do not include vendors, I/C items or G/L Accounts, so 
those Number Changers do not apply. 
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